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License Agreement

The use of Adagio Ledger, Adagio FX, and the Financial Reporter is governed by the
following agreement. You demonstrate your acceptance of the terms of this agreement by
using Adagio Ledger or Adagio FX and its associated materials. You may terminate this
agreement at any time by returning the original disks and manual to Softrak Systems Inc.
with a letter, signed by an officer of the company, stating that all copies of the software have
been destroyed.

Usage Rights

For the fee you have paid, Softrak Systems Inc. hereby grants to you and you accept a license
to use this application and the related materials on a single computer system only. To use this
application on more than one computer system, you must either purchase a license for
another copy of Adagio Ledger or Adagio FX and the Financial Reporter or arrange for a
multi-user license from Softrak Systems Inc. You may not copy any of the materials received
with Adagio Ledger or Adagio FX and the Financial Reporter, in whole or in part, except for
archival and backup purposes.

This license is not transferable.

Registration and Support

To receive technical support and notices of upgrades and announcements, your copy of
Adagio Ledger or Adagio FX and the Financial Reporter must be registered.

To register, install Adagio Ledger or Adagio FX and the Financial Reporter as you would any
other Windows application. When you start Adagio Ledger or Adagio FX for the first time,
you will be presented with a screen that gives you the option to register. Enter your company
information and print the registration form to be mailed or faxed to Softrak Systems Inc.

Liability

You agree that regardless of the form of any claim, the liability of Softrak Systems Inc. for any
damages to you or to any other party shall not exceed the license fee paid for the license and
the materials included in Adagio Ledger or Adagio FX and the Financial Reporter. Nothing in
this agreement shall be construed as a product warranty and all such warranties are explicitly
and expressly denied.
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Chapter 1
Introduction

Welcome to Adagio� Financial Reporter! This manual is intended for people who are
responsible for installing, configuring and maintaining the Adagio Financial Reporter
system, and designing the financial reports for use with Adagio Ledger or Adagio
FX.

This chapter introduces the Adagio Financial Reporter system and lists the contents
of this manual. Then it explains how to start Adagio Financial Reporter.

Adagio Financial Reporter is similar to many popular spreadsheet
applications. This manual assumes that users have a working
knowledge of spreadsheet applications. If you do not, you should
refer to your spreadsheet application manual for more information
on how to use a spreadsheet.
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About Financial Reporter
Adagio Financial Reporter is a powerful and flexible tool for creating, designing and
printing a variety of financial reports. Financial Reporter allows you to use data from
Adagio Ledger or Adagio FX and create a report about almost any aspect of your
accounting system.

Financial Reporter combines the flexibility of a spreadsheet application with the
branching structure of a file maintenance system. This system allows you to drag and
drop items into the spreadsheet, which makes the program very easy to use.

Once you configure your accounts system, just drag the desired accounts onto the
spreadsheet and select the information you want to incorporate. You can then print a
professional financial report.

When you save a report, the report is saved as a series of formulas linked to your
Adagio Ledger or Adagio FX data. As your ledger data changes, the reports you save
will reflect these changes every time you open them. You only have to create a report
once and it will always be up to date.

Adagio Financial Reporter ships with a number of basic financial statements that are
used with the Account Groups set up. They are stored as templates in the
x:\SOFTRAK\FSDesigner\Templates folder (where 'x' is the drive your Adagio
software is installed on). Templates use a prefix of FS and an extension of .fst which
differentiates them from other financial statements you may have stored in your
data.

About Financial Reporter
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Starting Financial Reporter
Adagio Financial Reporter is automatically installed on your system when you install
Adagio Ledger or Adagio FX. Financial Reporter can only be started from within
Adagio Ledger or Adagio FX so you must first open Adagio Ledger or Adagio FX
before you can start Financial Reporter. There are three ways you can do this.

If you want to print financial reports:

• Select Print Financial Reports from the Reports menu.
• Or, click the Financial button on the toolbar.

If you want to create or edit a financial report:

• Select Maintain Financial Reports from the Maintenance menu.
• Or, click the Financial button on the toolbar.

If you want to log into the Financial Reporter independent of Adagio Ledger, refer to
Logging into Adagio Financial Reporter on page 1-4.

When you click the Financial button in the toolbar, whether you are taken to Print
Financial Reports or directly into Maintain Financial Reports depends on the type
of access you have been granted within Ledger's or FX's security groups. Please refer
to the Ledger or FX online Help documentation or your Adagio Fundamentals manual
for more information about setting up users and security groups.

Starting Financial Reporter

Introduction Page 1-3



Logging into Financial Reporter
You may log into and start Adagio Financial Reporter independent of Adagio
Ledger.

All Adagio users must be registered with the system by the Adagio System
Administrator (user SYS). Each Adagio user receives a unique userID and password.
This information is required for a user to log into the system (please refer to the
online Adagio Ledger help documentation for more information about Adagio
security). When a user logs into the Financial Reporter, the uer also selects the data
path to the folder that contains the data files.

You can use Command Line Parameters (see page 1-6) to bypass certain fields in the
Open Adagio Financial Reporter dialog box each time you start the Financial
Reporter. Command Line Parameters ar set as properties for the program. If you
want to see the Account Codes used in many formulae when the View | Account
Data window is open, ensure you add the /a parameter to the shortcut's Target.

Logging into the Financial Reporter independent of Adagio Ledger consumes a
Lanpak license. A financial statement can only be opened once for edit. All other
users may open the statement in read-only mode.

Run the Adagio Financial Reporter shortcut:

Logging into Financial Reporter
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Fill in the fields based on the following table:

Field Description

User ID Each Adagio user should be assigned a unique user
identification code. Enter your assigned Adagio
userID. The ID SYS is for the Adagio system
administrator.

Password Enter your assigned Adagio password.

Date This is the sesion date. It defaults to the current system
date. If you need to change the date, use the calendar
dropdown button to the right or type the date.

Data path Enter the drive and data path to the folder for your
company's data, or click the Browse button (or use
Alt/b on the keyboard) and select the correct drive and
data path from the Data Selection dialog that appears.

There is another button to the far right of this field.
Click this 'multiple folder' button (or use Alt/f on the
keyboard) to view the Previously Opened data file list.
This feature is especially helpful if you are maintaining
multiple data sets (eg. data for multiple companies). If
you wish to use one of these previously opened data
sets, click the Company Name to select it, then click
Open.

Extension Set the extension used for the data files.

Remember user name/
Remember password

Enable the Remember user or password option to have
the Adagio user name and/or password remembered
and authenticated by the Windows user. This allows
you to default your Adagio user name and/or
password byinto Windows (on the station).

Last Access Displays the last (sysstem) date used when you Last
accessed or ran the program.

Logging into Financial Reporter

Introduction Page 1-5



Command Line Parameters
Adagio Financial Reporter allows you to use command line parameters to start the
program. Command line parameters are set as properties for the program and allow
you to bypass certain fields in the Open Adagio Financial Reporter dialog each time
you start the Financial Reporter. The parameters are as follows:

Parameter Description
/u - Allows you to set a default user
/p - Allows you to set a default password
/d - Allows you to set a default data path, must be used with /e
/e - Allows you to set a default data extension, must be used with /p
/a - Displays the Account Codes used in many formulae in the View | Account Data
window.

Since command line parameters can bypass certain security functions such as user
identification and passwords, you must ensure that you are the only user on that
particular machine and that password security is not a concern in your office before
using these parameters.

Setting Command Line Parameters
To set command line parameters:

1) Right click the Adagio Financial Reporter icon on your desktop and select
Properties from the pop-up menu that appears.

2) Click the Shortcut tab.

3) Locate your cursor at the end of the information in the Target field (i.e. the drive
and directory path to where you installed Adagio Ledger and the name of the
Financial Reporter program file).

4) Type the desired parameters with the associated default information you
require. For example, to set a default user, type /uUID (where 'UID' is the up to
3-character Adagio userID). Do not leave a space between the parameter and the
default information.

5) Continue typing as many parameters and the associated default information as
you require, leaving a space between each full parameter. If you set all four
parameters, Financial Reporter will bypass the Open Adagio Financial Reporter
dialog entirely each time this shortcut is used to start Financial Reporter, as the
only remaining field is the date field which defaults to te current date.

Command Line Parameters
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The Spreadsheet Window
The first time you open the program, Financial Reporter appears with only the
spreadsheet open.

The first thing you should learn how to do is open the other available windows.
These windows contain data from your Adagio files and allow you to drag and drop
the data into the spreadsheet.

The Spreadsheet Window
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For example, to open the Account Groups window, select Account Groups from the
View menu. The Account Groups window displays various account categories in an
expanding tree. Each account group is linked to data in your Adagio files. Once you
have configured the Account Groups (Chapter 2), you will use this window do drag
and drop data into the spreadsheet.

The Zoom Feature
You may also notice on the View menu that there are three Zoom options. These give
you zoom control on the spreadsheet and are useful if you are creating large reports,
or if you are working on a small monitor.

The zoom controls are also available on the toolbar. Just click the magnifying glasses
until you find the best zoom for your report.

Please refer to the online Help documentation for information about each button
within the Financial Reporter toolbars.

The Spreadsheet Window
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Toolbar Docking
You can move any toolbar to a new location to give you more room in the main
spreadsheet window, or to configure the toolbars to your taste. Just click the beveled
edge of the toolbar and drag it to a new position.

Please refer to the online Help documentation for information about each button
within the Financial Reporter toolbars.

The Spreadsheet Window
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Window Docking
All tree windows can be dragged to anywhere in the main window, and they can be
“docked” to any edge. For example, to move the Account Groups window, click and
drag the top of the window, or the title bar, and drag it to the desired location. To
dock the window against the edge of the main window, just drag the window to the
edge and it will fall into place.

The Spreadsheet Window
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Display Settings
Financial Reporter lets you control how the spreadsheet window appears. These
options do not change the look of your printed report, they are simply on-screen
preferences.

To change the spreadsheet window’s appearance, select View | Properties. . . . This
will open the Display Settings window.

The following table describes the components of the Display Settings dialog:

Field Description

3D Buttons If you want the Column and Row label buttons to
appear as 2-dimensional buttons, turn this option off.

Vertical Lines If you want the vertical grid lines hidden in the
spreadsheet window, turn this option off.

Horizontal Lines If you want the horizontal grid lines hidden in the
spreadsheet window, turn this option off.

Display Settings
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Field Description

Color You can change the color of grid lines, page break
markings, and hide when printed columns using this
dialog. Just select the element whose color you want to
change, then select the color you want it to appear in.

Preview This displays what the spreadsheet window will look
like with the settings you have selected.

Turn the Save settings to profile option on if you want to save these settings for
future spreadsheets that you create. If you check this option, all new spreadsheets
will retain the same options, unless you override them.

When you are finsihed, click OK to save the settings in the window.

Display Settings
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Toolbar Options

Resetting the Toolbar
When new features are added to the Financial Reporter, new buttons may also be
added to the toolbar to allow you to take advantage of those new features. In order to
view the new buttons, you may need to reset your toolbar after upgrading Adagio
and the Financial Reporter.

To do this, go to View | Customize, select the Toolbars tab, and click the Reset
button.

You must highlight each toolbar you wish to have reset to the
default and click on the Reset button for each.

Please refer to the online Help documentation for information about each button
within the Financial Reporter toolbars.

Customizing the Toolbar
You can customize the toolbar in Adagio Financial Reporter in order to incorporate
buttons you use most often. This can help streamline your work by providing toolbar
shortcuts that are useful to you and removing those that you do not use often.

To customize the toolbar:

1) Select Customize from the View menu. The Customize window appears. It
includes four tabs.

Toolbar Options
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2) Click on the Toolbars tab to bring it to the front. Click on the check boxes to
determine which toolbar command categories to include in the toolbar.

Toolbars may also be Locked, preventing any changes from being made to them
accidentally (such as moving the toolbar to a different location) if the Lock
Toolbars option is enabled.

Toolbar Options
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3) Click on the Commands tab to bring it to the front. Select a command category
by clicking on it. All the available toolbar buttons in that category are displayed.

4) Add a button to the toolbar by dragging it from the Customize Commands tab to
the toolbar. You can also remove buttons from a toolbar by dragging them off the
toolbar while the Customize Commands tab is open.

Toolbar Options
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5) Click the Views tab to bring it to the front.

This tab simply shows you the different types of Views you can select from the
View menu, and most importantly allows you to reset the Views in the case of
newer versions of Financial Reporter, where new Views may have been added.

New Views cannot be seen until they’ve been activated by resetting
the Views.

Toolbar Options
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6) Click the Settings tab to bring it to the front.

Set your default Display and Export buttons here. The table below explains
each field:

Field Description

Replace the text
“Consolidated
Departments” with

In statements where departments have been
consolidated, the default text to indicate that is
“Consolidated Departments”. However, you can
replace this default text with the text of your
choosing by entering it here.

Use the following text
to replace zero values

If you want any text to be displayed in place of
zero values, enter it here. If you prefer not to have
any text replacing zero values, leave this blank.

Toolbar Options
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Field Description

Save in user folder You can ensure that all exported files are saved to
your user folder by turning this option on.

Your user folder is a subdirectory of the folder that
your accounting data is in. For example, if your
data is in C:\DATA, and your user initials for
logging in to Adagio are “JSB”, then your user
folder would be C:\DATA\JSB.

NOTE: This applies to statements that are exported to
Excel or to HTML via the File menu, not to Excel
Direct, as Excel Direct opens the exported files for you
and allows you to save them wherever you wish.

Automatic overwrite of
file with same name

If you want any existing export files by the same
name to be overwritten automatically (without a
prompt reminding you that you are about to
overwrite an existing file), turn this option on.

Values only Check this option if you want the export file to be
saved with values only (i.e. results without
formulas).

ColSpec Date Format This field allows you to set your preferred date
format to be used in any date column headings
that appear in ColSpec reports. The format is also
used by the Date Style toolbar button. (See page
3-66 for more information on ColSpec reports.)

Auto save recovery
data

Every 5 to 30 minutes, the Financial Reporter can
automatically save your open financial statements
while they are being worked on. Set the time the
Financial Reporter should wait between auto
saves in this field. This facilitates statement
recovery if necessary.

7) Click the Clear button to reset all settings back to the program defaults.

8) Click the (Tx) Details button to control which field will display, and in what
order they display, when drill down to either Details or TxDetails is selected on
a spreasheet. Fields that have a checkmark beside them will display.

Toolbar Options
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9) Click OK to save the changes and close the Customize window. Click Cancel
to exit the Customize window without saving any changes.

Remember that you can drag toolbar functions together onto
single toolbars and to any edge of the screen.

Toolbar Options
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Chapter 2
Configuring Financial

Reporter

In this chapter we will show you how to configure the Adagio account trees. There
are four different trees that you can display:

• account groups
• account data
• chart of accounts
• departments (if departments have been enabled)

To open the account tree window, select Account Groups from the View menu.

These account trees work in the same way that Windows Explorer works. When you
see a ‘+’ sign, this indicates that there is another item or more underneath. Click the
‘+’ sign and these items will unfold. When the branch is fully expanded, the ‘+’ sign
will become a ‘-’ sign.

This chapter explains how to set up each of the trees and then describes how you can
customize the Account Groups window.
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Account Groups
The account groups tree is perhaps the most important window in Financial
Reporter. It is important that you take the time to establish a detailed and accurate
listing of all your accounts. This will make it a lot easier and faster to create reports.

Your accounts can be organized in any way that is appropriate for your accounting
system. Financial Reporter comes pre-loaded with an account group structure. You
can use this structure intact, modify it or create your own structure.

The Account Groups tree lists the following information for each account group:

• the name of the group and subgroups within each group
• the range of account numbers in each group
• the type of accounts included in each group.

As the financial reporter is a tool used to create financial statements, accounts are
most often grouped to reflect how they will appear on a particular financial
statement. For example, you might call a group Balance Sheet and within it create
another group called Current Assets. Within this second group you might create a
range of accounts called Bank that includes all of your bank accounts and another
range of accounts called Cash on Hand which includes your actual cash on hand and
petty cash accounts. The group Current Assets is one that would appear on your
Balance Sheet.

If your site is a new Adagio user and has made changes to the
Account Group assignments within Adagio Ledger, select View and
Account Groups from the Financial Reporter menu. Then, right
click on the column headings of the Account Group window and
select Reset to default. This will force the Financial Reporter to
read through the Account Group assignments set in Adagio Ledger
and update the Adagio Ledger Account Group definition
accordingly within Financial Reporter. The purpose of this is to
make the updated account groups available within the basic
financial statements that ship with the product.

Pop-up Menus
The account groups tree offers a number of pop-up menus that you can access using
the right-hand button on your mouse. These menus help you organize account
groups and give you control over what information each Account Group will include
when you drag it into the spreadsheet.

If you right-click on a first-level heading (which is your company name) in the tree
list, the following menu appears:

Account Groups
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Menu Item Function

New Group Allows you to add a new group.

New Range Allows you to add a new range of account numbers for the
selected group.

Sort Sub List Sorts the next level of headings in alphabetical order.

Copy Allows you to copy an existing account or range of
accounts to the Windows Clipboard.

Paste Allows you to paste the contents of the Windows Clipboard
into another group.

Account Groups
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If you right-click on a second-level heading (possibly the name of a type of
statement) in the tree list, the following menu appears:

Menu Item Function

Add page break Turning this option on will cause the Financial Reporter to
insert automatic page breaks before that account group on a
financial statement. For example, if you wished to have
your income and expenses on separate pages of your
income statement, you could set up the Expenses account
group to include an automatic page break. This would
insert a page break prior to the expenses data when you
created a new income statement specification via the drag
and drop method from the Account Groups View. It would
also automatically insert heading information onto the
second page.

When you do turn this option on, you’ll see a small red line
appear in the upper, left corner of the account group icon,
indicating visually that it will generate a page break when
dropped onto a specification.

NOTE: The page break line is red by default; however, yours may
not be red if your display options have been changed. See page
1-11 for more information on your display settings.

When you perform the drag and drop, as in our income
statement example, a red line will appear above the row
number at which the page break will occur, and then the
heading information for the financial statement will be
repeated.

Name as title Allows you to show the name of the group on reports.
When this option is selected, a blue line appears in the
upper portion of the icon associated with the selected
group.

Include total line Allows you to include a total line for the group in reports.
When this option is selected, a blue line appears in the
lower portion of the icon associated with the selected
group.

Account Groups
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Properties Displays a window that allows you to view and edit the
properties of the group, including:

� Add Page Break option
� Name as Title checkbox
� Included Total Line checkbox
� Name field
� Style for character values pull-down list
� Style for numeric values pull-down list

New Group Allows you to add a new group.

Delete Group Allows you to delete the selected group.

New Range Allows you to add a new range of accounts under the
selected group.

Sort Sub List Sorts the next level of headings in alphabetical order.

Move Up Moves the selected group one place higher in the tree list.

Move Down Moves the selected group one place lower in the tree list.

Copy Allows you to copy information from a group, an existing
account or a range of accounts to the Windows Clipboard.

Paste Allows you to paste the contents of the Windows Clipboard
into another group.

Account Groups
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If you right-click on the name of any range of account numbers, the following menu
appears:

Menu Item Function

Summarize to acct. Includes a detail line for accounts only, not departments.
This option is available only if departments are enabled.

Show detail lines Allows you to show detail lines for the ranges on reports.
When this option is selected, a blue line appears on the
left side of the icon associated with the selected group.

Include total line Allows you to include a total line for the range on reports.
When this option is selected, a black line appears in the
lower portion of the icon associated with the selected
group.

Liability/Revenue When checked, indicates that this range represents a
liability (in balance sheet or retained earnings accounts) or
revenue (in income statement accounts). When this option
is selected for a liability or a revenue, a red minus sign
appears in the icon associated with the selected group.
Click this option to “flip” an amount sign prior to printing
it on a report.

Properties Displays a window that allows you to set the name, range
of account numbers associated with the range and the
range type (balance sheet, income statement or retained
earnings). The window also allows you to set the
following options:

� Summarize to account or Show detail lines
� Include total line
� Liability or Revenue

Delete Range Allows you to delete the selected range.

Move Up Moves the selected group one place higher in the tree list.
You can also use the Alt key + the up arrow.

Move Down Moves the selected group one place lower in the tree list.
You can also use the Alt key + the down arrow.

Copy Allows you to copy an existing account or range of
accounts to the Windows Clipboard.

Account Groups
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Menu Item Function

Paste Allows you to paste the contents of the Windows
Clipboard into another group.

You can also right-click on the title bar of the tree (where it says “Name” and
“Range”), and the following menu appear will appear:

Menu Item Function

Allow Docking Allows the window containing the tree list to be
docked along the entire edge of the screen to which it
is dragged without overlapping other open windows.
If the window is not dragged right to the edge, it will
not dock correctly and display with an active
window bar rather than the beveled edge.

If this function is not selected, the windows can be
dragged anywhere on the screen but will cover some
of the worksheet area and will display with an active
window bar.

Hide Removes the tree list window from the screen.
Clicking on the 'x' in the beveled bar will also do this.

Reset to startup Deletes all changes made during the current session
and resets all values to those at the beginning of the
session.

Reset to default Resets the account groups structure to the structure
that existed when the system was initialized.

Float in Main Window Allows any open windows to float freely within the
screen and overlap other windows.

If you have made changes to your Account Groups and wish to discard all of the
changes made in this working session, right click on the column headings of the
Account Group window and select Reset to startup. Your Account Groups will be
reset to what they were prior to your accessing this Maintain Financial Reporter
session.

Account Groups
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Configuring Account Groups
Defining account groups in Adagio Financial Reporter is similar to developing an
outline. You start by adding an account group, or using an existing account group.
Then you add any number of sub-groups at as many different levels as you require.
Financial Reporter is flexible enough to accommodate any account group structure
that satisfies your requirements. This allows you to develop a number of levels of
account groups before you define the range of account numbers. The last level of
sub-groups is then used to define the range of account numbers in that group.

As the financial reporter is a tool used to create financial statements, accounts are
most often grouped to reflect how they will appear on a particular financial
statement. For example, you might call a group Balance Sheet and within it create
another group called Current Assets. Within this second group you might create a
range of accounts called Bank that includes all of your bank accounts and another
range of accounts called Cash on Hand which includes your actual cash on hand and
petty cash accounts. The group Current Assets is one that would appear on your
Balance Sheet.

You can also delete account groups and ranges to customize the account group
structure that is provided for you.

Adding an Account Group
To add an account group to the account groups tree:

1) Right-click an account group that you want this new group to appear under,
such as under the name of the company. If you are adding a main group, right-
click on the first level heading (the main branch of the tree). A pop-up menu
appears.
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2) Select New Group from the pop-up menu. The Add Group window appears.
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3) Complete the Add Group window according to the following table:

Field Entry

Add page break Turning this option on will cause the Financial
Reporter to insert automatic page breaks 'before'
that account group on a financial statement. For
example, if you wished to have your income and
expenses on separate pages of your income
statement, you could set up the Expenses account
group to include an automatic page break. This
would insert a page break prior to the expenses data
when you created a new income statement
specification via the drag and drop method from the
Account Groups View. It would also automatically
insert heading information onto the second page.

When you do turn this option on, you’ll see a small
red line appear in the upper, left corner of the
account group icon, indicating visually that it will
generate a page break when dropped onto a
specification.

NOTE: The page break line is red by default; however,
yours may not be red if your display options have been
changed. See page 1-11 for more information on your
display settings.

When you perform the drag and drop, as in our
income statement example, a red line will appear
above the row number at which the page break will
occur, and then the heading information for the
financial statement will be repeated.

Name as title Check this box if you want to use the name of the
group as the group title on printed reports.

Include total line Check this box if you want to include a total line for
this group on printed reports. When this option is
selected, a blue line appears in the lower portion of
its icon.

Name Enter the name of the group.
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Field Entry

Style for character values Select a style for character values from the drop
down list.

NOTE: The program comes with three pre-defined styles.
If you want to edit or add styles, select Styles from the
Format menu.

Style for numeric values Select a style for numeric values from the drop
down list.

NOTE: The program comes with three pre-defined styles.
If you want to edit or add styles, select Styles from the
Format menu.

4) Click OK to save the account group when you have completed all of the fields.
The account group will be added to the tree list. You can also click Cancel at any
time to exit the Add Group window without adding the new group.

Deleting an Account Group
You may delete an account group at any time. You can use this function to customize
the account structure provided with Adagio Financial Reporter or to modify your
own account group structure.

To delete an account group from the account groups tree, right-click on the group
you wish to remove from the tree list and select Delete from the pop-up menu. You
will not be prompted to confirm the deletion, so be sure that you want to delete the
group before you do this.

Deleting a Group will also delete all ranges associated with the
group.
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Modifying an Account Group
You can change the properties of any second-level or lower account group at any
time. You cannot, however, change the properties of the main-level account group.

To modify the properties of an account group:

1) Right-click on the account group you want to modify. A pop-up menu appears.

2) Select Properties from the pop-up menu. A Group Properties window appears.

Configuring Account Groups

Page 2-32 Adagio Financial Reporter



3) Modify the information in the Group Properties window according to the
following table:

Field Entry

Add Page Break Turning this option on will cause the Financial
Reporter to insert automatic page breaks before
that account group on a financial statement. For
example, if you wished to have your income and
expenses on separate pages of your income
statement, you could set up the Expenses account
group to include an automatic page break. This
would insert a page break prior to the expenses
data when you created a new income statement
specification via the drag and drop method from
the Account Groups View. It would also
automatically insert heading information onto the
second page.

When you do turn this option on, you’ll see a
small red line appear in the upper, left corner of
the account group icon, indicating visually that it
will generate a page break when dropped onto a
specification.

NOTE: The page break line is red by default; however,
yours may not be red if your display options have been
changed. See page 1-11 for more information on your
display settings.

When you perform the drag and drop, as in our
income statement example, a red line will appear
above the row number at which the page break
will occur, and then the heading information for
the financial statement will be repeated.

Name as Title Check this box if you want the name of the group
to appear on printed reports.

Include Total Line Check this box if you want to include a total line
for this group on printed reports. When this
option is selected, a blue line appears in the lower
portion of the icon associated with the selected
group.

Configuring Account Groups

Configuring Financial Reporter Page 2-33



Field Entry

Style for character values Select a style for character values from the drop
down list.

Style for numeric values Select a style for numeric values from the drop
down list.

4) Click OK to save the changes. Click Cancel at any time to exit the Group
Properties window without saving any of the changes.

Defining a Range
The range of account numbers is defined in the last level of your account group tree.
You can add, delete and modify ranges at any time.

The number of levels you define is at your discretion. For example,
you may define a range immediately below a main level group
heading or after a secondary or other level group.
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Adding a Range
To add a range of account numbers to a group:

1) Right-click a group that you want to enter the range immediately under and
select New Range. The New Range window appears.

2) Complete the fields in the New Range window according to the following table:

Field Entry

Name Enter a name for the range (up to 40 alphanumeric
characters are allowed). To specify a range of accounts,
enter the starting account, type a colon (:) and enter the
ending account. To separate one range from another or
from another individual account, type a comma (,).

Range Enter the range of accounts to be used.

Select Type Click the radio beside the type of accounts represented by
the range. You can select one of Balance sheet, Income
statement or Retained earnings.

Configuring Account Groups

Configuring Financial Reporter Page 2-35



Field Entry

Enable detail Turn this checkbox on if you wish to specify the level of
detail that is included for accounts only (this does not apply
to departments). This option is available only if
departments are enabled in Adagio Ledger or Adagio FX.

When this option is checked, you can either have the
financial statement Summarize to account or Show detail
lines for accounts. When the Show detail lines option is
selected, a blue line appears on the left side of account
range’s icon.

Show detail lines This option only displays if departments are not enabled in
Adagio Ledger or Adagio FX.

When this option is selected, a separate row will display in
the statement for each account in the range and a blue line
appears on the left side of the account range's icon.

Include total line Click to include a total line for the account number on
printed reports. When this option is selected, a black line
appears in the lower portion of the account range’s icon.

Liability/Revenue Click to define the account as a liability account (if Balance
Sheet or Retained Earnings was selected as Type) or as a
revenue account (if Income Statement was selected as
Type). When this option is selected, a red minus sign
appears in the account range’s icon.

3) Click OK to save the range when you have completed all of the fields. The range
will be added to the account group. You can also click Cancel at any time to exit
the New Range window without adding the new range.
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Adding Accounts and Departments to a Range
Once you have created a range, you must then specify what accounts and/or
departments you want included in that range.

1) Open the Chart of Accounts window by selecting Chart of Accounts from the
View menu.

The chart of accounts is defined in Adagio Ledger or the accounting software
you have retrieved into Adagio FX. Refer to the Adagio Ledger manual or your
accounting software manual for detailed information on setting up a chart of
accounts. Adagio Financial Reporter reads the chart of accounts from your
Adagio Ledger or Adagio FX database.

2) You can select the accounts and departments within this window and drag them
to a range in the Account Groups window. You can multi-select accounts by
holding down the Shift or Ctrl keys on your keyboard as you select accounts in
the Chart of Accounts.

3) When you drag the accounts to the range, notice that the account numbers
appear in the Range Column of the Account Groups window, next to your new
range.
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By default, accounts are organized by Account Type - Balance, Income or Retained
Earnings accounts. However, you can change this by right clicking within the Chart
of Accounts window and selecting Organize by Field. Highlight the field you wish
to reorganize your CofA by and click Okay. For example, you might want to quickly
organize the Chart by Status to see which accounts, if any, are Inactive. Or, if you've
defined Optional text fields in your Company Profile, you might use one of these
fields to further describe accounts in your Chart. The next time you open the Chart
of Accounts view, the Chart will again be organized by the default Account Type.

You can also right click anywhere within this window and select Recalculate
Balances. This will add both a debits and a credits column to the right of each
account (you may have to resize the window to see them) and calculate what the
current balance is for each account.

To view your chart of accounts in a worksheet, can select File | Send to Sheet |
Chart of Accounts. The chart of accounts is transferred to the empty worksheet.

To verify if the active financial statement is missing or contains duplicate accounts,
right click and select Verify. Missing accounts display in the Chart of Accounts with
a red 'X'. Duplicate accounts display with a blue '!'.

Deleting a Range
You can delete a range at any time. This is useful if you want to customize the
account structure provided with Adagio Financial Reporter or modify your own
account group structure.

To delete a range from the account groups tree, right-click on the range you want to
remove, and select Delete from the pop-up menu. The range is deleted from the tree
list.

Modifying a Range
You can make two different modifications to an existing range: You can change the
properties of the range and you can change the account numbers and account types
associated with the range.

To modify the properties of a range:

1) Right-click on the range you want to modify and select Properties from the
pop-up menu.
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A Range Properties window appears.

2) This window indicates the type of accounts and account numbers included in the
range. Modify the information in the Range Properties window according to the
following table:

Field Entry

Name Enter a name for the range (up to 40 alphanumeric
characters are allowed)

Range If needed, you can modify the range of accounts specified
here. To specify a range of accounts, enter the starting
account, type a colon (:) and enter the ending account. To
separate one range from another or from another individual
account, type a comma (,).

Select type Click the radio beside the type of accounts represented by
the range. You can select one of Balance sheet, Income
statement or Retained earnings.
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Field Entry

Enable details Turn this checkbox on if you wish to specify the level of
detail that is included for accounts only (this does not apply
to departments). This option is available only if
departments are enabled.

When this option is checked, you can either have the
financial statement Summarize to account or Show detail
lines for accounts. When the Show detail lines option is
selected, a blue line appears on the left side of account
range’s icon.

Show detail lines This option only displays if departments are not enabled in
Adagio Ledger or Adagio FX.

When this option is selected, a separate row will display in
the statement for each account in the range and a blue line
appears on the left side of the account range's icon.

Include total line Click to include a total line for the account number on
printed reports. When this option is selected, a black line
appears in the lower portion of the account range’s icon.

Liability/Revenue Click to define the account as a liability account (if Balance
Sheet or Retained Earnings was selected as Type) or as a
revenue account (if Income Statement was selected as
Type). When this option is selected, a red minus sign
appears in the account range’s icon.

3) Click OK to save the changes. You can also click Cancel at any time to exit the
Range Properties window without saving any of the changes.

To modify the account numbers or account types:

1) Select Chart of accounts from the View menu to open the Chart of Accounts
window.

2) You can use the Shift or Ctrl keys to multiselect accounts. Then drag the desired
account numbers into the target range of accounts in the Account Groups
window.

The account numbers will be included in the range. Adagio Financial Reporter
automatically verifies that the account numbers and types are valid.
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You can also modify account numbers manually. However,
Financial Reporter does not perform validation for manually
modified ranges.

To modify the account numbers or account types, manually:

1) Select the range you want to modify in the Account Groups window.

2) Right click on the range and select Properties.

3) Make the required changes to the range of account numbers by typing the
changes.

4) Press Enter on your keyboard or left-click on the OK button to save the changes.
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The Other Tree Windows

Account Data
To open the Account Data window, select Account Data from the View menu.

The Account Data tree has two functions. It allows you to view the data elements
that Adagio Financial Reporter uses to transfer account information into the
worksheet.

It is also used when dragging Account Groups onto the spreadsheet. For example,
when you drag an account group onto the spreadsheet, the Account Data window
will automatically open so that you can select the data you want to include on the
statement. The Name field will appear as a column heading on your reports. This
field can be edited. The symbol field cannot be changed.
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Take a moment and scroll through the tree. There are numerous sections relating to
balance sheets, income statements, budget figures, forecasts, statistical units,
providsion postings, etc..

Departments
The Departments tree is provided as a reference tool that allows you to view the
departments in your system.

The departments are defined in Adagio Ledger or the accounting software you’re
retrieving into Adagio FX. Refer to the Adagio Ledger manual or your accounting
software manual for detailed information on setting up departments. Adagio
Financial Reporter reads the departments from your Adagio Ledger or Adagio FX
database.

Departments can be displayed by selecting Departments from the View menu.

Other options related to departments follow.

Show Accounts
Shows the all of the accounts for the highlighted department as a subtree of the
department. Departments for which accounts are already shown as a subtree have a
'+' next to them, indicating the tree can be expanded.

Hide Inactive
Selecting this option hides from the view any departments that have been made
Inactive within Adagio Ledger's or Fx's Edit Departments function. Depending on
its current setting, the function toggles between Hide Inactive and Show Inactive. It
affects the display of the departments in the View Departments window only. It
does not prevent Inactive departments that may be included within a Departmental
Range or Mask from displaying. Inactive departments display with a red stop sign
having a slash through it icon. This setting is retained until changed.
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To prevent results for Inactive departments having no activity in
the period being reported from being included in the statement,
enable the Ignore Inactive button in the toolbar.

Set Order
You are able to right click on and Move departments up or down in the view
window. If you want your changes to be permanent (at least until you change them
again), select the Set Order function.

Departmental Masks
For more information on creating Departmental Masks, see page 3-108.

Departmental Lists
For more information on creating Departmental Lists, see page 3-109.

Departmental Ranges
Ranges of departments can be defined in the last level of your department groups
tree outline. You can add, delete and modify ranges at any time.

Restricted users cannot create departmental ranges or masks. To
read more about user security, see the User and Group maintenance
topics in the main help file.

Creating Departmental Ranges
To create a departmental range, highlight a selection of departments by clicking on
the first department and then, while holding down the Shift key, clicking on the last
department you want to include in the range. Then, right-click and the Create
Departmental Range option appears on the right-mouse button pop-up menu. Type
a description for the new Department Range. See the screen sample below for a view
of the range options.
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Editing Departmental Ranges
To edit a department range, right click on the range in the Departments view and
select Edit Departmental Range. You can type the account range directly into the
Start and End fields. For example, if you want to set a departmental range for
department numbers that are used in the United States only in sample data, then you
will see the following window:

Departmental User Restrictions
In the Departments tree, you can right-click anywhere and you will see the “Create
user departmental restrictions” option at the bottom of the pop-up menu.

This option allows you to limit the departments that certain users can work with on
the financial statements they have open, when that user is logged in. Financial
statements using this feature should not have departments hard-coded into the
account range.

Only the Adagio System Administrator (user SYS) can create these
restrictions. Other users cannot see this menu option and cannot
modify it. Ensure that the System Administrator logs in to Adagio
before starting the Financial Reporter if you want to set this
option.
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When you select the Create user departmental restrictions option, the following
window appears:

To restrict a user from seeing and working with certain departments on financial
reports, locate that department number, mask, or range, and click the checkbox
beside it 'off' (i.e. no checkmark beside it).

To permit a user to see and work with that department, mask, or range, click and
check the box beside it.

Click OK to save your changes. The next time the user logs in, they will not be able to
see the unchecked departments in the Departments tree.

Chapter 3 contains detailed information about working with departments in financial
reports.
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Chapter 3
Creating a Report

Once you set up your Account Groups tree, you can use it to create all kinds of
financial reports. The procedure for creating a financial report is based on a simple
“drag and drop” function. Adagio Financial Reporter allows you to customize both
the content and format of a financial report. You can specify exactly what
information to include in the report, and then use the formatting features to
customize the layout.

In this chapter, we will describe the procedures for:

• Adding Data
• Formatting the Report
• Setting up the Page
• Importing a Specification
• Printing the Report
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Adding Data
The first step in creating a financial report is to enter the data on a work sheet. To do
this, you must specify what data you want to include and determine the order you
want it to appear in.

The following steps will outline the most basic way to add data to your worksheet.
You can also use SmartSheets, described in the next section, to add data and make
working with your financial specification easier.

To enter data on a work sheet:

1) Open the Account Groups tree window.

2) Expand the branches of the tree to the level of detail that includes only the
accounts that you want to include in your report.

3) Click and drag the desired accounts and drop them onto a blank worksheet.

4) The Select Fields window will automatically appear. The account data fields are
listed in the window and grouped into several categories. Each category is
expandable, just like the tree list windows.
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Click the Clear Selections button to clear/remove any previously selected fields
for this statement. Note that the General Info tree field, Description, cannot be
cleared in this manner as it is rare that a user wouldn’t want the Account
Description to print on the statement.

When you are selecting fields to include on the report/statement, you can simply
click each field you want to include individually, or you can multi-select the
fields.

To multi-select fields for inclusion, use the Shift+Click or Ctrl+Click options, and
then press the Spacebar to turn multiple fields on all at once for inclusion.

• To multi-select a contiguous group of fields, press and hold Shift down while
clicking on the first field in the list you want to include, and then the last field.

• To multi-select a non-contiguous group of fields, press and hold the Ctrl
button down and then click each field of interest once.

When you’ve selected all of the fields to include, hit the Spacebar once and they
will all be added to the report.

You can also use the Spacebar to toggle or turn on the fields you want to include
one at a time, while scrolling through the list.

5) Click the checkboxes to indicate the specific account data you want to include in
the report. As a simple example, you might click “Description” and “Current
Balance on File.”

6) Click OK. The Layout window appears.

The checkboxes at the top of this window are all related to the SmartSheet
capabilities.
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SmartSheet technology makes working with your financial statements easier and
faster. It also helps avoid errors in your financial statements when changes are
made to your chart of accounts. If you wish to make this financial statement a
SmartSheet, turn the Enable SmartSheet option on. You will see, once your
financial statement has been created, that any statement that uses SmartSheet
technology will have the .SmartSheet notation in cell A1.

If you are working with an existing worksheet that was not created
with SmartSheet technology, you can easily turn it into a
SmartSheet by typing “.SmartSheet” in cell A1, or by right-clicking
in cell A1 and then selecting Make SmartSheet from the pop-up
menu.

If you are creating a SmartSheet this way, unless column A is
already blank, you will want to insert an extra column to create a
blank column A and then follow the above instructions.

If the top checkbox, Enable SmartSheet, is turned on, the other checkboxes will
also be available.

If you have chosen to use the SmartSheet technology, please read the following
section on “Using SmartSheets” for information on the remaining SmartSheet
options in this window, as well as other SmartSheet functionality and features.

If you decide not to use SmartSheet technology on this statement, turn this
checkbox off and the other options will not be available. You will only have the
option to re-sort your columns before adding the data to the financial statement.

7) This window allows you to change the column order. To move a column, click
the column heading once to select it, then click it again and drag the column
heading to its new location. However, you cannot move the Description column.

8) Click OK when the columns are arranged the way you want them.

The financial report appears on the worksheet.
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Working with SmartSheets
The Financial Reporter gives you the option to use SmartSheet technology to make
working with your financial statements easier and faster, and to help avoid errors in
your financial statements when changes are made to the chart of accounts.

A financial statement that uses SmartSheet technology will have the .SmartSheet
notation in cell A1.

The following topics discuss the various features of SmartSheet technology.

Creating a SmartSheet
There are two basic ways to create a SmartSheet. If you are working with an existing
worksheet that was not created with SmartSheet technology, you can easily turn it
into a SmartSheet by typing “.SmartSheet” in cell A1, or by right-clicking in cell A1
and then selecting Make SmartSheet from the pop-up menu.

If you are creating a SmartSheet this way, unless column A is already blank, you will
first want to insert an extra column to create a blank column A and then follow the
above instructions.

The other way to create a SmartSheet is to use the drag and drop functionality from
the Account Group View and select the Enable SmartSheet option when you do so.
This method is described below.

Drag and Drop Abilities from the Group View
The Account Group View’s drag and drop capabilities, which are used to quickly and
easily add information to your financial statements, have a SmartSheet field option in
the Layout dialog. Select View | Account Groups from the menu to activate the
Account Group View.

Working with SmartSheets
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For example, if you are creating a new balance sheet, open the Account Group View,
click on the Balance Sheet account group in this window and, while holding the left
mouse button down, drag the group over to the blank spreadsheet area of the
window. After selecting the Account Data fields you want to have included on the
statement, you are prompted to select some additional options in the Layout
window:

The checkboxes at the top of this window are all related to the SmartSheet
capabilities.

If you turn on the top checkbox, Enable SmartSheet, then the other checkboxes will
also be available. If you decide not to use SmartSheet technology on this statement,
turn this checkbox off and the other options will disappear. You will then only have
the option to re-sort your columns before adding the data to your financial statement.

If you have chosen to use the Enable SmartSheet, the following fields are also
available to you:

• Add Titles. This option will automatically include the company name and an
“as of” date on your statement. If this checkbox is not activated, this
information will be excluded. By default, this option is preselected for you.

• Expand. Turning this checkbox on will result in an expanded statement
(showing detail account lines) rather than a collapsed (to account ranges)
statement, when you first create the report. This can be easily changed after if
desired. See the following section, page 3-59, on “Expanding and Collapsing
Statements” for more information.

• Insert blank column before numeric columns. Turning this option on will
result in a narrow column being added before the numeric columns. This
automatically creates a white space between numeric column underlines.

• Use group formula for ranges. Turning this option on causes the Financial
Reporter to insert the ACCOUNTGROUP and ACCOUNTGROUPDEPT

Working with SmartSheets

Page 3-52 Adagio Financial Reporter



functions into your SmartSheet. When the Financial Reporter uses these
functions in your Smartsheet, it ensures that if a user edits the account group
range at any time, the changed accounts will be automatically reflected in the
financial statement when it is opened next or, if already open, F9 is pressed.

• Use Colspec format. Turning this option on allows you to use a ColSpec
report style for the financial report. Read more about ColSpec Reports
beginning on page 3-66.

• Separate DR/CR cols. Turning this option on will result in the creation of
separate columns for debit and credit amounts.

• Departmental Comparative. Turn this checkbox on to create a financial
statement that displays departmental data side-by-side in columns on the
report. When you choose this option and click OK, you will be prompted to
select the departments to include in the comparison. Select the departments of
interest in the same manner used to select Account Data fields. When the
statement is created, all selected fields for the first department will be set out
in a series of columns, with a departmental title. The next department(s) will
be laid out to the right in the same manner. If you select this option, please
read the section on “Departmental Comparative Statements” beginning on page
3-106 for more information.

When you have selected your SmartSheet layout options and have resorted the
report columns, click OK and your worksheet report will be created accordingly.

SmartSheet Ranges
A key advantage to using the SmartSheet technology in your financial statements is
its account range processing capabilities.

Without SmartSheet technology, your financial statements hardcode the account and
department information into the statement's references and formulas. If you make
any changes to your chart of accounts, the statements affected will require
time-consuming modification.

With the SmartSheet range processing functionality, your financial statements are
updated with any changes to your Chart of Accounts automatically through the use
of “.Range” lines.

However, the range feature won’t work unless you’ve set up your account ranges to
allow for the display of detail in the expanded mode. To set up your account ranges
to take advantage of the expanded mode, open your Accounts Group view (select
View | Account Groups) and then right-click on a range of accounts you’ve set up,
such as “Current assets”. From the pop-up menu that appears, select Show detail
lines. This option has been activated if it appears on the pop-up menu with a
checkmark beside it.

When you create a financial statement as a SmartSheet, you will notice that in
column A, there is a new .Range notation beside each range of accounts specified in
Column B.
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The .Range indicates that this row is expandable, using the expand/collapse buttons
in the toolbar. (Please see page 3-59 for more information.) When you expand a row,
all accounts in that range will appear in the expanded statement, including any
newly created charts of accounts.

If you are in the expanded view, rather than seeing the .Range
notation, you will see, “||** Generated Row **||”.

.Range also respects the department ranges and masks chosen from the departmental
drop-down box on the toolbar.

Departmental .Range Options
In addition to .Range, there are also .RangeDept and .RangeAccount functions If
you use .RangeDept in column A of a SmartSheet, rather than .Range, the
SmartSheet will expand the specified account range once for each department in the
range, without altering the account range specified. If you use .RangeAccount in
column A of a SmartSheet, rather than .Range, the SmartSheet will expand the
specified account range once for each account in the range, without altering the
department range specified.

.RangeDept() is useful in cases where you wish to create a row for every department
in a range, without changing the account range specified.

.RangeAccount is useful in cases where you wish to create a row for every account in
a range, summarized to the department mask used.

Example:
The following examples assume a database with these accounts:

• 1000
• 1100
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• 1110
• 1111
• 2000
• 2200
• 2220
• 2222

these departments:

• 1113
• 1133
• 1333
• 3333
• 1114
• 1144
• 1444
• 4444

and with at least one record for every account, department combination.

Account
specification

.Range
Expansion .RangeDept Expansion

(Assume the department mask
selection is 00??)

1000:1110 1000
1100
1110

1000:1110

??00 1000
1100
2000
2200

??00

1000:1100-` 1000-`
1100-`

1000:1100-1113
1000:1100-1133
1000:1100-1114
1000:1100-1144

??00-` 1000-`
1100-`
2000-`
2200-`

??00-1113
??00-1133
??00-1114
??00-1144
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Account
specification

.Range
Expansion .RangeDept Expansion

1000:1100-00?? 1000-1113
1000-1133
1000-1114
1000-1144
1100-1113
1100-1133
1100-1114
1100-1144

1000:1100-1113
1000:1100-1133
1000:1100-1114
1000:1100-1144

1000:1100-1133:1333 1000-1133
1000-1333
1100-1133
1100-1333

1000:1100-1133
1000:1100-1333

1000-1133:1100-1133 1000-1133
1000-1144
1000-1333
1000-1444
1000-3333
1000-4444
1100-1113
1100-1114
1100-1133

1000-1133:1100-1133
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Account
specification

.Range
Expansion .RangeDept Expansion

1000:1100-*

Account
Specification

1000:1100-`

1000:1100-???3

1000-1113
1000-1114
1000-1133
1000-1144
1000-1333
1000-1444
1000-3333
1000-4444
1100-1113
1100-1114
1100-1133
1100-1144
1100-1333
1100-1444
1100-3333
1100-4444

.Range
Expansion

1000-`
1100-`

1000-1113
1000-1133
1000-1333
1000-3333
1100-1113
1100-1133
1100-1333
1100-3333

1000:1100-1113
1000:1100-1114
1000:1100-1133
1000:1100-1144
1000:1100-1333
1000:1100-1444
1000:1100-3333
1000:1100-4444

.RangeAccount Expansion

1000-`
1100-`

1000-???3
1100-???3

Row Formatting
The .Row Format SmartSheet command allows you to apply any formatting desired
to generated rows which appear when you expand your SmartSheet. To use this
command:

1) Place the string “.RowFormat" in the last column of row 1 on your Smartsheet
(this column usually has the attribute “Hide when printed”).

For every row below the .RowFormat command, the Financial Reporter will
apply a style with the same name as any text value in the cell to the whole row.
This means you need to choose a style (or set up a new style) for the expanded
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rows and then use the “=IF()” condition to apply conditional formatting to rows
on expanded sheets.

2) Assuming you wish to create a style to use for the conditional row formatting,
select Format | Styles. A list of the currently defined styles will be displayed:

Enter a name for the new style, then click Add. Apply the formatting rules you
need from the available choices:

3) With the sheet collapsed, insert an =IF() formula in the same column as the
.RowFormat and the same row as the range of accounts you want tested. The
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=IF() formula should test the condition for the special formatting you desire. For
example, assume Columns D & E have the YTD and Budget YTD figures
respectively, and you want to highlight Expense overruns. The Formula would
be:

=IF($D9>$E9,"HighlightBold","")

This places the string “HighlightBold” in the cell, and the Financial Reporter will
apply that format to each row that satisfies the condition. When the SmartSheet
is expanded, all generated rows that meet that formula’s condition will have that
same formatting applied to them.

Samples
See the sample sheet “GL!RowFormat1” and “GL!BudgetExpense” in sample data for
examples.

Expanding and Collapsing Statements
As discussed in the previous section on the drag and drop enhancements in the
Account Group View, there is a SmartSheet feature which allows you to easily view
your statements in detailed or summary form. You “expand” the SmartSheet to view
the statement in detailed form and “collapse” it to view the statement in summary
form.

Expanding a sheet re-reads your chart of accounts. If you have created new accounts,
they will automatically be included in your SmartSheet statement after expanding,
assuming their code falls within an account range specified in the statement.

When you create your statement via the drag and drop method from Account Group
View, you can turn on the expanded view or leave it as a collapsed view. But you can
also expand and collapse the statement at anytime after it’s been created. There are
two methods of doing this:

• Right-click in cell A1, the .SmartSheet cell, and select Expand SmartSheet or
Collapse SmartSheet from the pop-up menu, or

• Click the expand/collapse buttons on the toolbar.
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Statements that Expand and Collapse should only be edited in
Collapsed mode. Editing the 'generated rows in the Expanded mode
can cause undesirable results. There is an Information Function
formula (see page 6-244) you can use to help you always know
which mode the sheet is in.

The Cut, Copy and Paste options only appear on the fly-out menu when you right
click on a cell in Collapsed module. They are disabled in the fly-out menu and the
toolbar when the statement is in Expanded module. As well, neither the
Create/Edit/Paste Hyperlink or Clear Contents options are available on the fly-out
menu when the statement is in Expanded mode.

Creating a Hyperlink
Hyperlinks to email addresses, websites and/or documentsmay be created and
stored in cells on the specification. Optionally, you may choose to enter specific text
to display in the cell rather than the actual email or website address. The text along
with its underlying link will be exported with the statement to your spreadsheet
program.

The option is only active on the context fly-out menu or from the
main menuwhen the statement is in Collapsed module.

To access the function from the main menu, select Edit and Insert Hyperlink:

Once created, the hyperlink may be copied and pasted to other cells and
specifications.

Verifying Ranges on Your SmartSheet
The .Verify function acts as a safeguard to ensure that all accounts within a specified
range have been referenced within the financial statement. This is easily done using
the .Verify function. This function will ignore accounts made Inactive within the
Adagio Ledger or FX Edit Accounts function.
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You can also verify accounts used in the worksheet displayed by
right clicking on the Chart of Accounts view (see page 2-37) and
selecting Verify.

To use .Verify, you must enter a range of accounts in column B, and then enter
.Verify in column A on the same row. (.Verify can be typed directly into column A,
or you may click the right mouse button in the appropriate cell in column A and then
select Make .Verify from the pop-up menu.)

For example, you may enter .Verify on row 10 of column A, and then type in
1000:2000 on row 10 of column B. Then, when you print, preview, or export the
financial statement, or when you run a verify check, the Financial Reporter will look
at the .Verify command and make sure that all accounts in the range 1000:2000 are
referenced somewhere within the specification. If an account that should be included
on the statement has been omitted, you will receive an error. This ensures that you
don’t miss important information on your statements by double-checking the
accounts included on the report against those found in the chart of accounts.

When you use .Verify at a particular point, such as row 10, the Financial Reporter
will look at the accounts in the range specified in cell B10 and make sure that from
that point on in the report, all of the accounts in the B10 range are referenced. .Verify
will not work if you put it at the bottom of a statement, for example, because it must
look “downward” at the content of the rows beneath the .Verify statement and range.

Using a .Verify Statement
The steps to use .Verify are simple:

• In an empty cell in column B, somewhere above the point at which you wish
to begin checking your ranges, type in a range of accounts, such as 1000:2000.

• In the cell to the left, in column A of the same row, type .Verify or select Make
.Verify from the right mouse button pop-up menu.

• Right-click on the .Verify statement and click Verify Range from the pop-up
menu to run the verify function. Or, print, do a print preview, or export the
file, and the ranges will also be verified in the same way.

When you verify your ranges, either of the following may occur:

• .Verify finds that all of the accounts you specified in your range are properly
referenced on the financial statement. You will be told:
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where cell B16 is the cell in which your account range was entered.

• .Verify finds that some of the accounts in your range are missing from the
financial statement. You will be advised of which accounts are missing:

Using Multiple .Verify Statements
If you use multiple .Verify statements, such as one at row 10 and one at row 25, the
Financial Reporter will first look at the accounts in the B10 range and verify that all
of those accounts are referenced somewhere between row 11 and row 24. Next, it will
look at the .Verify statement in cell B25 and repeat the process from row 26 forward,
until the next .Verify statement. This allows you to have several .Verify functions on
a specification, as needed in order to properly check the account ranges that should
be included on the report.

When you use multiple .Verify statements, the Financial Reporter will check each one
in turn. If there are no missing accounts in the first .Verify, it will let you know that
and then ask if it can move on to the next .Verify:

Click OK and it will check the next .Verify range that was specified and so on until
it’s finished.

If, however, it finds missing accounts in any of the .Verify ranges, then it will halt the
process entirely. In this case, correct the problem of the missing account(s) indicated,
and then run the Verify Ranges function again.
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Departmental References
When you drag and drop data onto a SmartSheet, including all departments in an
account range can be done in one of two ways:

• Using the ` character, such as in this example: ‘7000:8999-`, where all
departments in the account range 7000-8999 are included.

• Using the * character, such as in this example: ‘7000:8999-*, where all
departments in the account range 7000-8999 are included.

By default, all departments are included in this manner when dragging and
dropping data onto a SmartSheet.

Refer to the Department .Range Option section on page 3-55 for more information
on how the 'expanded' accounts display depending on whether the '`' or '*' is used
to reference all departments.

Missing and Duplicate Accounts
Adagio allows you to visually see missing accounts on any SmartSheet statement.
This prevents any accidental omissions from the financial statements.

With an active financial statement, open up the Chart of Accounts View. Right
mouse click on the Title bar of the View pane and select Verify from the drop down
menu.

Accounts missing off the active sheet will be highlighted with a red “X”.

Accounts that have been duplicated on the active sheet will display with a blue "!".
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This feature is only available if you have full access to the
Financial Reporter. If you are only in the print mode for the
Financial Reporter, you will not have access to this feature.

Select Reset from the pop-up menu before verifying another sheet.

AutoUpdating Your SmartSheet
By default, when you create a SmartSheet, an .AutoUpdate notation will appear in
cell A2.

This .AutoUpdate notation indicates that when you open the statement or if you
press F9 or use any menu’s Recalculate option to recalculate your statement, the
rows in your sheet will also be regenerated. This means that any change made that
affects the .Range feature will also be reflected when the spreadsheet is recalculated.

Should account changes be made by another station (eg. adding an account or
posting), you may still have to press F9 or Ctrl/F9 to read these changes into the
statement you have open.
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Use Recalculate (F9) to refresh the active sheet or Recalculate All
(Ctrl/F9) to refresh all sheets in the workbook.

You can remove this if you don’t wish to use the .AutoUpdate feature, just by
deleting the contents of cell A2. Or, if it is not included on a SmartSheet you’re
working with, you can either add it in simply by right clicking in cell A2 and
selecting Make .AutoUpdate or by manually typing “.AutoUpdate” in cell A2.

Printing a SmartSheet
When you print a SmartSheet, all of the information entered in columns A and B will
be hidden (Hide when Printed feature) automatically.

However, if you would like to print the account ranges stored in column B on the
report also, position your cursor in cell B1, right click and select Make
.ShowAccounts or simply type .ShowAccounts into cell B1.

If you remove .SmartSheet from cell A1, both columns A and B will
print on the report.
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ColSpec Reports

Overview
.ColSpec reports are created in one of two ways:

• By selecting the Use ColSpec format when you are creating a SmartSheet.
• By importing a statement from xDirect.

.ColSpec reports are different from other Adagio Financial Reporter specifications
because they include an extra row with a “.ColSpec” token in column A. This token
allows you to use the columns across this row to designate the fields you wish to
include in the report. The formulas that are added in these columns look to the field
name in the .ColSpec row of the column to retrieve the appropriate information. (In
non-.Colspec Financial Reporter specifications, the formulas in each column would
instead use the =ADGET function.

Traditional SmartSheet / ADGET example
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ColSpec Example

ColSpec Benefits & Notes
The main benefits of using a .ColSpec report are:

• Allows you to import statements from Excel and quickly reformat them just by
adding the .ColSpec token in column A.

• Allows you to quickly change an entire column of numbers by changing the
field in the column heading (in the .ColSpec row).

• Allows you to create ‘lookup’ column headings, where the column heading
and thus the entire row of values can be changed with one mouse-click.

Notes about using .ColSpec:

• The .ColSpec row is automatically hidden when printing.
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Drag & Drop ColSpec Reports

Creating a ColSpec report
To create a basic .ColSpec report, follow these steps:

1) Open the Account Groups tree window.

2) Expand the branches of the tree to the level of detail that includes the accounts
for which you want to create a report.

3) Click and drag the desired account group and drop it onto the worksheet. The
Select Fields window appears. The account data fields are listed in the window
and grouped into several categories. Each category is expandable like the tree list
windows.

4) Click the checkboxes to indicate the specific account data you want to include in
the report.

You can use the Spacebar to toggle or turn on the highlighted field. This makes
selecting fields faster from the keyboard, since you can scroll through the list of
fields with the up and down arrows and quickly press the Spacebar at each field
you wish to include. You can also multi-select the fields for inclusion using the
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Shift+Click or Ctrl+Click options, and then press the Spacebar to turn multiple
selected fields on all at once for inclusion on the report.

5) Click OK. The Layout window appears.

Ensure the Enable SmartSheet option is turned on. Then ensure the Use Colspec
format checkbox on.

6) Determine the order of the columns of information by clicking on then clicking
and dragging each column to the desired location. To move a column, click on it
and release, then click and hold while dragging the column to its new position.

7) Click OK. The financial report appears on the worksheet.

Editing a ColSpec report
Formatting a .ColSpec report is the same as formatting any other report in terms of
changing fonts, highlighting columns, hiding rows and columns, and so forth.

Statements that Expand and Collapse should only be edited in
Collapsed mode. Editing the 'generated rows in the Expanded mode
can cause undesirable results.

Changing a Column’s Values
However, if you wish to edit any specification information on the report, you will
need to do it in the .ColSpec row only. For example, if you need to change the
contents of one column, instead of editing the formulas all the way down the column,
you would simply click in the .ColSpec row within the column and enter the name of
the new field you want the column to display values for.

For instance, say you put the “Opening Balance” (or OPEN) field in Column D, but
you wanted to change it to the “Current Balance” instead. You would simply go to
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the .ColSpec row in Column D, and in place of OPEN, you would enter CURBAL.
When you recalculate, you will see that all the values in the column below the new
.ColSpec heading will change to reflect the change in field.

Changing a Cell’s Value
When .ColSpec reports are created, by default Adagio Financial Reporter assumes
you want the straight amount for each field that you include on the report. However,
you can change that if needed, by inserting some special account information
formulas that are meant for .ColSpec reports, as well. (See the Adagio =function
definitions beginning on page 4-124 for more information on each one.) They are:

• GLAMT - displays Amount
• GLCREDIT - displays Amount (credit only)
• GLDEBIT - displays Amount (debit only)

Two additional formulas don’t appear here, but are available for
.ColSpec reports that use the “Separate CR/DR Columns” option
from the Layout tab when you created your SmartSheet. They are
GLCRONLY and GLDRONLY. See the Adagio =function definitions
on page 4-124 for more information.

To insert any of these formulas:

1) Right-click in the cell where you want the formula to appear. A pop-up menu
will be displayed.

2) Go to the Insert Formula option, and a fly-out menu appears.

3) Highlight the Account Information option, and select the desired formula from
the list that appears.

Adding Fiscal Period Date Information
The Adagio Financial Reporter also includes two special formulas for .ColSpec
reports which allow you to insert fiscal period dates. This can be useful for creating
.ColSpec reports with lookup column headings. They are:

• GLFPS (Fiscal Period Start)
• GLFPE (Fiscal Period End)

These dates are formatted according to the date format you’ve entered in the View |
Customize window on the Settings tab).
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To insert either of these formulas:

1) Right-click in the cell where you want the formula to appear. A pop-up menu
will be displayed.

2) Go to the Insert Formula option, and a fly-out menu appears.

3) Highlight the Account Information option, and select the desired formula from
the list that appears.

ColSpec & Importing from xDirect
One of the most useful features of .ColSpec reports is the ability to import statements
from Excel and then quickly and easily change them into useable Adagio Financial
Reporter specifications.

To do this, follow these steps:

1) Open the statement of interest in Excel.

2) Open your Financial Reporter, and then select File | Import from xDirect. Your
statement will appear in the Financial Reporter window and will be set to use
the .SmartSheet capabilities automatically.

3) Insert a row above your column headings, by selecting that row and then
right-clicking. From the pop-up menu that appears, select Insert Row.

4) In Column A of the row you just inserted, right-click and select Make .ColSpec
from the pop-up menu that appears.

5) Next, we must indicate what data each column should contain.

• Move over to the first column of numbers. Determine what that column
represents (for example, the Current Balance of the accounts listed below).

• Open the Account Data window by selecting Account Data from the View
menu. In that window, locate the name of the field of interest — such as
Current Balance.

• Drag the appropriate field name across to the .ColSpec row, to the appropriate
column. Adagio Financial Reporter will enter the correct field information for
you.

Repeat this process for each column of data that appears in the report. When
you’re done, you may wish to close the Account Data window.
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6) Now we have to edit the account ranges for each row. To begin, open the Chart
of accounts window by selecting Chart of accounts from the View menu.

• Go to the first row of accounts. For example, if you’re editing a balance sheet
your first row might fall under the Assets category, as Cash or something
similar.

• In Column A of that row, right-click and select Make .Range from the pop-up
menu.

• From the Chart of accounts window, drag each account you wish to include in
the range over to column B of that row. Or, type in the range of accounts, such
as 1000:1050-`. (To enter a single account, you can also type it in manually, by
entering something like 1000-`.)

Repeat this process for each row that appears in the report. When you’re done,
you may wish to close the Chart of accounts window.

7) Now, we must insert the Adagio =functions to retrieve the data from the column
headings and the accounts ranges you’ve just entered.

• Go to the first column of data, to the top row where the first amount appears.
• Right-click on the cell. From the pop-up menu that appears, select Insert

Formula, and then Account Information.
• Select the Account Information you wish to use — generally this will be

Amount. (See the Account Information Notes section for more information.)
• Depending on what type of information you insert, you will be asked for some

formatting options. Select your preferences, then click OK.

Repeat this process for each cell in which an amount appears (except for
sub-totals and totals). You can also copy and paste the formulas down the
column.

8) Next, we can insert the Adagio =GLDESC function to provide a text description
on each row for the data you retrieved in step 7.

• Go to the first column where you want the first description to appear.
• Right-click on a cell the description should appear in. From the pop-up menu

that appears, select Insert Formula, and then Account Information.
• Select Account Description.
• In the screen that appears, enter first the number of spaces by which you want

the text to be indented in the cell (if at all); then enter the description you
would like to use for the range of accounts that applies to that row — such as
“Assets” if it’s a Balance Sheet and you’ve combined all asset accounts on a
given row.

• Click OK.
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The Text field is what will print when the SmartSheet is in
Collapsed mode; in Expanded mode, the =GLDESC function will
return the account description from the GL in expanded mode.

Repeat this process for each cell in which a text description should appear.

9) Finally, insert any appropriate sub-totals and totals with the =SUM function, (i.e.
=SUM(H12..H16)), and format your report as desired.

Your imported financial statement will now be auto-updated as your data in Adagio
FX or Adagio Ledger changes.

Account Information Notes
Although you will generally use the “Amount” field when you’re inserting a formula
into your ColSpec sheet, there are other options available as well. (See the Adagio
=function definitions for more information on each one.) They are:

• GLAMT - displays Amount
• GLCREDIT - displays Amount (credit only)
• GLDEBIT - displays Amount (debit only)

Two additional formulas don’t appear here, but are available for
.ColSpec reports that use the “Separate CR/DR Columns” option
from the Layout tab when you created your SmartSheet. They are
GLCRONLY and GLDRONLY. See the Adagio =function definitions
for more information.

ColSpec Lookups
One excellent feature of ColSpec reports is the ability to create lookup columns. This
is a column whose data can change with one mouse-click, by selecting a different
field in the .ColSpec row’s column heading.

To create a lookup column, open a ColSpec specification. Then, from the View menu,
select Account Data.

In the Account Data window, you can select fields that you wish to include in one
lookup column. For instance, you may wish to have a column that you can use to
look interchangeably at the Ending Balance of any one of the prior 13 periods. In this
case, you would select all of the End Bal. fields under the “Account Balance As Of”
tree.

When you’ve selected your fields of interest, select them one at a time and, in turn,
drag them over to the .ColSpec row, and drop them into the column that you wish to
use for the lookup.
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The column will change from containing just one field, to a list of fields. It will
appear with a down arrow at the right side of the field, allowing you to view the list
of fields included and to change them as you wish.

Once you’ve created the lookup column, all you need to do is change the value in the
column heading (at the .ColSpec row level) and press Enter, and the financial report
will automatically update to reflect the values for the field you’ve selected.

To edit the list of fields within the .Colspec field, right click and select Edit Colspec
from the flyout menu.

Use the Insert button to add another field. Or, select the field(s) in question and
either use the Delete button to remove it or the Add Prefixes button to add a prefix.
For example, typing 1 in the Prefix field for field of [2]M changes the field to {1}[2]M
meaning the Financial Reporter will report the 2nd Period Last Year.

If you wish to include fiscal period dates beneath the column heading, to remind you
of which period is being referred to in the printed report, you can use the Fiscal
Period dates discussed in the Drag & Drop ColSpec Reports topic. (These dates are
formatted according to the date format you’ve entered in the Customize window on
the Settings tab).
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Using Auto-formulas
Another way to add information to the spreadsheet is to use Financial Reporter’s
formulas. Because formulas are difficult to remember, Financial Reporter has added a
simplified method to enter formulas: auto-formulas.

These auto-formulas allow you to add information or comments that are not
included in the Select Fields window, such as column headers, dates and your
company information.

To add formulas to a cell automatically:

1) Right-click in the cell where you want to add information. A pop-up menu
appears.

On this same fly-out menu, if the Edit on Print option is turned on
as a cell property, users having Print Only security access will be
allowed to change/edit the cell. As well, you may change the color
assigned these cells using the Display Settings (see page 1-11).

2) Select Insert Formula from the pop-up menu. A second pop-up menu offers
several categories of information that can be automatically inserted into the cell.
Some of the categories offer another level of pop-up menus with additional
information options.
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3) Select the information you want to include in the cell by clicking on it. The
information appears in the cell. You can then format the cell as described in the
formatting section of this manual.

The following table lists the auto-formulas available in Adagio Financial Reporter:

Drop Down Selection Result (example)

Insert formula
Adagio System Date 6/21/2000

Current Date 6/21/2000

Current Time 4:45:38 PM

User Information
Initials SYS

Name System Account

Useful Text Strings
Balance Sheet Balance Sheet

Income Statement Income Statement

As of <Month DD, YYYY> As of June 21, 2000

Provisional Provisional

For the period
For the Period Ending … For the Period Ending July 31, 2000

For the Period Beginning … For the Period Beginning 7/1/2000

For the Period Ending … For the Period Ending 7/31/2000

For the xx Periods Ending … For the 7 Period(s) Ending Jul 31, 2000

For the xx Periods Ending … For the 7 Period(s) Ending 7/31/2000

For the Period from … For the Period from 7/1/00 to 7/31/00

Company Information
Company Name Adagio Corporation

Address1 123 North Charles Street

Address2 Baltimore, MD
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Drop Down Selection Result (example)
Address3

Phone 555 235-1000

Fax 555 235-1005

Postal Code 21204

Zip Code 21204

Account Information
Account Description Revenue - Consulting

Amount 127,317.07

Amount (Credit only) 0.00

Amount (Debit only) 127,317.07

Period start 02/01/2005

Period end 02/28/2005

Fiscal Information
Fiscal Period Number 7

Fiscal Period Starting Date 7/1/00

Fiscal Period Ending Date 7/31/00

Report Date Jul 31 00

Department Information
Department Code *

Department Description Consolidated Departments
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For more detailed information on GLCREDIT and GLDEBIT found
in Account Information (or for GLCRONLY and GLDRONLY),
please refer to Chapter 4.

If you want greater control over the information in a report and
you don’t mind working with formulas, you can also manually
enter the formulas into cells. See the Appendix on formulas for
descriptions of the available formulas.

•
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Formatting Reports
The second step in creating a financial report is formatting the report. Adagio
Financial Reporter employs all of the formatting features available in spreadsheet
applications.

The Format Toolbar
Many of the program’s formatting options are available as buttons on the toolbar. For
example, if you want to bold the text in a cell, select the cell then click the Bold
button on the toolbar. Or, if you want the text in a cell aligned to the right, click the
Right-align button on the toolbar. You can affect multiple formats to cells at one
time by using the Format Cell button. Or, if the data in a column(s) or row(s) is not
entirely visible, select the rows or columns to AutoFit by selecting either of those
buttons.

Another useful set of buttons on the toolbar are the cell style buttons, which are just
to the right of the Bold, Italics, Underline and Double Underline buttons. Format a
date cell using the Date Style stored in your View | Customize, Settings. If the data
in a cell is in dollars, select the cell and click the Currency Style button. This will
insert the dollar symbol before the number and allow for two decimal places. The
Accounting Dollar button inserts a narrow column and places a $ sign in it. The
Percent Style button will automatically insert the percent sign after the number. The
Comma Style button will format a number in a selected cell to use the comma as the
thousands separator.

The Decimal Places buttons allow you to quickly set the number of decimal places to
use in a selected cell. Clicking the Increase decimal button will round the number in
a selected cell to use one extra decimal place; whereas clicking the Decrease decimal
button will round the number to one less decimal place.

The second button from the left on the Format toolbar is the Cover Cells button. If
you have text that you want to span more than one cell, select the cells you want the
text to span and click the Cover Cells button.

The very last button on the right side of the Format toolbar is the Sum button. This
button quickly create a sum. To do so, click the cell where you want the total to
appear and click the Sum button. Next, select all the cells you want to add together
using Shift+Click or Ctrl+Click. Finish by clicking the Sum button one more time.
The sum will be created in the cell you originally selected.
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The View Toolbar
Like the Format Toolbar, the View toolbar contains a number of options that allow
you to change the appearance of your financial reports.

The first dropdown box on this toolbar allows you to set the fiscal period for the
report. Select the fiscal period you want the statement to report on.

The second dropdown box enables you to select the fiscal year for the statement to
report on. You must be using version 9.0A or higher and version 9.0A or higher data
must already exist for this option to be available on the toolbar.

Both the fiscal period and year may be pinned using the Pin Fiscal thumbtack
button to the left of the dropdown. When enabled, the button is red and any change
to the Fiscal Period and/or Fiscal Year dropdowns on a sheet in the workbook will
immediately make the same change to all other sheets in the workbook having this
button enabled. When disabled, each sheet in the workbook may have different
Fiscal Periods and Years selected to report on.

Clicking the Zero suppress button (with the red circle) will suppress any rows of all
zero values when you are printing your financial specification.

For zero suppression to work properly, absolutely all columns
(other than A and B) must have Zero Suppress turned on. If you are
experiencing difficulty getting the Zero Suppress option to work,
collapse the statement. Then, highlight all columns except A and B,
right click and turn off the Zero Suppress option in the menu. Right
click again and turn it back on. When next you expand the
statement and select the Zero Suppress button in the toolbar, your
all zero result rows will be suppressed again.

Next is the Blank zeroes button, which prints all zeroes in detail lines as blanks
without affecting the zeroes in any totals.

Provisionally posted amounts can be included on specifications by clicking the “P”
Include provisional button. This allows you to see what impact provisionally posted
amounts would have on your financial statements.

Clicking the Include year end adjustments button will include any transactions
posted using the YE Adjustments feature in the period being reported on. This
feature only exists if you have version 9.0 or higher data. Refer to the Adagio Ledger
online Help documentation for more information about this function.
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Click the Ignore inactive accounts option to suppress printing of any accounts
having an Inactive status on your financial specification. An account's status may be
changed from Active to Inactive within the Edit Acounts function of Adagio Ledger
or FX.

When the Update budget/forecast button is clicked, Adagio Ledger accounts’ budget
and/or forecast values will be updated by the Financial Reporter. What
accounts/departments are updated for what periods and for what functions (i.e.
budgets, forecasts, or both) is dependent on the GLUPDATE formulas used in the
sheet and whether the user has access to Adagio Ledger budgets and/or forecasts.
GLUPDATE is always enabled and for all years in FX9. If there is more than one
sheet containing data, you will be prompted for whether you want to run
GLUPDATE on this sheet only or on all sheets.

This button is only active in Adagio Ledger when the current fiscal
year is displayed in the toolbar. If the Next Year is open within
Adagio Ledger, it is considered the current fiscal year for this
function and will be the year updated unless the optional '1'
parameter is used in the formula which forces the update to be for
the previous year budgets/forecasts.

The up and down arrow buttons allow you to Expand and Collapse your
SmartSheet. (SmartSheets are explained in more detail earlier in this chapter.) If your
worksheet has not been defined as a .SmartSheet (i.e. cell A1 does not say
.SmartSheet), these two buttons will be inactive.

The next button allows you to turn your specification into a Consolidated (all
departments) statement. The button toggles the statement between being
consolidated of reporting on a specific department(s) only. If department codes have
been hardcoded into the account ranges in your statements (eg. 4000-100 rather than
4000 or 4000-` or 4000-*), this button will have no effect on the results your statement
returns.

The last drop-down box on this toolbar displays the Department number. When
active, you can change department numbers being reported on by clicking the down
arrow. To make the selection of the appropriate department easier, the dropdown
box that lists departments in the Financial Reporter includes the department’s
description rather than just the department number.

Use the Pin Department button to pin either the Consolidated or Department code
dropdown (whichever is active) so that any change made to these fields will
immediately make the same change on any sheet in the workbook also having the
Pin Department button enabled. The button is red when enabled.
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If department codes have been hardcoded into the account ranges in
your statements (eg. 4000-100 rather than 4000 or 4000-` or 4000-*),
this button will have no effect on the results your statement
returns.
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Working with Rows and Columns

Inserting Multiple Rows or Columns
You can easily insert multiple rows or columns. To do so, select the number of rows
or columns you wish to insert before the selected row(s) by clicking on the row
number(s) and using your mouse to highlight them. Then right click or select either
Insert Row or Insert Column from the Edit menu. For example, if you wished to
insert four columns to the left of Column D, you would select Columns D-G and then
right click or select Edit | Insert Column.

New columns are always inserted to the left of the selected columns; new rows are
always inserted above the selected rows.

In SmartSheets, inserted columns will not affect your formulas, as the columns that
contain the account and department ranges are hard-coded into the formulas.

Formatting Rows or Columns
If you wish to change the formatting of an entire row or column at one time, you can
simply select the row or column by clicking on its row number or column heading
and make your changes as needed. For example, you can select an entire row or
column of values and change the currency style (with/without a dollar sign) or the
number of decimal places or change just with the click of one button.

Duplicating Rows or Columns
You can quickly duplicate an entire row to a new row immediately above the one(s)
selected. Just select the row you want to make a copy of (by clicking the row
number). Then right-click and select the “Duplicate Row” option from the pop-up
menu that appears. The Adagio Financial Reporter will make a copy of the selected
row, insert a new row directly above it, and place the duplicate in that row. You can
then modify the row as desired.

The same may be accomplished for a column by clicking on its column heading, right
clicking and selecting the "Duplicate Column" option. The Adagio Financial
Reporter will make a duplicate of the selected column, insert a new column directly
to the left of it, and place the duplicate in that column.

Copying Rows or Columns
You can easily copy a row(s) to another location on the statement. Just select the
row(s) you want to make a copy of (by clicking the row number) and then right-click
or select Edit | Copy. Position your cursor anywhere on the statement you want the
first copied cell of the row(s) to appear and right click or select Edit | Paste..
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Deleting and Hiding Multiple Rows or Columns
Deleting or hiding rows or columns is very easy, since you can multi-select rows or
columns for these functions. To delete or hide multiple rows or columns, select the
rows or columns of interest, then delete or hide them all at once using the right
mouse button pop-up menu (or select from the Edit menu).

Standard multi-select rules apply: just drag the mouse along the cell letters or
numbers to select more than one contiguous row or column or hold the Shift key
down and click the first and last rows to highlight them and each row in between.
Or you can hold the Ctrl key down and then click each row or column to select
non-contiguous rows or columns.

Hiding Rows or Columns When Printing
In addition to the standard “Hide” feature, rows and columns can be hidden for
printing purposes only yet still be viewable on the design screen while working in
the Financial Reporter.

When a row or column has been hidden for printing purposes only, it will appear on
the screen but will be shaded blue so you know it won’t appear on your printed
report.

In a .SmartSheet, columns A and B are automatically hidden when
printed even though they are often not shaded blue.
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To hide a row or column, select it then, with your cursor in the grey area that marks
the column letters or row numbers, click the right mouse button. From the menu that
appears, select the Hide when printed option.

The shading of the hidden row or column may not be blue if you
have changed the default color preferences. Please see page 1-11 for
more information on your display settings (see page 1-11).

On this same fly-out menu, if the Edit on Print option is turned on
as a cell property, users having Print Only security access will be
allowed to change/edit the cell. As well, you may change the color
assigned these cells using the Display Settings (see page 1-11).
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The Cell Properties Window
There is also a more advanced way to control the format of a cell. Just highlight the
cells in the spreadsheet, then select Format | Cells from the menu or click the
Format Cells button (the first button on the Format toolbar). This will open the Cell
Properties dialog which gives you access to all the cell formatting options in one
window. This window is separated into six tabs -- font, color, borders, align and
based on.

You may also apply style to particular cells using Conditional Cell Styles (refer to
page 3-93).

If you want to format several cells at once, select all the cells by
holding down the Shift or Ctrl keys while you select the desired
cells. You can then click the Cell Properties button or right click or
use the Format menu. All changes made in the Cell Properties
dialog will be reflected in all the highlighted cells.

You may also choose to Copy a formatted cell. After, you may you are able to right
click in a destination cell and select to Paste Formatting from Cell## only (i.e.
contents of cell won't be copied also) or use the Paste Formatting button in the
toolbar. The cell you are pasting to must be on the same sheet as the cell you copied
from. You can also choose to right click on a formatted cell and Clear Formatting for
that cell only.
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Font Tab
This tab allows you to select a font, font size, color and format for the text in the
selected cell.
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Color Tab
The Color tab allows you to change the color of the selected cell.

The following table describes the fields on this tab:

Field Description

Interior If you want to use shading (patterns) in the cell, select
a shading from the drop down field at the top of this
tab.

Foreground Select a foreground color for the selected cell.

Background Select a background color.

3-D Effect If you want the cell to appear as though it was
3-dimensional, select either Inset or Raised.

Preview Shows you what the cell will look like according to
your selections on this tab.
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Borders Tab
This tab allows you to format the borders for each cell.

To use this tab, first select the border you want to format: Left, Right, Top, or
Bottom. Then select the type of border you want from the styles on the right. You can
also select a color for the border using the drop-down Color field.
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Align Tab
This tab gives you horizontal and vertical alignment control for the text in the
selected cell.

The following table describes the fields on this tab:

Field Description

Horizontal Select a horizontal alignment

Vertical Select a vertical alignment.

Wrap Text If you want the text to wrap inside the cell, forming
more than one line of text in the cell, turn this option
on.

Allow Enter If you want to allow use of the Enter key within the
cell, turn this option on. Otherwise, pressing the
Enter key will simply select the next cell below.

Auto Size If you want the cell dimensions to adjust
automatically to fit whatever is entered, turn this
option on.
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Format Tab
The format tab allows you to select text formats for the cell. For example, if the
contents of the cell are currency values, you might select Dollars. This will
automatically insert the dollar sign before the number and round the number to the
nearest two decimal places.

Other useful text formats include the Comma format, which uses the comma as the
thousands separator; the Date formats which indicate the number of places to use for
month, day and year formats; and the Percent format, which automatically inserts
the percent sign at the end of the number.

For cells that are formatted as a Date, setting the Precision to '0' trims leading zeroes
from the date, month and year (depending on the Date format selected).
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Based On Tab
If you want to use predefined styles, you can select a style such as Heading 1 or
Heading 2 for the text in the cell. For more information on Styles, refer to page 3-99.

If you want to view the current format settings for a cell, select the
cell in the spreadsheet and select Format | Lookup. This will open
the Lookup dialog, which displays all the formatting selections for
the cell.

Formatting Reports

Page 3-92 Adagio Financial Reporter

Note



Cell Conditional Styles
Conditional Styles are used to apply a particular style (refer to page 3-99) to a cell(s).
This is done by selecting the cell(s) that will be evaluated and entering an IF
statement formula in the box for the Conditional Style. Statements may be nested
and more than one Style may be used in a sheet. The # symbol in the formula
represents the value in the cell being evaluated by the formula.

Begin by selecting the cell(s) to apply the conditional style(s) to if the condition(s) is
met.

From the Format menu, select Conditional Styles ... The Conditional Styles window
will appear.

The following table details the fields and buttons in the Conditional Styles window:

Field Description

Styles (list) Displays the list of styles already created. Double
click on a style to select it and to have its text string
added to the Formula box.

Styles (button) If necessary, use this button to be taken to the Styles
window where you may Add, Edit, Delete and Make
Default a style.

Enable Conditional
Styles

May be used to toggle the conditional style on or off
(remove the style from the cell).
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Field Description

Formula to evaluate Enter the IF statement to be used to evalute the cell(s)
and apply the Conditional Style to selected cells that
meet the condition expressed. Statements may be
nested and more than one style may be used. For
example:

IF(#>5000,"AP Bal Outstanding",IF(#>1000,"AJ
Materials",""))

The name of an existing style is specified within the
quotation marks.

The # symbol forms a part of the formula and
indicates the value of the cell being evaluated by the
formula. This formula will be appended to the
original formula for the cell(s) and be separated by the
original formula with a semi-colon. For example:

=-GLAMT(D$8,$B11);IF(#>5000,"AP Bal
Outstanding",IF(#>1000,"AJ Materials",""))

Preview Displays the selected Conditional Style when a valid
formula has been entered. If multiple styles have
been used, only one of the styles is shown.

The OK button is not active if an incomplete or incorrect formula has been entered.
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Those cells that have been selected to use the conditional Style will be evaluated and
the style will be applied to those cells that satisfy the formula when the sheet is
Recalculated (F9).

Use Recalculate (F9) to refresh a single sheet or Recalculate All
(Ctrl/F9) to refresh all sheets in the workbook.
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Headers and Footers
If you select the Header and Footer option from the File menu, you can enter
hard-coded information to appear on the header or footer of your report, just like in a
spreadsheet.

You can also use some special codes to include other information. Wherever you
want this information to appear in your header/footer, enter the code(s) of interest in
the Header / Footer tab. They are:

Code Prints

$A Application name
$C Company name from the company profile
$D Date the report is printed

(use the same formatting codes as with DATESTRING
formulas (eg. $D{%B %d %Y}

%H Hour the report is printed
%M Minute the report is printed
$F File name
$R Sheet tab name
$N Total number of pages in the report
$P Number of the individual page on the report
$X File path of the statement specification
$U User initials
$L User name (long)
$Y As of Month dd, yyyy

Adding Logos to Reports and Statements
If you wish to include your company’s logo on financial statements, you can easily
do so by following the steps below. Your graphic format options are .DIB, .PCX, .TIF,
.TGA, .BMP, and .JPG.

1) Click on the cell where you want the logo to appear.

2) From the Edit menu, select Insert Graphic. A graphics selection window
appears.

3) Select a graphic to add to the report or statement. A Preview window on the
right will display the graphic you’ve selected, allowing you to confirm that
you’ve selected the right file.

4) When you’re ready to insert the graphic, click Open. The graphic is added in the
cell you selected in step 1, and the column and row height/width are
automatically adjusted to the size of the graphic.
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Using Auto Fit
Auto Fit is a feature that can make formatting your spreadsheets quick and easy.
Sometimes, when you have information in a cell that is too long or tall to fit in the
cell, you have to make the cell bigger. Using the Auto Fit feature will automatically
size rows and columns to fit whatever is inserted in a cell.

To use this feature, select a cell, row(s), column(s) or the entire spreadsheet that has
data in it. Then, from the Format menu, select either Rows | Auto Fit or Columns |
Auto Fit. The row or column will automatically adjust to fit the data. You can also
use the two Auto Fit buttons in the Format toolbar.

Freezing and Hiding
Financial Reporter lets you freeze and hide columns or rows. Freezing is often used
when working with a large spreadsheet. If you want to be able to see the header row
no matter how far down you have scrolled in the spreadsheet, you can freeze the
header row, which means that only the rows below it will scroll.

Freezing
With the statement in Collapsed view, to freeze a row, select the row(s) by clicking
on its label. (For example, to select the first row, click the grey edge labeled “1”.)

Once you have selected the row(s) you want to freeze, go to the Format menu and
select Rows | Freeze.

Now you can use the scroll bar on the spreadsheet and row 1 will always be visible.

You can also freeze columns in the same way. Just select a column, then select
Columns | Freeze from the Format menu.

If you select a row(s) or column(s) the do not contain .SmartSheet
in cell A1 to freeze, the Collapse and Expand buttons will be come
inactive until such time as you Unfreeze the row(s) or column(s).
Frozen rows always appear at the top of the sheet. Similarly,
frozen columns always appear as the leftmost columns.

When a statement is created using the 'drag and drop' method from
Account Groups, title and column heading rows are automatically
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frozen. This way, if a Row Page Break is used, those rows will be
repeated at the top of each printed page.

Hiding
If you want to hide a row the process is very similar. Select the row by clicking on its
grey label. Then, from the Format menu, select Rows | Hide or use the right-click
context menu.

You can also select columns in the same way. Just select the column, then select
Columns | Hide from the Format menu or use the right-click context menu.

When using the right-click context on a selected column(s), you can also select to
Auto Hide the column(s). The Auto Hide occurs when the statement is recalculated.
When Auto Hide is enabled, it will hide columns that have all 'blanks' or zeroes in
them. It will also hide columns that are all text. Text columns would not normally
be selected to Auto Hide.

Use Recalculate (F9) to refresh the active sheet or Recalculate All
(Ctrl/F9) to refresh all sheets in the workbook.

To unhide the columns or rows again, select the columns that should appear on the
immediate left and right of the hidden column(s) or the rows that should appear
immediately above and below the hidden row(s) and select Unhide from the
right-click context menu.

For columns that have had Auto Hide enabled, if you wish to permanently unhide
them, you must first select to Unhide them, then right-click again and disable Auto
Hide.
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Using Styles
If you have certain heading styles that you frequently use, you can create a Style,
which is like a template for the header. For example, a style called Heading 1 might
have a text size of 18 points, in bold and centered.

Financial Reporter comes with pre-defined styles that you can use. You can create
your own, or edit the styles that come with Financial Reporter.

To Edit Styles
To view a list of styles, select Format | Styles . . . . This will open the Styles dialog.

Select the style you want to edit and click the Change button. The Detail Text dialog
will open. This dialog is identical to the Cell Properties dialog, which is explained in
detail in the Cell Properties Window section earlier in this chapter. Make any
changes you want. When finished, click OK.

• Dates refers to date formats (except for ColSpec date formats set in View
Customize).

• Headings refers to the font type and size of headings created using Account
Group Properties.

• Numeric is for number formatting.
• Standard is for font type and size of basic text and values.
• Totals is used for font type and size and borders of totals.
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For example, if you select to Change the Dates style, on the Format tab that displays
next you can specify the default date format that is applied when dates are inserted

into the spreadsheet using the right-click menu.

The style will now reflect these changes, and any cells in the spreadsheet that already
use this style will be updated.

If you have edited the default styles that were predefined in
Financial Reporter and you want to reset all the styles to this
default, you can use the Load Default button on the Styles dialog.
This will reset all changes made to the default styles.

To Apply a Style
To apply a style to a cell in your spreadsheet, highlight the cell, then select Format |
Cells from the menu or click the Format Cells button in the Format toolbar. In the
Cell Properties dialog, select the Based On tab and the style you want to use, then
click OK. The cell will then be formatted according to the style you selected.
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Drill-down
While you're viewing a report in the Financial Reporter, you can drill down to the
General Ledger Posted Details while in cells that contain any of the following
functions:

• ADGET
• ADDEBIT
• ADCREDIT
• ADCRONLY
• ADDRONLY
• GLAMT
• GLDEBIT
• GLDRONLT
• GLCREDIT
• GLCRONLY

Drill down to the posted details from any cell containing one of the above-listed
functions simply by clicking the right mouse button on that cell. A pop-up menu will
appear:

Drill-down
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In this example, the right mouse button was clicked in cell F11, and the pop-up menu
appeared.

There are two ways to drill down to G/L Details: either with the Details... option on
the pop-up menu, or the Tx Details... option. The following sections will describe
each one.

Drill-down
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Details
To drill down to the details, click the Details option on the pop-up menu. When you
do so, a screen showing the details will appear (as long as you have selected a
consolidated acocunt; otherwise, this screen will be skipped):

While in this window, you can modify the period field to view the details of other
periods. This will not change anything in the underlying Financial Report.

Double clicking on the particular account-department pair produces the amounts for
each period window and you can export the contents of this grid also using the Excel
Direct button:

Double click on a row (period) to display the posted details below for that period.

Drill-down

Creating a Report Page 3-103



You can modify the period field using the Dropdown arrow to view the details of
other periods. This will not change anything in the underlying Financial Report.

In addition to this basic drill-down, you can drill down to the batch details for a
particular entry by double-clicking on that row. Specifically, double clicking on row
2 above produces the following:

Clicking the Close button at any time will take you back to the Financial Reporter;
clicking Back will return you to the previous drill-down grid.
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Transaction Details
Choosing the Tx Details... option from the right-mouse button pop-up menu is
similar to the Details option described above; however, instead of displaying
consolidated totals for each account/department, it immediately displays the actual
transactions that make up the amount displayed on the report.

Clicking the Close button at any time will take you back to the Financial Reporter.

Drill-down and Departments
The drill-down functionality respects the department ranges and masks chosen from
the departmental drop-down box on the toolbar. See the example given in the
information on the .RangeDept feature, beginning on page 3-54, for more on how the
departmental selection affects the displayed information.
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Using Departments

Departmental Comparative Statements
When you’re using the drag and drop method to create a report/statement, the
Layout window in the drag and drop process includes a checkbox which allows you
to create financial statements that compare departmental data side by side.

If you turn the Departmental Comparative checkbox on in the Layout window, you
will see a Department window, prompting you to select the departments you wish to
compare on the financial statement.

Select the departments of interest in the same manner used to select the fields. You
can also turn on the following options, if desired:

• Add Consolidated Departments. Turn this option on if you want to include a
column that totals all departments.

• Sum Selected Departments. This option creates a column that sums just the
departments you have selected to report on. This column can have its own title,
which you specify in the field below this checkbox. This feature allows you to
create combined financial statements for any arbitrarily complex set of
departments in your chart with only a few mouse clicks.

When you’ve set your department options and click OK, you will be given an
opportunity to arrange the order of the departments on the comparative statement.
The order you select here will be repeated for each department included on the
statement.

Click OK to continue, and your spreadsheet will be created.
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Departmental Comparative Notes
• You can change the order of the columns on a statement while still on the

Layout screen by clicking on the column to select it, then clicking again and
dragging it to the desired position.

• In the statement, you can change the department number at the top of the
column, and the new department’s figures will be displayed.

• The department list at the top of the column that was created by the Sum
Selected Departments option is built by concatenating the department
numbers from the other columns. If you insert a new column to add
another department, the formula for the departmental sum will have to be
updated.

Departmental Print Function
A new departmental print function has been added to the File menu in the
Financial Reporter. To print departmental financial statements, select File |
Departmental Print.

Select the Fiscal Period for the statement, and then select the departments you
wish to include on the report. The departments that will be included on the
statement will appear in the large box on the right side of the window.

• To include all departments, use the double-headed right arrow.
• To select one department at a time for inclusion, click the department and

then click the single right arrow button. Repeat this process until all
departments you wish to include have been added to the right box.

• To select multiple contiguous departments for inclusion, hold down the
Shift key and click the first and then the last department you want to
include on the statement. Click the single right arrow button when you’re
finished.

• To select multiple non-contiguous departments, hold down the Ctrl key
and then click all of the departments of interest, and then click the single
right arrow button.
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Departments can be removed from the right-hand side print list in the same manner
as above, except using the left arrows.

Click the Print button when you’re ready.

Departmental Masks
When you are printing your financial statements using the Departmental Print
feature just described, you can also use Departmental masks. This may be useful if,
for example, if you wish to create consolidated financial reports for departments that
match a wildcard. For example, using the “?” wildcard, you could enter a
departmental mask such as 2??, which would include all department codes that are
three-characters in length and begin with the number 2; therefore the result would be
a departmental financial report for the departments in the range 200-299.

To create a departmental mask, select Departments from the View menu.

Restricted users cannot create departmental ranges, masks or lists.
Refer to the online Help for more information about User and
Group security.

With the main level or a single department highlighted, right-click on a department
code.

Using Departments
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From the pop-up menu, select Create Departmental Mask, and the following
window appears:

Enter a mask in the Mask field. As mentioned earlier, question marks can be used as
wildcards for the mask, such as 2??, which would include all departments beginning
with the number two, regardless of what the final two characters in the department
code might be.

Your mask would be added to the department list, as in this example:

You can then use the mask when using the Departmental Print feature described
earlier, as well as when printing individual financial statements.

Departmental Lists
Departmental Lists can also be used when you are printing your financial statements
using the Departmental Print feature. This can be useful as sometimes a chart of
accounts has been set up such that neither Department Ranges nor Departmental
Masks may be used effectively to group departments for purposes of reporting.
Departments in a Departmental List are summed on a statement.

Departmental Lists allow you to group contiguous and non-contiguousdepartments
that don't match a wildcard.

To create a Departmental List, select Departments from the View menu and then
right-click on a department code within the view.

Using Departments
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Restricted users cannot create departmental ranges, masks or lists.
Refer to the online Help for more information about User and
Group security.

From the pop-up menu, select Create Departmental List. The following window
appears:

Enter a description of the list of up to 80 characters.

The departments selected for use in the list become the department code that will be
seen in the Departments dropdown button in the toolbar.

Initially, the department that was pointed at is enabled for inclusion in the list. You
may disable this department if wanted. The OK button does not become active until
at least two department codes are enabled.

Using Departments
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The Departmental List displays in the Department View along with other
departments, departmental ranges and department masks.

Inserting and Deleting Sheets
You can add sheets to a workbook at any time, or delete or move sheets within the
workbook. Use the tabs at the bottom of the worksheet window to work with the
sheets.

If you right-click on the tabs at the bottom of any worksheet window, the following
menu appears:

Menu Item Function

Move to first Moves the sheet you right-clicked on to the beginning
of the tab list, to be the first sheet in the workbook.

Move left Moves the sheet you right-clicked on to the left of its
current position in the workbook.

Move right Moves the sheet you right-clicked on to the right of its
current position in the workbook.

Move to last Moves the sheet you right-clicked on to the end of the
tab list, to be the last sheet in the workbook.

Insert worksheet Inserts a sheet before the sheet you right-clicked on.
(This option is only available in Adagio Ledger and Adagio
FX Pro.)

Delete worksheet Deletes the sheet you right-clicked on. (This option is
only available in Adagio Ledger and Adagio FX Pro.)
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Menu Item Function

Rename Renames the sheet you right-clicked on.

Sheets can also be added or deleted from the View menu. To add a sheet before the
currently-selected sheet, select Insert Worksheet from the View menu. To delete the
currently-selected sheet, select Delete Worksheet from the View menu.
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Importing

Importing a Specification
Adagio Financial Reporter will import Adagio Ledger, Adagio FX and ACCPAC®
Plus™ financial statement specifications. You can specifically import a specification
by selecting Import Spec from the File menu.

To import a specification into Adagio Financial Reporter:

1) Select Import Spec from the File menu. The Open dialog box appears. Available
specifications are listed.

2) Select the type of files to include in the available list by making a selection in the
Files of type field.

3) Select a file from the list by clicking on it. You can also enter the name of a file in
the File name field.

4) Click OK.

Importing a Workbook
Adagio Financial Reporter will import Adagio financial statement specifications, and
where they contain multiple sheets (a workbook), you can specify only those sheets
you wish to include on the import.

To import a workbook into Adagio Financial Reporter:

1) Select Import Workbook from the File menu. The Open dialog box appears.
Available specifications are listed.

2) Select the type of files to include in the available list by making a selection in the
Files of type field.

3) Select a file from the list by clicking on it. You can also enter the name of a file in
the File name field.

4) Click OK. If the specification includes multiple sheets, you will be prompted to
select the sheets you wish to import. When you have put a check beside all
sheets of interest, click OK.

5) The selected sheet(s) will be appended to the worksheet currently opened

Importing

Creating a Report Page 3-113



Importing from xDirect
If you have a financial statement open in Excel, you can use the Import from xDirect
command on the File menu to import that statement right into your Adagio Financial
Reporter.

These imported statements will not be entirely set up according to usual Financial
Reporter methods. They will use .SmartSheet though and you can then add a
ColSpec format to make it easier to modify the statement as you would normally in
the Financial Reporter.

See the section on ColSpec Reports beginning on page 3-66 for more information.

Importing
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Setting Up a Page
There are a number of page setup options that you can set that affect the way a page
prints. These options can be set for an individual work sheet or you can save the
settings so that all work sheets will be printed using the same options.

ExcelDirect supporst the Page Scaling set in Adagio's Financial Reporter.

To set up a page:

1) Select Page Setup from the File menu. The Page Setup window appears.

2) Complete the fields in the window according to the following table:

Field Entry

Margins Set the top, bottom, left and right margins for the
page.

Row Headers Include row numbers on printed worksheets.

Column Headers Include column letters on printed worksheets.

Setting Up a Page
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Field Entry

Print Frame Include a frame around the content of a printed
worksheet.

Vertical Lines Include vertical grid lines on printed worksheets.

Horizontal Lines Include horizontal grid lines on printed worksheets.

Only Black and White Exclude any gray shading on printed worksheets.

Page Order Select whether first rows, then columns or first
columns then rows will be printed on worksheets.

Center on Page Select whether to center the content of a work sheet
horizontally on the page, vertically on the page, or
both.

Scaling Use these options to scale a statement that is normally
too wide or too long to fit onto one or more pages.
The font size may change as a result of your settings.

ExcelDirect supports Page Scaling set in Adagio's
Financial Reporter.

Save settings to profile Check this box to save your settings and apply them
to this and all future printed worksheets.

3) Click OK to apply the settings. You can click Cancel at any time to exit the Page
Setup window without saving any of the new settings.

Setting Up a Page
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Printing the Report
The last step in creating a financial report is printing the report. Before you can
print a financial report, a printer must be properly installed on your system. Refer
to your Windows documentation for more information.

You might also consider running a Print Preview before printing, to make sure
that the report will print as you expect it to. To run a Print Preview, select File |
Print Preview.

To print a financial report:

1) Select Print from the File menu. A standard Windows print dialog box
appears.

2) Select the desired printer from the list of available printers.

3) Set any other desired options.

4) Click Print to print the report.

Using File | Page Setup, you may set the scaling options to force
printing to fit all columns to a single page wide or to fit rows to
one or more pages tall.

Printing the Report
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Printing to the AdagioPDF Printer
At any time, you may choose to print to the AdagioPDF printer. When you do, the
following window will display:

Complete the fields in the window according to the following table:

Field Description

File name:

Append to existing PDF file

PDF Password This field is only active if Append to
existing PDF file is turned on.
Passwords may be alphanumeric and
up to ?? characters long. If desired,
carefully enter a password

Open PDF with default viewer

Printing the Report
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Exporting a Specification
The Financial Reporter allows you to export specifications to either Excel or to
HTML.

Exporting to Excel
You can export a spreadsheet's data to Excel for further use. You can do this via
the Export to Excel or Export to Excel Direct options on the File menu, or by an
Excel Direct button on the toolbar.

Export to Excel
Select Export to Excel from the File menu. You'll be prompted for the location and
file name for the Excel (.xls) file. Select the appropriate drive, directory, and file
name and click Save. Your exported data is now ready to be opened in Excel,
using the file name you specified.

Export to xDirect
If you don't see the Excel Direct button, you will need to reset
your toolbars to display the latest toolbar buttons.

When you export to a spreadsheet via the Excel Direct button or the Export to
Excel Direct option on the File menu, instead of just having the data saved to a
spreadsheet file, the Financial Reporter will immediately launch the spreadsheet
program and the data will be written to the spreadsheet with the default file name
book1.xxx (where 'xxx' represents the extension used by the spreadsheet
program). You can then save the spreadsheet under the name you wish and then
manipulate this data as you would in any spreadsheet.

Statements using a non-period decimal character do not export their formulas to
Excel.

Refer to the Readme help file located within the Help menu of Adagio Ledger and
FX for information on Configuring Excel Direct for CSV (or a different
spreadsheet program).

Export Protection (see page 3-121) may be applied to statements and statement
groups.

Exporting a Specification
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Exporting to HTML
You can export your spreadsheet's data to HTML format very easily. To do so, select
Export to HTML from the File menu. The following window appears.

With no options selected, the formatted text and values of the sheet are exported
only. However:

• When the Display cell borders option is turned 'on', any cell borders that
display within the Financial Reporter are exported to the HTML file as well.

• When the Display row and column numbers option is turned on, the letters at
the top of each column and numbers to the left of each row in the Financial
Reports are exported to the HTML file also.

• When the Display hidden cells option is turned on, rows and columns within
the sheet that normally do not print (eg. those that have Hide when printed
turned on and columns A and B, etc.) are exported to the HTML file.

Click OK when you've set your export preferences. You'll be prompted for the
location and file name for the HTML (.htm or .html) file. Select the appropriate drive,
directory, and file name and click Save. The data will be exported to an HTML file

Your exported data is now ready to be uploaded to a web site or opened in any web
browser or HTML editor.

Exporting a Specification
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Export Protection
Applying Export Protection to a sheet means that when the sheet is exported to
Excel using Excel Direct, it is protected and, therefore, uneditable in Excel.
Additionally, you may assign a password to the sheet that must be used within
Excel in order to Unprotect the sheet within Excel.

Neither of the Export to Excel nor Export to HTML functions are
active within the File menu when a sheet that has Export
Protection in effect is open.

While the sheet you want to apply the protection to is open and visible, select File
| Export Protect... from the menu. Enable the Enable protection option by
clicking the checkbox to place a checkmark in it. Optionally, you may enter an up
to 10-character alphanumeric Password.

When the sheet is exported to Excel using the Excel Direct button (or File |
Export to Excel direct), if the user tries to edit the sheet, they will receive the
following message:

The location of the Unprotect Sheet command in Excel might
vary depending on the version of the product you are using.

Export Protection
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Chapter 4
Formulas & Functions

The best feature of Adagio Financial Reporter is that you do not need to learn any
formulas to create detailed and great-looking reports. But, if you have a special
reason that requires formulas, this chapter and the next explain the available
formulas in detail. These formulas are applied in the same manner as other
spreadsheet applications. For more information on using spreadsheet formulas, refer
to your spreadsheet application documentation.

In this chapter, we will explain how to use some of the formulas including the rules
of usage that apply. Then we will list the formulas that are available to you in Adagio
Financial Reporter.

If you want to view your spreadsheet content as formulas rather
than values, select Formula | Expression from the menu. This will
show you the formula used in each cell.
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Special Considerations
Some Financial Reporter =functions read current information from an Adagio
database each time a workbook is recalculated.

Use Recalculate (F9) to refresh the active sheet or Recalculate All
(Ctrl/F9) to refresh all sheets in the workbook.

For each of these =functions, Financial Reporter updates the workbook cells
containing these =functions with the current data from your Adagio database, every
time you load or recalculate your workbook. The =functions that do this are:

=ACCOUNTGROUP

=ACCOUNTGROUPDEPT

=ADAVERAGE

=ADCREDIT

=ADCRONLY

=ADDEBIT

=ADDRONLY

=ADGET

=ADGETF

=ADMAX

=ADMIN

=ADSELECT

=ADDRESS1 through ADDRESS4

=CONAME

=CURRENTFISCALYEAR()

=DEBIT

=DORANGE

=FAX

Special Considerations
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=FPERIOD

=FYEAR

=NEXTCREATED()

=NEXTFISCALYEAR()

=PHONE

=POSTCODE

=PRIORFISCALYEAR()

=QLFUNC

=RERR

=RNGMERGE

=ZIP

=GLAMT

=GLCREDIT

=GLCRONLY

=GLDEBIT

=GLDESC

=GLDESC2

=GLDESC3

=GLDRONLY

=GLFPE

=GLFPS

=GLSTR

=GLTITLE

= GLUPDATE

=ADCOMMENT

=ADNOTE

Special Considerations
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These Financial Reporter =functions give you up-to-the-minute information from
your Adagio system each time you recalculate the workbook. However, each
=function must open and read an Adagio data file each time the workbook is
recalculated.

Multiple Years
Adagio's Financial Reporter enables you to report on up to 10 years of stored ledger
data using both .ColSpec reports and Adagio Database functions.

To do so using ColSpec reports, simply edit the appropriate .ColSpec cell and prefix
the code with {n}. {n} can be an integer from -9 to 9.

For example, if the .ColSpec account data token is Y:

• editing the cell to read {1}Y will return the information for one year before the
year displayed in the Year dropdown on the toolbar,

• editing the cell to read {2}Y will return the information for two years before
the year displayed in the Year dropdown on the toolbar,

• editing the cell to read {-1}Y will return the information for one year in the
future, after the year displayed in the Year dropdown on the toolbar.

To do so using Adagio Database formulas (eg. ADGET), again assume the account
data token is Y, simply edit the formula as follows:

• to read {1}Y (eg. =ADGET("gldata.{1}Y","$B11") will return the information for
one year before the year displayed in the Year dropdown on the toolbar,

• to read {2}Y (eg. =ADGET("gldata.{2}Y","$B11") will return the information for
two years before the year displayed in the Year dropdown on the toolbar,

• to read {-1}Y (eg. =ADGET("gldata.{-1}Y","$B11") will return the information
for one year in the future, after the year displayed in the Year dropdown on
the toolbar.

Again, {n} can be an integer from -9 to 9.

Special Considerations
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=Function Summary
If you were manually entering a range of accounts (or record range), you would enter
the starting account, type a colon (:) and enter the ending account. To separate one
range from another or from another individual account, type a comma (,). You could
also use a Named Range (see page 6-175).

There are two categories of Financial Reporter =functions. The following list
summarizes the =functions in each category. Each =function is described in detail
later in this chapter.

Adagio Database =Functions

This function . . . . . . returns:

=ACCOUNTGROUP(string1[,string2
[,...string]])

The range of accounts with the
departmental place holder (`).

=ACCOUNTGROUPDEPT(string1
[,string2[,...string]])

The range of accounts.

=ADAVERAGE(link.field,record
range[,multiplier])

The total of the field values in record range
divided by the number of records in
record range.

=ADCREDIT(link.field, record
range[,multiplier])

The absolute value of the total of field in
record range, in the database indicated by
link, if total is a credit; otherwise returns
a zero amount.

=ADCRONLY(link.field, record
range[,multiplier])

The absolute value of the total of all
credit amounts in field in record range, in
the database indicated by link.

Similar to =ADCREDIT, but only sums
the credit amounts, while =ADCREDIT
calculates for all amounts in the range
specified.

=Function Summary
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This function . . . . . . returns:

=ADDEBIT(link.field, record
range[,multiplier])

The total of field in record range, in the
database indicated by link, if total is
debit; otherwise returns a zero amount.

=ADDRONLY(link.field, record
range[,multiplier])

Similar to the =ADDEBIT function, but
returns only the sum of the debit
amounts in the range.

=ADGET(link.field,record
range[,multiplier])

The total of field in record range, in the
database indicated by link.

=ADGETF(link.field,record range) Returns the first value located in a range
of accounts.

=ADMAX(link.field,record
range[,multiplier])

Returns the largest value of field in record
range.

=ADMIN(link.field,record
range[,multiplier])

Returns the smallest value of field in
record range.

=ADSELECT(record range, criteria) Where record range conforms to the
format described in Adagio Database
=functions for ranges and the criteria is
valid formula using the embedded
functions in conjunction with the fields
from the Account Data tree.

This function can only be used in a
.Range row and builds a record range that
can be referenced from other cells.

=GLAMT({Acct Data Token},
{Account Range})

Use this function to retrieve GL amounts
for the data field and account range you
choose.

=Function Summary
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This function . . . . . . returns:

=GLCREDIT({Acct Data Token},
{Account Range})

Use this function to retrieve GL amounts
for the data field and account range you
choose. If field contains numbers,
=GLCREDIT totals the values in field
within record range. If the total is a
credit (negative) value, =GLCREDIT
returns the absolute (that is, unsigned)
value of the total. If the total is a debit
(positive) value, including zero,
=GLCREDIT returns a zero amount in
the record cell.

=GLCRONLY({Acct Data Token},
{Account Range})

Use this function to retrieve GL credit
amounts for the data field and account
range you choose. Similar to the
=GLCREDIT function, but returns only
the sum of the credit amounts in the
range. If field contains numbers,
=GLCRONLY totals the credit values in
field within record range.

=GLDEBIT({Acct Data Token},
{Account Range})

Use this function to retrieve GL amounts
for the data field and account range you
choose. If field contains numbers,
=GLDEBIT totals the values in field
within record range. If the total is a
debit (positive) value, including zero,
=GLDEBIT returns the total. If the total
is a credit (negative) value, =GLDEBIT
sets the workbook cell to a zero amount.

=GLDESC (“Default Text”,
{Indent},{Account Range})

Use this function to insert a default
description line 1 of the account range
that appears in column B.

=GLDESC2 (“Default Text”,
{Indent},{Account Range}))

Use this function to insert a default
description line 2 (when used) of the
account range that appears in column B.

=Function Summary
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This function . . . . . . returns:

=GLDESC3 (“Default Text”,
{Indent},{Account Range}))

Use this function to insert the
concatenated of account description of
lines 1 and 2 of the account range that
appears in column B.

=GLDRONLY({Acct Data Token},
{Account Range})

Use this function to retrieve GL credit
amounts for the data field and account
range you choose. Similar to the
=GLDEBIT function, but returns only the
sum of the debit amounts in the range. If
field contains numbers, =GLDRONLY
totals the debit values in field within
record range.

=GLFPE ({Acct Data Token}[,
format])

Use this function to insert the fiscal
period ending date that corresponds to
the data field ususally specified in the
.ColSpec row above.

Adding the optional [, format] parameter
(eg. "dd mmm yyyy") returns the period
end date as 31 Jan 2012.

=GLFPED ({Acct Data Token}) Use this function to insert the fiscal
period ending date that corresponds to
the data field usually specified in the
.ColSpec row above. The date returned
is the Julian date which you may
subsequently format if you choose to.

=GLFPS ({Acct Data Token}[,
format])

Use this function to insert the fiscal
period starting date that corresponds to
the data field usually specified in the
.ColSpec row above.

Adding the optional [, format] parameter
(eg. "dd mmmm yyyy") returns the
period end date as 01 January 2012.

=Function Summary
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This function . . . . . . returns:

=GLFPSD ({Acct Data Token}) Use this function to insert the fiscal
period starting date that corresponds to
the data field usually specified in the
.ColSpec row above. The date returned
is the Julian date which you may
subsequently format if you choose to.

=GLSTR({Acct Data Token},
{Account Range})

Use this function to retrieve GL units and
optional fields for the data field and
account range you choose.

=GLTITLE() Use this function to retrieve Account
Data code titles as defined in the cell
referenced (eg. in ColSpec row).

=GLUPDATE({Acct Data Token},
{Account Range}, X,{N])

Use this function to write new budget
and/or forecast values in Adagio Ledger
for the 'current' fiscal year unless the
optional 'N' parameter is set to '1' (which
forces the update to be for the previous
year budgets/forecasts).

NOTE: If Next Year is open, the 'current'
fiscal year is the Next Year.

NOTE: GLUPDATE is always enabled and
for all years in FX9.0A.

=RNGMERGE() Creates a list of all possible combinations
of accounts and departments, where the
accounts and departments are stored in
separate cells. This function is most
commonly used to aid in calculating a
sum of non-consecutive accounts and/or
departments in a single cell.

=RERR(link.field, record range) The sum of the rounding errors of field
for all records in record range, in the
database indicated by link.

=Function Summary
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Link =Functions

This =function . . . . . . returns:

=ADDRESS1( ) The first line of the company address from the
company profile.

=ADDRESS2( ) The second line of the company address from the
company profile.

=ADDRESS3( ) The third line of the company address from the
company profile.

=ADDRESS4( ) The fourth line of the company address from the
company profile.

=CONAME( ) The company name from the company profile.

=FAX( ) The company fax number from the company profile.

=FPERIOD( ) The current fiscal period selected on the View
toolbar.

=PHONE( ) The company phone number from the company
profile.

=POSTCODE( ) The company postal code from the company profile.

=ZIP( ) The company zip code from the company profile.

=Function Summary
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Financial Reporter =Functions
This section explains the two categories of Financial Reporter =functions. Details on
the operation of each individual =function are given under =Function definitions, later
in this chapter.

Adagio Database =Functions
The Adagio database =functions retrieve current information from an Adagio
database. This information may be a number, a text string, or a date, depending on
the data type of the field referred to by the =function. The Adagio database
=functions all require two arguments: link.field and record range. These arguments
must be of the string data type, and must follow these rules:

• The arguments can be literals (e.g. typed into the =function), or other
=functions, or single workbook cells, but they cannot be cell ranges. If you use
literals, enclose them with quotation marks. For example:

=ADGET(“gldata.bal”,"1000:2000")

This =function returns the total of the values in the field “bal” in the database
indicated by the link “gldata” for all records in the account code range “1000:2000".

• In the argument link.field:

The link can only be one of the following: glglob, gldata, gldates, gldept.

The field must be a field in the database indicated by link’s data dictionary.

• The argument record range consists of the keys to one or more records. A key is
a character string that represents a range of values in the link’s index field.
The record range must be in one of the following forms:

The lowest and highest indices in the range, separated by a colon; for example:

“A100:Z999"

When entering a range of accounts with a single department, the department should
be specified as a range as well. For example, if you want to return the sum of all
accounts between 4000 and 5000, with department 1000, you would use the key
range:

“4000:5000-1000:1000”

As indicated in this example, you would use the same department number for the
start and end of the department number range.

Financial Reporter =Functions
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If you were using cell references instead of actual account and department numbers,
you would use the same cell number in the start and end positions of the department
number range, such as:

C16&”-”&E14&”:”&E14

where C16 is account range 2000:3000, and E14 is department 1000.

This function cannot be used in groups, only in formulas.

The codes used to designate a range do not have to exist within the database. All
existing records within the range are read.

A single index string, which may contain wild-card characters:

? A question mark in one or more character positions means “accept any
single character in this position”. A?00 matches AA00, AB00, A100, and so on.

* An asterisk anywhere in the index string means “accept any number of
characters that follow.” A* matches all index codes that begin with A. A*0 matches
all index codes that begin with A and end with 0, regardless of the length of the code.
* matches all index codes.

Two or more of the above forms, separated by commas:

“A*,B0??,X100:Z999"

This function cannot be used in groups, only in formulas.

If overlapping ranges occur, the record will be read in multiple
times.

• Cell references can be used as record ranges. For example, if you read a certain
account number into cell A7, you could use the formula
=Adagio(“link.field”,A7) to return a value which is dependent on the account
number it finds in cell A7.

Do not insert cell references as literal text; in other words, do not surround a cell
reference with quotation marks (“ ”).

• Two of the =Adagio functions require an additional argument: QL Function.
Both the =DORANGE and =QLFUNC =functions require this additional
argument in order to function correctly. As with the link.field and record range
arguments, the QL Function argument must be entered as a literal.

• If field contains numbers, the Adagio database =functions return a result based
on the total of field within record range. If field is a text string or date, the
Adagio database =functions return a result from the last field in record range,

Financial Reporter =Functions
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except for the function =ADGETF, which returns only the first record in the
specified record range.

• If you are using wildcards in conjunction with the =ADGET function, you will
need to be aware of the following.

If you are not using departments, wildcards will function normally.

If you are using departments, you can use the * wildcard as the department
(consolidated) without any problem.

However, if you are using any wildcard for a single department, you will need to
make sure that all characters of the department field are accounted for, even if your
department fields are less than the maximum character length. You must fill the
department number with leading question marks so the number equals the
maximum character length.

FX Users: The department field is 12 characters in length. So, for example, if the
range you wanted was 4???-1000, you would actually need to enter 4???-????????1000.

Ledger Users: The department field is 6 characters in length. So, for example, if the
range you wanted was 4???-1000, you would actually need to enter 4???-??1000.

Specifying Record Ranges for Compound Index Keys
The Adagio database files use indices made up of multiple parts. When you specify
record ranges for a link to these files, you can enter the range in one of the following
forms:

• Wildcard characters within any or all of the parts of the key. For example:
“1*0-??ST”

This code selects all accounts that start in 1 and end in 0 (10, 120, 19990, etc.) for all
four-character department codes ending in ST (EAST and WEST but not NORTH or
SOUTH).

• The lowest and highest codes in a range, separated by a colon, for the entire
index; for example:

“1000-B:3000-C”

For this example, assume that departments A, B, C and D all contain accounts 1000,
2000 and 3000. This range selects all accounts in the chart of accounts between
1000-B and 3000-C (e.g. 1000-B, 1000-C, 1000-D, 2000-A, 2000-B, 2000-C, 2000-D,
3000-A, 3000-B, and 3000-C). Compare this result with specifying a range for each
part of the index, in the following example.

• The lowest and highest codes in a range, separated by a colon, for each part of
the index. For example:

“1000:3000-B:C”
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This range selects accounts 1000-B, 1000-C, 2000-B, 2000-C, 3000-B, and 3000-C.

You cannot mix wildcard characters and colons within an index,
regardless of whether it contains single or compound keys. This is
because colons are used to specify a range of contiguous accounts,
while wildcards can be used to specify a range of non-contiguous
accounts; therefore, mixing colons and wildcards can result in
ambiguous key ranges. You can, however, specify two or more of the
above forms, separated by commas. The single exception to the
mixing of wildcards and colons is the use of a colon to specify an
account range, and the use of a wildcard to specify “all
departments” in that account range. For example, you can use the
range “1000:3000-*” to specify all departments within the range of
accounts from 1000 to 3000. This allows you to easily build
financial statements for one or all departments.

You can enter the =function =ADGET into cells or you can type it in as you would
any other =function.

Link =Functions
Like the Adagio database =functions, the link =functions retrieve information from
an Adagio database. The link =functions do not require a field and record range to
specify the data to retrieve.

The link =functions =ADDRESS, =CONAME, =FAX, =PHONE, =POSTCODE, and
=ZIP offer a convenient way to enter company profile information from an Adagio
database into workbook cells without having to define a link to the company profile
file (e.g. glglob). The link =function =FPERIOD lets you enter the fiscal period
considered current for a link into a workbook cell. =FYEAR lets you display the fiscal
year. Most of these are available from the insert formulas selection in the cell
formatting pop-up menu.
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=Function Definitions
This section lists the Financial Reporter =functions alphabetically.

=ACCOUNTGROUP(string1[,string2[,...string]])
=ACCOUNTGROUPDEPT(string1[,string2[,...string]])

These functions allow template financial statements to be created.

These functions return the range of accounts specified in the range located by
matching the heading entries. They take a sequence of text strings as arguments and
return the account range from the Account Group tree that matches the text
arguments.

ACCOUNTGROUPDEPT() returns the range of accounts with the departmental
place holder (`).

ACCOUNTGROUP() just returns the account range.

These functions can be automatically added to the financial statement you are
creating. Open the Account Group View and make a cell in column “B” of a
SmartSheet the active cell. Then drag the desired range into the formula box (not the
active cell). When a user edits the account group range, the changed accounts will
automatically be reflected in the financial statement.

Parameters

The argument strings refer to the group headings in the account group tree.
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Example:

Given the following Account Group tree:

=ACCOUNTGROUPDEPT(“Income Statement”,"Income","Revenue")
returns “4000:4999-`”

=ACCOUNTGROUP(“Income Statement”,"Income","Revenue")
returns “4000:4999”
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=ACCTDEPT("<account range> | <account list>",
"<department range> | <department list>")

This formula permits you to create a Departmental List (see page 3-109) of
non-contiguous departments using a formula in column B where the account ranges
are stored. The Departmental List function used within the Departments View has
obsoleted this formula.

Example:

=ACCTDEPT("4000:4500","100;125;150") produces
4000:4500-100:100,4000:4500-125:125,4000:4500-250:250

=ADAVERAGE(link.field,record range[,multiplier])
If field contains numbers, =ADAVERAGE returns the total of the field values in
record range divided by the number of records in record range.

Example:

If gldata is a link to a General Ledger database that contains accounts 1000, 1100,
1200, and 1300, with the following balances:

1000 123.00
1100 99.80
1200 -256.57
1300 419.37
for a total balance of 385.60

the following function:

=ADAVERAGE(“gldata.bal”,"1000:1300")

would result in a value of 96.40 (385.60 divided by 4).

If field is a text string or date, =ADAVERAGE returns the content of field from the
last record in record range.

If you include the optional [, multiplier] parameter then the result will be multiplied
by this value. This parameter is especially useful in representing source currencies in
a home equivalent value.

The [, multiplier] can be a value, a cell reference, or a function that returns a value.

Refer to the section on Adagio database =functions on page 4-133 for a description of the
arguments link, field, and record range.
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=ADCREDIT(link.field,record range[,multiplier])
If field contains numbers, =ADCREDIT totals the values in field within record range. If
the total is a credit (negative) value, =ADCREDIT returns the absolute (that is,
unsigned) value of the total. If the total is a debit (positive) value, including zero,
=ADCREDIT returns a zero amount in the record cell.

Example:

If gldata is a link to a database and the total balance of accounts 1000 through 1999
is -299.05, this function:

=ADCREDIT(“gldata.bal”,"1000:1999")

would return a value of 299.05.

If the total balance of accounts 1000 through 1999 is 299.05, the same function would
result in a zero amount.

If field is a text string or date, =ADCREDIT returns the following error:

#FieldTypeBad#

If you include the optional [, multiplier] parameter then the result will be multiplied
by this value. This parameter is especially useful in representing source currencies in
a home equivalent value.

The [, multiplier] can be a value, a cell reference, or a function that returns a value.

Refer to the section Adagio database =functions on page 4-133 for a description of the
arguments link, field, and record range.

=ADCRONLY(link.field,record range[,multiplier])
Similar to the =ADCREDIT function, but returns only the sum of the credit amounts
in the range.

If field contains numbers, =ADCRONLY totals only the credit values in field within
record range.

Example:

If the Adagio database contained three accounts with debit amounts of 145.55, 273.96,
and 14.85, as well as three accounts with credit amounts of 78.93, 221.89, and 194.45
in record range, this function:

=ADCRONLY(“gldata.bal”,"1000:1999")
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would return a value of 495.27, the sum of the three credit records.

If field is a text string or date, =ADCRONLY returns the following error:

#FieldTypeBad#

If you include the optional [, multiplier] parameter then the result will be multiplied
by this value. This parameter is especially useful in representing source currencies in
a home equivalent value.

The [, multiplier] can be a value, a cell reference, or a function that returns a value.

Refer to the section on Adagio database =functions on page 4-133 for a description of
the arguments link, field, and record range .

=ADDRESS1 through =ADDRESS4
Returns the first, second, third, or fourth address line from the company address in
the company profile database.

Example:

=ADDRESS1( )

would return the first address line from the company profile.

=ADDEBIT(link.field,record range[,multiplier])
If field contains numbers, =ADDEBIT totals the values in field within record range. If
the total is a debit (positive) value, including zero, =ADDEBIT returns the total. If
the total is a credit (negative) value, =ADDEBIT sets the workbook cell to a zero
amount.

Example:

If gldata is a link to a database and the total balance of accounts 1000 through 1999 is
123.45, this function:

=ADDEBIT(“gldata.bal”,"1000:1999")

would return a value of 123.45. If the total balance of accounts 1000 through 1999 is
-123.45, =ADDEBIT would result in a zero amount.

If field is a text string or date, =ADDEBIT returns the content of field from the last
record in record range.
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If you include the optional [, multiplier] parameter then the result will be multiplied
by this value. This parameter is especially useful in representing source currencies in
a home equivalent value.

The [, multiplier] can be a value, a cell reference, or a function that returns a value.

Refer to the section on Adagio database =functions on page 4-133 for a description of
the arguments link, field, and record range.

=ADDRONLY(link.field,record range[,multiplier])
Similar to the =ADDEBIT function, but returns only the sum of the debit amounts in
the range.

If field contains numbers, =ADDRONLY totals only the debit values in field within
record range.

Example:

If the database contained three accounts with debit amounts of 145.55, 273.96, and
14.85, as well as three accounts with credit amounts of 78.93, 221.89, and 194.45 in
record range, this function:

=ADDRONLY(“gldata.bal”,"1000:1999")

would return a value of 434.36, the sum of the three debit records.

If field is a text string or date, =ADDRONLY returns the following error:

#FieldTypeBad#

If you include the optional [, multiplier] parameter then the result will be multiplied
by this value. This parameter is especially useful in representing source currencies in
a home equivalent value.

The [, multiplier] can be a value, a cell reference, or a function that returns a value.

Refer to the section on Adagio database =functions on page 4-133 for a description of
the arguments link, field, and record range.

=ADGET(link.field,record range[,multiplier])
Returns the contents of field in the records in record range, in the database indicated by
link. If field contains numbers, =ADGET returns the total of all values in field within
record range. If field is a text string or date, =ADGET returns the content of the last
field in record range.
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Example:

If the database and the total balance of accounts 1000 through 1999 is 1453.99, this
function:

=ADGET(“gldata.bal”,"1000:1999")

would return a value of 1453.99.

If you include the optional [, multiplier] parameter then the result will be multiplied
by this value. This parameter is especially useful in representing source currencies in
a home equivalent value.

The [, multiplier] can be a value, a cell reference, or a function that returns a value.

Refer to the section on Adagio database =functions on page 4-133 for a description of
the arguments link field and record range.

=ADGETF(link.field,record range)
For dates and strings, returns the first value located in a range of accounts. If no
record exists in the selected range, returns a blank.

For numeric values, this function works like =ADGET without the drill down to
Details being available.

Example:

If the database contained accounts 1000, 1100, 1200, and 1300, with the following
account descriptions:

1000 Petty cash
1100 Accounts receivable, trade
1200 Investments, short term
1300 Inventory

the following function:

=ADGETF(“gldata.DESC”,"1000:1300")

would return a value of “Petty cash”.

=ADGET(“gldata.DESC”,"1000:1300")

would return a value of “INVENTORY”.

Refer to the section on Adagio database =functions on page 4-133 for a description of
the arguments link field and record range.
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=ADMAX(link.field,record range[,multiplier])
Returns the largest value of field in record range.

Example:

If the database contained accounts 1000, 1100, 1200, and 1300, with the following
balances:

1000 123.00
1100 99.80
1200 -256.57
1300 419.37

the following function:

=ADMAX(“gldata.bal”,"1000:1300")

would result in a value of 419.37.

If field contains a text string or date, =ADMAX sorts the fields in record range
alphabetically and returns the last value in the sorted range.

If you include the optional [, multiplier] parameter then the result will be multiplied
by this value. This parameter is especially useful in representing source currencies in
a home equivalent value.

The [, multiplier] can be a value, a cell reference, or a function that returns a value.

Refer to the section on Adagio database =functions, earlier in this chapter, for a
description of the arguments link, field, and record range.

=ADMIN(link.field,record range[,multiplier])
Returns the smallest value of field in record range.

Example:

If the database contained accounts 1000, 1100, 1200, and 1300, with the following
balances:

1000 123.00
1100 99.80
1200 -256.57
1300 419.37

the following function:
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=ADMIN(“gldata.bal”,"1000:1300")

would return a value of -256.57.

If field contains a text string or date, =ADMIN sorts the fields in record range
alphabetically and returns the last value in the sorted range.

If you include the optional [, multiplier] parameter then the result will be multiplied
by this value. This parameter is especially useful in representing source currencies in
a home equivalent value.

The [, multiplier] can be a value, a cell reference, or a function that returns a value.

Refer to the section on Adagio database =functions, earlier in this chapter, for a
description of the arguments link, field, and record range.

=ADSELECT(“record range”, “criteria”)
Where “record range” conforms to the format described in Adagio Database
=functions for ranges and the “criteria” is a valid formula using the embedded
functions in conjunction with the fields from the Account Data tree.

This function can only be used in a .Range row and builds a “record range” that can
be referenced from other cells.

Example #1:

Assuming A10 has .Range:

If cell B10 has

=ADSELECT(“4000:4999-*”,"LEFT({DESC}, 5) =

\"Sales\"")

then the result shown in B10 will be all accounts in the range 4000:4999 where the
first 5 characters of the Account description is Sales. The \"’s are required when
using text strings. Text Strings are all the fields in the General Information section of
the Chart of Accounts tree. That is, the double quotes (“) in all string literals must be
preceded by a backslash (\).

Example #2:

Assuming A10 has .Range:

If cell B10 has

=ADSELECT(“4000:4999-*”,"{BAL} <> 0")
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then the result shown in B10 will be all accounts in the range 4000:4999 where Bal.
End Selected Period {BAL} is not equal to zero.

Example #3:

Assuming A10 has .Range:

If cell B10 has your range of expense accounts

=ADSELECT(“5000:5999-*”,"{M} > {LYM}*1.1")

where “5000:5999" is your range of expense accounts then the result shown in B10
will be all accounts in the range 5000:5999 where the ”current period" {M} expenses
are more that 10% higher than the “same period last year” {LYM}.

Refer to the section on Adagio database =functions on page 4-133 for a description of
the arguments link, field, and record range.

=CONAME(link)
Returns the company name from the company profile.

Example:

=CONAME( )

would return the company name from the company profile.

=DORANGE(QLFunction, starting key, ending key)
This function is used to properly convert imported specifications.

=FAX( )
Returns the company fax number from the company profile.

Example:

=FAX( )

would return the fax number from the company profile.

=FPERIOD( )
Returns the current fiscal period.
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Example:

If fiscal period 9 is the current period, this function:

=FPERIOD( )

would return a value of “9".

=FYEAR()
Returns the fiscal year.

Example:

If fiscal year 2009- is displayed in the fiscal year dropdown in the toolbar, this

function:

=FYEAR( )

would return a value of “2009-".

=FYEAR(1)

would return the fiscal year prior to what is displayed in the fiscal year dropdown,

"2008-"

etc.

=GLAMT({Acct Data Token}, {Account Range})
In conjunction with ColSpec reports ONLY, use this function to retrieve GL amounts
for the data field and account range you choose. With the {Acct Data Token}, you will
specify the cell in the .ColSpec row that indicates the data you are retrieving. The
{Acct Data Token} will generally be in the same column as the current cell. Then, use
{Account Range} to determine the range of accounts to be used. This account range
must conform to the format described in Database =functions for ranges and the
“criteria” is a valid formula using the embedded functions in conjunction with the
fields from the Account Data tree.

Example:

If you have a .ColSpec row that retrieves “CURBAL” data in column D, row 8; and
you have an account range such as 5000:5999-` set up in column B, row 12, then your
function would be:

=GLAMT(D$8,$B12)
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=GLCREDIT({Acct Data Token}, {Account Range})
In conjunction with ColSpec reports ONLY, use this function to retrieve GL amounts for
the data field and account range you choose. If field contains numbers, =GLCREDIT
totals the values in field within record range. If the total is a credit (negative) value,
=GLCREDIT returns the absolute (that is, unsigned) value of the total. If the total is a
debit (positive) value, including zero, =GLCREDIT returns a zero amount in the
record cell.

With the {Acct Data Token} you will specify the data you are retrieving for this cell.
The {Acct Data Token} will generally be in the same column as the current cell and in
the .ColSpec row. Then, use {Account Range} to determine the range of accounts to
be used. This account range must conform to the format described in Database
=functions for ranges and the “criteria” is valid formula using the embedded
functions in conjunction with the fields from the Account Data tree.

Example:

If you have a .ColSpec row that retrieves “BAL” data in column D, row 8; and you
have an account range such as 1000:1999-` set up in column B, row 12; and

If gldata is a link to an Adagio database and the total balance of accounts 1000
through 1999 is -299.05, this function:

=GLCREDIT(D$8,$B12)

would return a value of 299.05.

If the total balance of accounts 1000 through 1999 is 299.05, the same function would
result in a zero amount.

=GLCRONLY({Acct Data Token}, {Account Range})
In conjunction with ColSpec reports ONLY, use this function to retrieve GL credit
amounts for the data field and account range you choose. Similar to the =GLCREDIT
function, but returns only the sum of the credit amounts in the range. If field contains
numbers, =GLCRONLY totals only the credit values in field within record range.

With the {Acct Data Token} you will specify the data you are retrieving for this cell.
The {Acct Data Token} will generally be in the same column as the current cell and in
the .ColSpec row. Then, use {Account Range} to determine the range of accounts to
be used. This account range must conform to the format described in Database
=functions for ranges and the “criteria” is valid formula using the embedded
functions in conjunction with the fields from the Account Data tree.
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Example:

If you have a .ColSpec row that retrieves "CURBAL" data in column D, row 8; and
you have an account range such as 5000:5999-` set up in column B, row 12; and

If the database contained three accounts with debit amounts of 145.55, 273.96, and
14.85, as well as three accounts with credit amounts of 78.93, 221.89, and 194.45 in
record range, this function:

=GLCRONLY(D$8,$B12)

would return a value of 495.27, the sum of the three credit records.

=GLDEBIT({Acct Data Token}, {Account Range})
In conjunction with ColSpec reports ONLY, use this function to retrieve GL amounts for
the data field and account range you choose. If field contains numbers, =GLDEBIT
totals the values in field within record range. If the total is a debit (positive) value,
including zero, =GLDEBIT returns the total. If the total is a credit (negative) value,
=GLDEBIT sets the workbook cell to a zero amount.

With the {Acct Data Token} you will specify the data you are retrieving for this cell.
The {Acct Data Token} will generally be in the same column as the current cell and in
the .ColSpec row. Then, use {Account Range} to determine the range of accounts to
be used. This account range must conform to the format described in Database
=functions for ranges and the “criteria” is valid formula using the embedded
functions in conjunction with the fields from the Account Data tree.

Example:

If you have a .ColSpec row that retrieves “BAL” data in column D, row 8; and you
have an account range such as 1000:1999-` set up in column B, row 12; and

If gldata is a link to a database and the total balance of accounts 1000 through 1999 is
123.45, this function:

=GLDEBIT(D$8,$B12)

would return a value of 123.45. If the total balance of accounts 1000 through 1999 is
-123.45, the same function would result in a zero amount.

If field is a text string or date, =DEBIT returns the content of field from the last record
in record range.
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=GLDESC (“Default Text”, {Indent} , {Account Range})
In conjunction with ColSpec reports ONLY, use this function to insert a default
description of the account range that appears in column B.

Note that the Default Text value is what will print when the SmartSheet is in
Collapsed mode; in Expanded mode, the =GLDESC function will return the account
description line 1 from the GL.

Example:

If you have an account range that covers your Revenue accounts, such as 4000:4999-`,
set up in column B, row 13, you may enter a function like this:

=GLDESC(“Revenue”,3,$B13)

This would add the descriptive text “Revenue” to the cell in which the function
appears, indented by three spaces when the statement is in Collapsed mode.

=GLDESC2 (“Default Text”, {Indent} , {Account Range})
In conjunction with ColSpec reports ONLY, use this function to insert a default
description line 2 (when used) of the account range that appears in column B.

Note that the Default Text value is what will print when the SmartSheet is in
Collapsed mode; in Expanded mode, the =GLDESC2 function will return the account
description line 2 (when used) from the GL.

Example:

If you have an account range that covers your Revenue accounts, such as 4000:4010-`,
set up in column B, row 14, you may enter a function like this:

=GLDESC2 (“Services”,5,$B14)

This would add the descriptive text “Services” to the cell in which the function
appears, indented by five spaces when the statement is in Collapsed mode.

=GLDESC3 (“Default Text”, {Indent} , {Account Range})
In conjunction with ColSpec reports ONLY, use this function to insert a default
description for description lines 1 and 2 of the account range that appear in column
B.

Note that the Default Text value is what will print when the SmartSheet is in
Collapsed mode; in Expanded mode, the =GLDESC3 function will return the
concatenation of account description lines 1 and 2 from the GL.
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Example:

If you have an account range that covers your Revenue accounts, such as 4000:4010-`,
set up in column B, row 13, you may enter a function like this:

=GLDESC(“Revenue Services”,3,$B13)

This would add the descriptive text “Revenue Services” to the cell in which the
function appears, indented by three spaces when the statement is in Collapsed mode.

=GLDRONLY({Acct Data Token}, {Account Range})
In conjunction with ColSpec reports ONLY, use this function to retrieve GL debit
amounts for the data field and account range you choose. Similar to the =GLDEBIT
function, but returns only the sum of the debit amounts in the range. If field contains
numbers, =GLDRONLY totals the debit values in field within record range.

With the {Acct Data Token} you will specify the data you are retrieving for this cell.
The {Acct Data Token} will generally be in the same column as the current cell, in the
.ColSpec row. Then, use {Account Range} to determine the range of accounts to be
used. This account range must conform to the format described in Database
=functions for ranges and the “criteria” is valid formula using the embedded
functions in conjunction with the fields from the Account Data tree.

Example:

If you have a .ColSpec row that retrieves "CURBAL" data in column D, row 8; and
you have an account range such as 5000:5999-` set up in column B, row 12; and,

If the database contained three accounts with debit amounts of 145.55, 273.96, and
14.85, as well as three accounts with credit amounts of 78.93, 221.89, and 194.45 in
record range, this function:

=GLDRONLY(D$8,$B12)

would return a value of 434.36, the sum of the three debit records.

=GLFPE ({Acct Data Token})
In conjunction with ColSpec reports ONLY, use this function to insert the fiscal period
ending date that corresponds to the data field specified in the .ColSpec row above.

Example:

If you have an “Account Balance As Of” field on your report, such as the “End Bal.
Prior Period” (BAL_[1]M), and you want to specify beneath the .ColSpec row the
relevant start period date for that period, so that as the specification is used from
month-to-month you will have an accurate date displayed on the report each time
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you use this function. Assuming that your .ColSpec row is row 8, and the
“BAL_[1]M” field appears in column E, you would use this function to display the
proper fiscal period start date.:

=GLFPE(E$8)

would return the period end date using the .ColSpec Date Format as specified in
your View | Customize | Settings.

=GLFPS ({Acct Data Token})
In conjunction with ColSpec reports ONLY, use this function to insert the fiscal period
starting date that corresponds to the data field specified in the .ColSpec row above.

Example:

If you have an “Account Balance As Of” field on your report, such as the “End Bal.
Prior Period” (BAL_[1]M), and you want to specify beneath the .ColSpec row the
relevant start period date for that period, so that as the specification is used from
month-to-month you will have an accurate date displayed on the report each time
you use this function. Assuming that your .ColSpec row is row 8, and the
“BAL_[1]M” field appears in column E, you would use this function to display the
proper fiscal period start date.:

=GLFPS(E$8)

would return the period start date using the .ColSpec Date Format as specified in
your View | Customize | Settings.

= GLSTR({Acct Data Token}, {Account Range})
In conjunction with ColSpec reports ONLY, use this function to retrieve GL optional
fields for the data field and account range you choose. With the {Acct Data Token},
you will specify the cell in the .ColSpec row that indicates the data you are retrieving.
The {Acct Data Token} will generally be in the same column as the current cell. Then,
use {Account Range} to determine the range of accounts to be used. This account
range must conform to the format described in Database =functions for ranges and
the “criteria” is a valid formula using the embedded functions in conjunction with
the fields from the Account Data tree.

Example:

If you have a .ColSpec row that retrieves “OPTXT1” data in column D, row 8; and
you have an account range such as 5000:5999-` set up in column B, row 12, then your
function would be:

=GLSTR(D$8,$B12)
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=GLTITLE()
Use this function to retrieve GL titles as defined in the cell referenced (eg. in .ColSpec
row). May also use extended custom period ranges for GL functions, eg.
NET/B/F/U/PRO/ENC[(P)Sp:Ep]M:

NET=Sum Net Changes (NOTE: NET is assumed)

B=Sum Budgets

F=Sum Forecast

U=Sum Units

PRO=Sum Provisional

ENC=Sum Encumbrance

(P)Sp=Starting Period - Must be in the range [1-(total periods)] - (P) means optional
'P' see example

Ep=Ending Period - Must be in the range [1-(total periods)]

M is required as indicated (NOTE: M is the only valid value)

Examples:

=GLTITLE(P8) would return 10th Period to 12th Period where cell P8 contains the
period range [10:12]M for actuals or B[10:12]M for budget.

=GLTITLE(P8) would returnYear to Date 2 Years Ago where cell P8 contains {2}M

=GLTITLE(P8) would return 10th Period Last Year to 5th Period This Year where
cell P8 contains the period range [P10:5]M
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=GLUPDATE({Acct Data Token}, {Account Range}, X)
Use this function to write new budget and/or forecast values in Adagio Ledger for
the 'current' fiscal year. Once new 'update' values are calculated in the sheet, use the
Update Budget/Forecast button in the Financial Reporter toolbar, to automatically
update accounts specified in the sheet. If departments are used, they must either be
hard-coded with the accounts in column B or indicated in the Department dropdown
on the toolbar.

If there is more than one sheet containing data, you will be prompted for whether
you want to run GLUPDATE on this sheet only or on all sheets.

If Next Year is open, the 'current' fiscal year is the Next Year.

If account ranges are not expanded, budget and forecast values from
.Range rows will not be updated in Adagio Ledger.

If the Consolidated button is turned on, #Range# replaces the
GLUPDATE value in any row that .Range does not exist unless the
department is hard-coded with the accounts.

If Zero Suppress is on, dependant on your sheet, budgets and/or
forecasts will be updated for account-department pairs hidden by
Zero Suppress.

If Ignore Inactive accounts is on, dependant on your sheet, budgets
and/or forecasts, will not be updated.

GLUPDATE is always enabled and for all years in FX9.0A.

Parameter

X A numeric value

Example #1

Writes to the budget first period for account 5000-200 the value of 14,175.

=GLUPDATE ("B[1]M","5000-200",14175)
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Revenue values would be entered as negative values. If you want to
reverse the sign of the associated amount, use -GLUPDATE instead.

Example #2

Let's assume that column D row 12 contains the GLAMT (or 13,500) of a ColSpec row
that retrieves "B[1]M" data in column D row 8; the account range of 5000-` is set up in
column B row 12, and the Department dropdown in the toolbar set to 200. If you
want to calculate the new budget value for D12 in column E row 12, your function
would be:

=GLUPDATE(D$8,$B12,$D12*1.05)

The new budget amount for period one of account code 5000-200 would be 14,175.

Example #3

All assumptions are the same as Example #2 'except' the account range of 5000:5999-`
is set up in column B row 12 and .Range exists in column A row 12.

= GLUPDATE(D$8,$B12,$D12*1.05)

In collapsed mode, the new budget amount for period one of the account range
5000:5999-200 in collapsed mode is 25,182.30.

In expanded mode, each account within the range for department 200 displays with
each individual budget amount, the values of which sum to 25,182.30.

=PHONE( )
Returns the company phone number from the company profile.

Example:

=PHONE()

would return the phone number from the company profile.

=POSTCODE( )
Returns the company postal code from the company profile.

Example:

=POSTCODE()

would return the postal code from the company profile.

=Function Definitions
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=QLFUNC(QLFunction)
This function is used to properly convert imported specifications.

=RERR(link.field,record range)
This function is only used by import. If field contains numbers, =RERR sums the
rounding errors in field within record range.

Example:

If gldata is a link to a database and the total balance of accounts 1000 through 1999
is 123.45 but you are rounding to the nearest dollar, this function:

=RERR(“gldata.bal”,"1000:1999")

would return a value of .45. If the sum of the rounding error is zero, this function
would return a zero value.

If field is a text string or date, =RERR returns a blank.

Refer to the section on Adagio database =functions, earlier in this chapter, for a
description of the arguments link, field, and record range .

=RNGMERGE()
Use this function to create a list of all possible combinations of accounts and
departments, where the accounts and departments are stored in separate cells. This
function is most commonly used to aid in calculating a sum of non-consecutive
accounts and/or departments in a single cell.

This function can be used in conjunction with the functions ADGET, ADDEBIT,
ADCREDIT, ADCRONLY and ADDRONLY. For an illustration, see Example #2
below.

Example #1:

If we use RngMerge to refer to two cells, cells A1 and A2, where cell A1 = 1000:2000-,
3000:4000-, 5000-, and A2 = 100,250, the formula would be:

RngMerge(A1 ,A2)

and the result would be:

1000:2000-100, 1000:2000-250, 3000:4000-100, 3000:4000-250, 5000-100, 5000-250
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Example #2:

This function:

ADGET (”gldata.M”, RngMerge(A1,A2))

will give you the current month net posted amount for the range of accounts shown
in the example above.

=ZIP( )
Returns the company zip code from the company profile.

Example:

=ZIP( )

would return the zip code from the company profile.

=Function Definitions
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Chapter 5
Statement Groups

Using the Statement Groups feature, you can define entire groups of financial
statements to print without operator intervention. This feature allows printing of an
unlimited number of financial statements with minimum mouse clicks!

You can also specify:

• what Adagio users are allowed to edit and print a statement group,
• add a Word document to print after any statement within the group,
• export the group to Excel using Excel Direct,
• print to the AdagioPDF printer or other available printers,
• create Subgroups to help you better organize your statements
• and more.
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Creating Statement Groups
To use this feature, you first need to create a Statement Group. (You can create as
many Statement Groups as you wish, according to your needs.)

1) From the View menu, select Statement Groups. This opens the Statement
Groups window. The first time you access this feature, it will be blank, as below.

This window is easiest to view horizontally. You may need to drag
the window to the bottom of the screen.

2) Right-click on the Statement Groups heading in the window, and from the
pop-up menu that appears, select New Group. You will be asked to assign a
name to the new statement group. You will want to choose a descriptive name,
such as Monthly Statements for a group of statements that you will be printing
on a monthly basis.

You must be the Adagio System Administrator (i.e. SYS logon) to access the
pop-up menu to delete groups within Statement Groups . Other users with
access to Maintain Financial Statements are able to create statement groups. If
the non-SYS user has no department restrictions, they will automatically have
access to all statement groups for which Allow Users (see page 5-167) have not
been set (unless they have also been 'allowed'). Users, who have access to Print
Financial Statements only are able to select functions which affect printing of a
statement group only.

If there are user Departmental Restrictions (see page 2-45) in effect at your site,
users will only be able to maintain/print statement groups for the departments
they have been restricted to.

Creating Statement Groups
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3) The new group gets added to the window, but you may need to click the plus
sign to the left of the Statement Groups heading to view it.

4) Right-click on the newly added group’s name. To add an item to this group,
select New Item. A window appears to give you your Report Item options:

Creating Statement Groups
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This window gives you several options:

Field Description

File Type the name of the specification you wish to add to
the Statement group, or click the Browse button and
select the specification file from the list displayed.

IMPORTANT NOTE: You can use Browse to locate a
specific file name, but if you plan to copy your
Statement Groups (i.e. from one dataset to another),
then once the specification file name has been added
to the File field, you should change the path to “.\”
followed by the file name. For example:

.\GL!BalanceSheet.sam

rather than:

C:\SOFTRAK\AFWIN\SAMDATA\
GL!BalanceSheet.sam

If your specification files are stored in a subdirectory
below your current directory, you would use
“..\SubDirectory” instead, such as:

..\SubDirectory\GL!BalanceSheet.sam
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Field Description

Department (list
with description)

Select the departments for which you want the
selected statement printed. Once selected, use the
Up/Down arrow buttons to set the order in which the
selected departments print.

The Consolidated (*) choice will print the statement
with the figures for the whole organization
(Consolidated).

The Custom Range option allows you to right click
and edit it (or F2) to add specific departments, ranges,
masks and/or lists. You must separate each
department with a semi-colon. You may also enter a
unique Name for the Custom Range. When a Custom
Range is edited, it becomes the new 'default' for any
subsequent item it is selected for. Unlike selecting a
Department Range (page 2-44), Mask (page 3-108) or
List (page 3-109) as the department, when an item
using the Custom Range department is printed,
separate statements are printed for each department
included in the Custom Range. (Department Ranges,
Masks and Lists each summarize the departments
they encompass on a single statement.) When a
Custom Range is edited, the edited Custom Range
now becomes the new 'default' for any new item it is
selected for. This facilitates you easily creating a
Custom Range name and departments for specific
groups within your organization. The Custom Range
need only be created once and it can then be easily
selected for all items within that Statement Group or
subgroup.

NOTE: If a Custom Range is subsequently edited, any
existing items the Custom Range was selected for will
require editing also IF you want the revised Custom
Range's departments to affect those items also.
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Field Description

Fiscal period Current will print the statements for the current
period – whichever period was selected as the current
period when Ledger or FX was started.

Prior will print the statement for the prior period -
period prior to whichever period was selected as the
current period when the program was started.

1 thru 12 or 13 will print the statement for the
specifically selected period.

Tabs (list with
description)

Each Financial Statement can contain multiple sheets.
You can select which sheets to print, and the order
you want them printed. Use the Up/Down arrow
buttons to reorder the sheets to set the order in which
they print.

Zero Suppress Suppresses printing of rows that contain zero as the
value in each column.

Blank Zeroes Prints a 'blank' for all zero value cells.

Expand
SmartSheet

Prints the statement in Expanded format.

Include Y/E
Adjustments

When this option is enabled, prior year postings to the
Year End Adjustment period (i.e. period 14) will be
included in the statement. Refer to the Adagio Ledger
online Help for more information about this function.

Ignore Inactive
Accounts

Enable this option to suppress printing of any
accounts having an Inactive status on your financial
specification. An account's status may be changed
from Active to Inactive within the Edit Accounts
function of Adagio Ledger or FX.

NOTE: Accounts are only suppressed if they have no
activity nor opening balance for the period being reported.
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Field Description

Skip Inactive
Departments

When this option is enabled, information for
departments that have been made Inactive will not be
included in the financial specification. A department's
status may be changed from Active to Inactive within
the Edit Departments function of Adagio Ledger or
FX.

Add a specification file to the group via the Browse button and then set your
options for printing that statement by indicating the departments you wish to
use, the fiscal period, and the zero suppression, blank zeroes, and SmartSheet
options.

5) For each financial statement that you want to add to this group, repeat step #4.

The Home and End keys can be used in this window to quickly
move through the list of statements.

6) You may wish to specify the fiscal period for a statement group prior to each
printing. To do so, once you’ve added the statement group to the statement
group window, right-click on the statement group name. A pop-up menu will
appear.

On the menu, click the Specify Fiscal Period option.

Once this option is turned on (as indicated by a checkmark to the left), every
time you print Adagio will prompt you to set the fiscal period you wish to use.

7) You may also want the page numbers to print in consecutive order. Perhaps
you have four statements in the group which together create a total of nine
printed pages. If you've used the $P parameter on the header or footer for each
statement, you can right-click on the statement group name and select
Consecutive Page Numbering. When the statement group prints, it will print
pages consecutively numbered one through nine.

8) However, if you turn on the Consecutive Page Numbering option on the
Statement Group, then right click on a Statement Item within the group, you can
select to Restart Page Numbering (at one) for that item. Normally, if you
selected to restart the page numbering for one item, you would also select to
have it restarted for each item in the group.
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Creating Sub Groups
Sub Groups are created in much the same way as Groups are. To create a Sub Group,
you would right-click on the parent Group and select New Sub Group. After
creation, the same options are available for a Sub Group as there are for Groups.

Sub Groups allow you to organize large Groups more effectively. Aditionally, when
a Group is printed using the Specify Fiscal Period option, you are not prompted to
enter the fiscal period for each Sub Group within the Group even if the option is also
enabled on the Sub Group. You are only prompted if you print the Sub Group
separately and the setting is enabled.

Enabling Consecutive Page Numbering on a Sub Group has effect only when the
Sub Group is printed separately from the Group.
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Allowing Users
This function is only available to the Adagio System
Administrator (user SYS).

Users who have been restricted to specific departments are only able to see and,
therefore, work with statement groups the Adagio System Administrator has
allowed them access to.

If your organization uses Departmental Restrictions (see page 2-45), in order to
provide users who have been restricted to specific departments access to use a
particular statement group:

1) Right click on the statement group and select Allow Users. The Allow These
Users Only window will display:

2) Click to place a checkmark beside all users (including those who do not have
Departmental Restrictions) who should have access to this statement group.

If a user having Group Security access to Print Financial Statements only has
been allowed access to a statement group, they will see the statement group
when they select View | Statement Groups or File | Statement Group Print,
and will be able to turn on/off print type functions with the statement group.

If a user having Group Security access to Maintain Financial Statements is
allowed access to a statement group, they will see and be able to print the
statement group (as above), and will also be able to turn on/off print type
functions, Duplicate and Rename the statement group.

A user having no Departmental Restrictions needs to be allowed access to a
statement group that others have been allowed access to, if they also need to
perform print type functions or otherwise manipulate the statement group.

Allowing Users
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3) Or, if only the Adagio System Administrators should have access to this
statement group, click the Administrator only checkbox.

Changing Statement Order
You may wish to have the reports in a particular group printed in a certain order. If
you did not enter the Items in the order you’d like, you can reorder the items by
right-clicking on an item you want to move, and then clicking Move Up or Move
Down from the pop-up menu.

Or, find the statement you wish to move up or down in the print order and click it
once to select it. Then, press Alt and the Up or Down arrow, depending on which
direction you wish to move it. The statement will go up or down in the list
accordingly, each time you press Alt+Arrow.

Similarly, you can reorder the groups themselves using the Move Up / Move Down
menu options and Alt+Arrow options.

Changing Statement Order
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Editing Items
Items in each group can be modified as needed, simply by right-clicking on the item
name and clicking Edit from the pop-up menu. You will be presented with the same
options as shown previously in the Add Report Item window, when you created the
report item, and can make any changes needed.

Deleting or Duplicating Groups/subgroups
and Itemsor Copy and Paste Items

You can Delete Groups/Subgroups or individual Items in each group, by
right-clicking on the component name and clicking Delete from the pop-up menu.

Duplicate Groups creates a new duplicate/copy of the group/subgroup at the end
of the list.

You can also Copy items and Paste them to other groups and subgroups.

Open Item or Open Item with Settings
Select Open Item to have the statement open using the settings it was last saved with.

Select Open Item with Settings to have the statement open using the settings applied
to it in the Edit or Add Report Item windows. For example, perhaps the statement
item was last saved using Consolidated departments. Open Item with Settings will
open the statement using the departments selected for it when used within the
statement group. This might be using a particular Custom Range or Departmental
List.

To set the default behavior for when an item is double clicked on and opened, use
Ctrl/RightClick on the preferred menu pick.

Editing Items
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Group and Item Ordering
You may wish to have the reports in a particular group printed in a certain order. If
you did not enter the Items in the order you’d like, you can reorder the items by
right-clicking on an item you want to move, and then clicking Move Up or Move
Down from the pop-up menu.

Similarly, you can reorder the groups themselves using the Move Up / Move Down
menu options.

Group and Item Ordering
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Printing Statement Groups
Once you have created a statement group, you can print it whenever needed in one
of two ways:

• Open the Statement Groups window from the View menu, then right-click on
the group’s name and click Print Group from the pop-up menu.

OR…

• Select Statement Group Print from the File menu. In the window that
appears, click the checkbox beside each statement group you wish to print,
and then click the Print button. (This method allows you to print multiple
statement groups at one time, instead of right-clicking on each of them
individually in the Statement Groups window.)

If you have chosen to Specify Fiscal Period each time you print your statement
groups (see step #6 in the Creating Statement Groups topic on page 5-160), once you
choose to print any statement groups flagged with that option, you will be prompted
to enter the appropriate fiscal period. Simply choose the fiscal period you want and
then click OK.

Subgroups (see page 5-166) printed within a statement group use the same fiscal
period as the parent group when the entire group is printed. When printed by itself,
a subgroup can be set to prompt you to Specify Fiscal Period.

You may also want the page numbers to print in consecutive order. Perhaps you
have four statements in the group which together create a total of nine printed pages.
If you've used the $P parameter on the header or footer (see page 3-96) for each
statement, you can right-click on the statement group name and select Consecutive
Page Numbering. When the statement group prints, it will print pages consecutively
numbered one through nine.

In addition to printing the statement groups, you may also export them to Excel
Direct by clicking the Excel Direct button by clicking the Excel Direct button in the
Statement Group Print window or the Export to Excel Direct selection from the
pop-up menu. When you do so, every statement will open in its own tab in the same
Excel book.

Export Protection (see page 3-121) may be applied to statements and statement
groups for when they are exported using Excel Direct.

Printing Statement Groups
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Printing to the AdagioPDF Printer
If you choose to print the statement group to the AdagioPDF printer, the following
window will display:

Complete the fields in the window according to the following table:

Field Description

File name: The default folder to store your PDF
document is the AdagioPDF folder
within your data folder, unless you
have Adagio ePrint installed.

NOTE: If Adagio ePrint is installed, the
default folder path defaults from what is
entered within the Ledger Company
Profile, Posting/Reports tab for
Statements (refer to the Adagio Ledger
online Help documentation).

Enter a file name to assign to the stored
file.

Printing Statement Groups
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Field Description

Append to existing PDF file If the file name entered already exists
in the folder, turn this option 'on' to
have the new group appended (added)
to the end of the existing file.

If a file of the same name already exists
and this option is turned 'off', the
existing file will be overwritten by the
new AdagioPDF output.

PDF Password This field is only active if Append to
existing PDF file is turned on.
Passwords may be alphanumeric. If
desired, carefully enter a password.
Before the file may be opened for
viewing, the password must be
correctly entered.

This field may be left blank (i.e. no
password required).

Open PDF with default viewer When enabled, the PDF file will
automatically open using your default
PDF viewer when it is finished
printing.

If left 'off', the output will still be saved
to PDF file to be viewed at another
time.

Click OK to complete your print request and create the file.

Printing Statement Groups
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Chapter 6
Function List

Using Named Ranges
Within the Financial Reporter, many functions may include cell ranges such as
S9..T15. In these cases, you have the choice of either manually typing the cell range
addresses or assigning the range a name (which may be easier to remember) and
entering the name in the formula instead.

If you were manually entering a range of accounts or record range,
you would enter the starting account, type a colon (:) and enter the
ending account. To separate one range from another or from
another individual account, type a comma (,).

Before going into a detailed list of each function in the Financial Reporter, we'd like
to discuss using the Named Range feature.

To create a Named Range, select Formulas | Named Ranges from the Financial
Reporter menu.
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The following window will open:

For example, in the Named Ranges field, type names=S9..T15 and press Enter or
click on the Add button (where "names" is the name you are assigning to the cell
range). The new Named Range will display in the list box below the Named Range
field.

When you are finished, click the Done button.

To edit an existing Named Range, simply access the Named Ranges
window from the Formulas menu and either click on the
appropriate name and edit the text in the Named Ranges field or
retype the entire name command (eg. names=S9..T14) and press
Enter or Click the Add button.

To delete a Named Range, highlight the name in the Names Range
List and click on the Remove button.

An example of a formula using the Named Range you just created might be:

=COUNT(NAMES) where NAMES is a Named Range for cells E5..J10

Note



Function List

Date/Time Functions

DATE(Y, M, D)

Description
This function returns the date value corresponding to year Y+1900, month M, and
date D. Y must be in the range 0 to 199 (representing 1900-2099).

Parameters
Y year

M month

D day

Example
DATE(66, 4, 6) = 24203, April 6, 1966

DATE(366) = Error! wrong number or arguments

DATESTRING()

Description
Formats dates in your financial statements according to your needs.

Parameters
The table below lists the Datestring() parameters, explaining what each parameter
will return when used in the Datestring function.

Parameter Description

a Abbreviated weekday name

A Full weekday name

Function List
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Parameter Description

b Abbreviated month name

B Full month name

c Date and time representation appropriate for locale, with
month/day/year in mm/dd/yyyy format

#c Date and time representation appropriate for locale, with
month/day/year in month dd, yyyy format

d Day of month as decimal number (01 - 31)

#d Day of month as decimal number (01 - 31), remove leading zeros

H Hour in 24-hour format (00 - 23)

#H Hour in 24-hour format (00 - 23), remove leading zeros

I Hour in 12-hour format (01- 12)

#I Hour in 12-hour format (01- 12), remove leading zeros

j Day of year as decimal number (001 - 366)

#j Day of year as decimal number (001 - 366), remove leading zeros

m Month as decimal number (01 - 12)

#m Month as decimal number (01 - 12), remove leading zeros

M Minute as decimal number (00 - 59)

#M Minute as decimal number (00 - 59), remove leading zeros

p Current locale’s A.M./P.M. indicator for 12-hour clock

S Second as decimal number (00 - 59)

#S Second as decimal number (00 - 59), remove leading zeros

U Week of year as decimal number, with Sunday as first day of week (00
- 53)
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Parameter Description

#U Week of year as decimal number, with Sunday as first day of week (00
- 53), remove leading zeros

w Weekday as decimal number (0 - 6; Sunday is 0)

W Week of year as decimal number, with Monday as first day of week (00
- 53)

x Date representation for current locale, with month/day/year in
mm/dd/yyyy format

#x Date representation for current locale, with month/day/year in month
dd, yyyy format

X Time representation for current locale

y Year without century, as decimal number (00 - 99)

#y Year without century, as decimal number (00 - 99), remove leading
zeros

Y Year with century, as decimal number

#Y Year with century, as decimal number, remove leading zeros

z, Z Time-zone name or abbreviation; no characters if time zone is
unknown

Example
Stringing together the parameters allows for a very descriptive date string.

=DATESTRING($C$2,"%A, the %d day of %B in the year of %Y ")

returns

Friday, the 14 day of June in the year of 2002
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DATEVALUE(S)

Description
This function returns the corresponding date value for a given string S. It interprets
the data in the following formats:

MM/DD/YY
DD-MMM-YY
MMM-YY (assumes the first of the month)
DD.MM.YY

In all formats, the year may be omitted, in which case it defaults to the current year
(current year is based on your system year and not the fiscal year selected - unless
this changes). The year may be given as 2 or 4 digits. A two-year digit assumes the
20th century. In the above formats, the month (MMM) is case insensitive and may be
either the standard 3 letter abbreviation or the full name of the month.

Parameters
S string value of a date

Example
DATEVALUE(``3/24/2004’’) = 38070

DATEVALUE(``3/24/54’’) = 19807

DATEVALUE(``4-July-1994’’) = 34519

DATEVALUE(``4-July’’) = 34519, where the year is omitted, and assuming the year is
1994.

DATEVALUE(``September-94’’) = 34578

DATEVALUE(``Sep-1994’’) = 34578

DATEVALUE(``SEP’’) = 34578, where the year is omitted, and assuming the year is
1994.

DATEVALUE(``06.04.66’’) = 24203

DATEVALUE(``06.04.2007’’) = 39237
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When the year is defaulted, the value returned by DATEVALUE will
vary depending on the year. For example, if you are using Objective
Grid late on New Year’s Eve 1991, the function
DATEVALUE(``1-Jan’’) will return 33239 before midnight and 33604
after midnight.

DAY(DT)

Description
This function returns the day of the month component of the date/time value DT.

Parameters
DT A date/time value

Example
DAY(24203) = 6 (24203 represents April 6, 1966)

DAY(TODAY()) = 25, where TODAY = January 25, 1994

DAY(366) = 31 (366 represents December 31, 1900)

DAYOFFISCALYEAR([D])

DAYOFYEAR([D])

DAYS360(S, E)

Description
This function returns the number of days between two dates, based on a 30/360 Day
Count Basis (30-days-per-month, 360-days-per-year.)

Parameters
S Start date

E End date
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Example
DAYS360(DATE(92, 5, 1), DATE(92, 6, 1)) = 30

DAYS360(DATE(93, 2, 28), DATE(93, 3, 1)) =1

DAYS360(DATE(92, 2, 28), DATE(92, 3, 1)) = 3 (1992 is a leap year.)

EDATE(S, M)

Description
This function returns a date/time value representing the date M months after S if M
is positive, and M months previous to S if M is negative. The date returned will be on
the same day of the month as S.

Parameters
S Start date

M Months

Example
EDATE(DATEVALUE(``2/29/92’’), 3) = 33753 or 05/29/92

EDATE(DATEVALUE(``2/29/92’’), 12) = 34028 or 2/28/93

EDATE(DATEVALUE(``3/30/93’’), -6) = 33877 or 09/30/92

EOMONTH(S, M)

Description
A date/time value representing the date M months after S, if M is positive, and M
months before S, if M is negative. The date returned will be on the last day of the
month.

Parameters
S Start date, a date/time value

M Months, an integer
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Example
EOMONTH(DATEVALUE(``7/7/93’’), -24)= 33450 or 7/31/91

EOMONTH(DATEVALUE(``4/15/94’’), 2)= 34515 or 6/30/94

HOUR(DT)

Description
This function returns the hours (0 - 23, where 0 represents midnight) component of
the date/time value DT.

Parameters
DT A date/time value

Example
HOUR(.25) = 6

HOUR(0) = 0

HOUR(.99) = 23

ISOWEEKNUM(D)
Description

This function returns the week number of the date specified. Week one starts on
Monday of the first week of the calendar year having a Thursday.

Parameters

D A date value

Example

ISOWEEKNUM(H4) = 2 where cell H4 contains 1/11/2015

ISOWEEKNUM(H4) = 9 where cell H4 contains 2/28/2015

ISOWEEKNUM(H4) = 39 where cell H4 contains =TODAY()

ISOWEEKNUM(H4) = 39 where cell H4 contains =DATE(15,9,24)
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MINUTE(DT)

Description
This function returns the minutes (0 to 60) component of the date/time value DT.

Parameters
DT A date/time value

Example
MINUTE(.99) = 45

MINUTE(.6) = 24

MINUTE(.3) = 12

MONTH(DT)

Description
This function returns the month component of the date/time value DT.

Parameters
DT A date/time value

Example
MONTH(24203) = 4, where 24203 represents April 6, 1966

MONTH(TODAY) = 12, where TODAY = December 25, 1994

MONTH(366) = 12, where 366 represents December 31, 1900
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NETWORKDAYS(S, E, H)

Description
This function returns the number of whole working days, beginning with S and
ending with E, excluding days in H and weekends.

Parameters
S Starting date, a date/time value

E Ending date, a date/time value

H A range of dates to exclude, such as holidays

Example
NETWORKDAYS(DATE(93, 1, 1), DATE(93, 12, 31)) = 261

NETWORKDAYS(DATE(93, 1, 1), DATE(93, 12, 31), A1..A5) = 258,

where A1..A5 =

DATEVALUE(``1/1/93’’),

DATEVALUE(``5/25/93’’),

DATEVALUE(``7/4/93’’),

DATEVALUE(``9/3/93’’),

DATEVALUE(``11/28/93’’)

NOW( )

Description
This function returns the date and, depending how it is used, time value
corresponding to the current system date and time.

Example
NOW() = 33139.37, where 33139.37 represents September 23, 1990 at 8:52:48 A.M.

MONTH(NOW( )) = 9
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HOUR(NOW( )) = 8

DATESTRING(NOW(),"%#H:%M%p" = 8:52AM

SECOND(DT)

Description
Returns the seconds (0 to 59) component of date/time value DT.

Parameters
DT A date/time value

Example
SECOND(.1000000) = 0

SECOND(.8755342) = 46

SECOND(.0645977) = 1

TIME(H, M, S)

Description
Returns the time value represented as a fraction of a day, starting at midnight. H
must be between 0 and 23, and M and S must be between 0 and 59.

Parameters
H hour

M minute

S second

Example
TIME(12, 0, 0) = 0.5, where 0.5 represents half of a day, which is noon

TIME(8, 45, 46) = 0.36511574

HOUR(TIME(C1, D1, E1)) = 13, where C1 = 13, D1 = 40, and E1 = 2
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TIMEVALUE(S)

Description
Returns the corresponding time value for a given string value S. The function
interprets the times specified in the following formats: HH:MM:SS AM or PM

(1 <= HH <= 12)
HH:MM:SS (0 <= HH <= 23)
HH.MM.SS (0 <= HH <= 23)
HH,MM,SS (0 <= HH <= 23)
HHhMMmSSs (0 <= HH <= 23)

The first format is the international 12-hour AM/PM time format. All others are
international 24-hour time formats. In all formats the seconds (SS) may be omitted, in
which case they default to 00. In all formats the hours may be specified with 1 or 2
digits, while the minutes (MM) and seconds (SS) must be 2 digits. The following are
equivalent:

TIMEVALUE(``12:55:00 AM’’)
TIMEVALUE(``12:55 am’’)
TIMEVALUE(``00:55:00’’)
TIMEVALUE(``00:55’’)
TIMEVALUE(``00, 55, 00’’)
TIMEVALUE(``0.55.00’’)
TIMEVALUE(``0h55m00s’’)
The result is 0.038194444

Parameters
S A string value

TODAY( )

Description
Returns the date value corresponding to the current system date.

Example
YEAR(TODAY( )) = 107, where107 represents the year 2007

MONTH(TODAY( )) = 9

DAY(TODAY( )) = 23
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WEEKDAY(D)

Description
Returns an integer representing the day of the week on which the day D falls. 1 is
Sunday, 7 is Saturday.

Parameters
D serial date value

Example
WEEKDAY(DATEVALUE(``2/25/94’’)) = 6

WEEKDAY(34466) = 5

WEEKDAY(TODAY()) = 2

WEEKNUM(D, [RT], ["C | F"])

Description
Returns the week number of the date specified. Optionally, may indicate return type
for how you define weeks in the calendar or fiscal year. Calendar year is the default.
Return type must be specified when used with "F".

Parameters
D Date value

RT Return Type and C(alendar)

1 Week runs from Sunday to Saturday, January 1st is week 1 (default)
2 Week runs from Monday to Sunday, January 1st is week 1
11 Week runs from Monday to Sunday, January 1st is week 1
12 Week runs from Tuesday to Monday, January 1st is week 1
13 Week runs from Wednesday to Tuesday, January 1st is week 1
14 Week runs from Thursday to Wednesday, January 1st is week 1
15 Week runs from Friday to Thursday, January 1st is week 1
16 Week runs from Saturday to Friday, January 1st is week 1
17 Week runs from Sunday to Saturday, January 1st is week 1
21 Use ISO week numbering
All other values return Error!
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RT Return Type and F(iscal)

1 Week runs from Sunday to Saturday, January 1st is week 1
2 Week runs from Monday to Sunday, January 1st is week 1
21 use ISO week numbering - fiscal periods are ignored
All other values return Error!

Example
WEEKNUM(H4) = 3 where cell H4 is 1/11/2015

WEEKNUM(H4,2) = 2 where cell H4 is 1/11/2015

WEEKNUM(H4,21) = 2 where cell H4 is 1/11/2015

WEEKNUM(H4,1) = 39 where cell H4 is =TODAY()

WEEKNUM(H4,1) = 39 where cell H4 is =DATE(15,9,24)

WEEKNUM(H4, 1, "F") = 3 where cell H4 is 1/11/2015

WORKDAY(S, D[, H])

Description
Returns the serial day value that is D working days after day S (if D is positive) or D
working days before day S (if D is negative), excluding weekends and all holidays
specified as dates in range H.

Parameters
S Serial start date value

D Number of days before (negative) or after (positive) start date

H Cell or range of cells containing serial date values to exclude

Example
WORKDAY(DATE(91, 1, 1), 5, A1..A2) = 33249 or 01/11/91,

where A1..A2 =

DATEVALUE(``1/7/91’’),

DATEVALUE(``1/8/91’’)
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WORKDAY(DATE(93, 1, 1), 258, A1..A5) = 34334 (or 12/31/91),

where A1..A5 =

DATEVALUE(``1/1/93’’),

DATEVALUE(``5/25/93’’),

DATEVALUE(``7/4/93’’),

DATEVALUE(``9/3/93’’),

DATEVALUE(``11/28/93’’)

YEAR(DT)

Description
Returns the year component of the date/time value DT, where 1900 = 0.

Parameters
DT A date/time value

Example
YEAR(24203) = 66, where 24203 represents April 6, 1966

YEAR(TODAY()) = 90, where TODAY = December 25, 1990

YEAR(366) = 0, where 366 represents December 31, 1900

YEARFRAC(S, E[, B])

Description
Returns the year fraction representing the number of whole days between S (start
date) and E (end date). This function is useful in calculating the percent of benefit or
obligation to assign a specific period.

Parameters
S A date value that represents the start date

E A date value that represents the end date
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B (Optional) The day count basis to be used:

0 or omitted 30/360
1 Actual/actual
2 Actual/360
3 Actual/365

Example
YEARFRAC(DATE(94, 1, 1), DATE(94, 5, 30), 0) = 0.4167

YEARFRAC(DATE(94, 1, 1), DATE(94, 5, 30), 1) = 0.4110

Mathematical Functions

ABS(X)

Description
This function returns the absolute (positive) value of X.

Parameters
X A numeric value or cell reference containing a numeric value

Example
ABS(5) = 5

ABS(-5) = 5

ABS(52) = 52

ABS(C15) = 10, where C15 = -10

SQRT(ABS(D4)) = 10, where D4 = -100

CEIL(X)

Description
This function returns the smallest integer that is greater than or equal to X.
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Parameters
X A numeric value

Example
CEIL(5.5) = 6

CEIL(E3) = -9, where E3 = -9.99

CEIL(C17) = 1, where C17 = 1

FLOOR(X)

Description
This function returns the largest integer less than or equal to X.

Parameters
X A numeric value

Example
FLOOR(5.5) = 5

FLOOR(E3) = -10, where E3 = -9.99

FLOOR(C17) = 3, where C17 = 3.45

FRAC(X)

Description
This function returns the fractional portion of X.

Parameters
X A numeric value

Example
FRAC(232.45566) = 0.45566

FRAC(20) = 0
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FRAC(PI()) = 0.14159265

INT(X)

Description
This function returns the integer portion of X.

Parameters
X A numeric value

Example
INT(232.45566) = 232

INT(J20) = -10, where J20 = -10.3

INT(PI()) = 3

MOD(X, Y)

Description
This function returns the remainder of X/Y with the same sign as X. (This function is
NOT modulus as sometimes documented.)

Parameters
X A numeric value

Y A numeric value

Example
MOD(8, 4) = 0

MOD(D2, F3) = 12, where D2 = 100 and F3 = 44

MOD(F5, A1) = Error!, where F5 = 98.6 and A1 = 0 (cannot divide by zero)

MOD(-14, 3) = -2 (the true modulus is 1)
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MODULUS(X, Y)

Description
This function returns the modulus of X/Y.

Parameters
X A numeric value

Y A numeric value

Example
MODULUS(8, 4) = 0

MODULUS(D2, F3) = 12, where D2 = 100 and F3 = 44

MODULUS(F5, A1) = Error!, where F5 = 98.6 and A1 = 0 (cannot divide by zero)

MODULUS(-14, 3) = 1

PI( )

Description
This function returns the value of the mathematical symbol PI.

Example
PI( ) = 3.1415927…

PRODUCT(argumentlist)

Description
Multiplies all the numeric elements of the argument list together, ignoring empty
and non-numeric values, and returns the product.

Parameters
argumentlist

Any combination of numbers, cells, or ranges
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Example
PRODUCT(6, 5, 8, 2) = 480

PRODUCT(A1..A3) = 25.1327, where A1..A3 = 2, PI, 4

ROUND(X, N)

Description
Returns X rounded to the number of decimal places specified by N (when N is
positive); it returns X rounded to a whole number when N is negative.

Parameters
X A numeric value

N the number of decimal places or whole numbers, between -15 and 15

Example
ROUND(PI(), 2) = 3.14

ROUND(FRAC(PI()), 2) = 0.14

ROUND(1234.5678, -2) = 1200

SQRT(X)

Description
Returns the positive square root of X.

Parameters
X A numeric value

Example
SQRT(100) = 10

SQRT(ABS(P9)) = 2, where P9 = -4

SQRT(-3) = Error! (the argument is negative)
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SUM(argumentlist)

Description
Returns the sum of its arguments. Blank cells and cells containing strings are not
counted.

Parameters
argumentlist

Any combination of numbers, cells, or ranges

Example
SUM(10, 20, 30, 40, 50) = 150

SUM(L1..L3) = 15.10564, where L1 = 1.32342, L2 = 5.45735, and L3 = 8.32487

SUM(A1, B1, C1, D1) = 0, where A1 = -1, B1 = -9, C1 = 9, and D1 = 1

VSUM(argumentlist)

Description
Returns the ``visual sum’’ of its arguments. This function differs from SUM in that it
uses the precision and rounding of the actual formatted values appearing in the cells
instead of the internal double-precision value of the cell. This ensures that what you
see is what you get when calculating a sum.

VSUM will only be recalculated when the cell values of the
referenced cells are changing. If you change the format of the
referenced cells but not the values, you have to manually update the
cell with the VSUM formula, e.g. by editing it and adding a blank at
the end.

Parameters
argumentlist

Any combination of numbers, cells or ranges
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Example
VSUM(L1..L3) = .99 where L1 = 1/3, L2 = 1/3, and L3 = 1/3 and are displayed with
two decimal places

VSUM(F11,F20)-VSUM(F14,F17) uses corect formula structure.
VSUM(F11,-F14,-F17,F20) does not use correct formula structure and will produce
unpredictable results.

VSUM is not a replacement for SUM. It will sum only the amounts that are
'displayed' in the sheet. Hidden rows are not included unless they are specifically
summed, for example VSUM(L1+L3).

VSUM in the total cell reports the incorrect total if the last cell in the calculated range
is a .Range row. The work around is to create a 'blank' row immediately following
the last .Range row in the range and to include this row in the range of cells being
VSUMmed. If you want, you can always reduce the height of the 'blank' row so that
it doesn't appear like it is on the statement.

Text Functions

CHAR(N)

Description
This function returns the character represented by the ASCII code N.

Parameters
N An ASCII code from 1 to 255

Example
CHAR(55) = ``7’’

CHAR(C2) = ``C’’, where C2 = 67

CHAR(F5) = ``c’’, where F5 = 99
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CLEAN(S)

Description
This function returns the string formed by removing all non-printing characters from
the string S.

Parameters
S A string value

Example
CLEAN(A1) = ``test’’, where A1=STRCAT(A2, A3), A2=``test’’ and A3=CHAR(10)

CODE(S)

Description
This function returns the ASCII code for the first character in string S.

Parameters
S A string value

Example
CODE(``test’’) = 116

CODE(H100) = 107, where H100 = ``k’’

CODE(M10) = 56, where M10 = ``89’’

CONCATENATE(argumentlist)

Description
Use this function to join strings. This function is the same as the STRCAT() function
in previous versions of the Financial Reporter, and was added for compatibility
reasons. Either function will work to join strings.
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Parameters
argumentlist
Any combination of numbers, cells, or ranges

Examples
CONCATENATE(”The bottom line is “, B3,”!”) = “The bottom line is 1!” where
B3 = 1

CONCATENATE(”The sum is ”, SUM(I1..I5)) = “The sum is 4”, where I1..I5 = 1, 1, -4,
0, and 6

CONCATENATE(”The word is ”, PROPER(S3)) = “The word is Boston”, where S3 =
boston

EXACT(S1, S2)

Description
This function returns 1 if string S1 exactly matches string S2; returns 0 otherwise.

Parameters
S1 A string value

S2 A string value

Example
EXACT(``computer’’, ``computer’’) = 1

EXACT(``Abc’’, ``abc’’) = 0

FIND(S1, S2, N)

Description
This function returns the index of the first occurrence of string S1 in string S2,
starting the search at position N in string S2. Note that the string index always starts
with 1 (the number 1).

Parameters
S1 A string value
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S2 A string value

N A numeric value

Example
FIND(``bc’’, ``abcdefg’’, 1) = 1

FIND(V1, V2, 5) = 9, where V1 = ``Functions’’, and V2 = ``Built-in Functions’’

FIND(V1, V2, 5) = Error!, where V1 = ``Built-in’’ and V2 = ``Functions’’ (string is not
found)

LEFT(S, N)

Description
This function returns the string composed of the leftmost characters of string S. If N
is greater than or equal to the length of S, then the entire string S is returned.

Parameters
S A string value

N A numeric value

Example
F1 = ``workstation’’

LEFT(F1, 1) = ``w’’

LEFT(F1, 4) = ``work’’

LEFT(F1, 20) = ``workstation’’

LENGTH(S)

Description
This function returns the number of characters in string S.

Parameters
S A string value
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Example
LENGTH(``computer’’) = 8

LENGTH(G3) = 14, where G3 = ``Expense Report’’

LENGTH(Z7) = 20, where Z7 = ``Linear Least Squares’’

LOWER(S)

Description
This function returns the alphabetic string S converted to lower-case characters.

Parameters
S A string value

Example
LOWER(``AIRPORT’’) = ``airport’’

LOWER(G3) = ``expense report’’, where G3 = ``Expense Report’’

LOWER(K10) = ``connections’’, where K10 = ``CONNECTIONS’’

MID(S, N1, N2)

Description
This function returns the string number of characters N2 that start at position N1 in
string S. N1 is the number of characters from the beginning of the string, must be
greater than or equal to zero, and less than the length of S. N2 must be greater than
or equal to zero. If N1+N2 is greater than the length of S, then the substring starting
at position N1 in S is returned. The first character in string S is in position zero.

Parameters
S A string value

N1 A numeric value

N2 A numeric value
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Example
T5 = ``Spreadsheet’’

MID(T5, 6, 5) = ``sheet’’

MID(T5, 10, 1) = ``t’’

MID(T5, 1, 0) = `` ‘’

PROPER(S)

Description
Returns the string S with the first letter of each word capitalized.

Parameters
S A string value

Example
PROPER(``president’’) = ``President’’

PROPER(P9) = ``Chicago’’, where P9 = ``CHICAGO’’

PROPER(E18) = ``Chapel Hill’’, where E18 = ``chapel hill’’

REGEX(S1, S2)

Description
Returns True (1) if the string S2 matches the pattern specified by the regular
expression in string S1, and False (0) otherwise. This function is similar to EXACT
except it allows ``wildcard’’ comparisons by interpreting S1 as a regular expression
of the type used in the Find and Extract operations.

Parameters
S1 A string value

S2 A string value
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Example
REGEX(``t.p’’, ``top’’) = 1

REGEX(``t.e’’, ``table’’) = 1

REGEX(``t.e’’, ``talk’’) = 0

REGEX(``F[0-9]’’, ``F3’’) = 1

REGEX(``F[0-9’’, ``F3’’) = Error! (missing ] after 9)

REGEX(``a’’, ``apple’’) = 1

REGEX(``ab’’, ``apple’’) = 0

REPEAT(S, N)

Description
Returns the string S repeated N times.

Parameters
S A string value

N A numeric value

Example
Z1 = ``There’s no place like home.’’

REPEAT(Z1, 1) = ``There’s no place like home.’’

REPEAT(Z1, 3) = ``There’s no place like home. There’s no place like home. There’s no
place like home.’’

REPEAT(Z1, 0) = `` ‘’

Function List

Function List Page 6-203



REPLACE(S1, N1, N2, S2)

Description
Returns the string formed by replacing the N2 characters starting at position N1 in
string S1 with string S2. The first character in string S1 is zero.

Parameters
S1 A string value

N1 A numeric value

N2 A numeric value

S2 A string value

Example
REPLACE(``John’’, 1, 3, ``ack’’) = ``Jack’’

REPLACE(E1, 8, 3, ``Log’’) = ``Expense Logort’’, where E1 = ``Expense Report’’

REPLACE(E1, 8, 6, ``Log’’) = ``Expense Log’’, where E1 = ``Expense Report’’

REPLACE(``ABC’’, 0, 0, ``XYZ’’) = ``XYZABC’’

RIGHT(S, N)

Description
Returns the string composed of the rightmost N characters of S. If N is greater than or
equal to the length of S, then the entire string S is returned.

Parameters
S A string value

N A numeric value

Example
F1 = ``workstation’’

RIGHT(F1, 1) = ``n’’
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RIGHT(F1, 4) = ``tion’’

RIGHT(F1, 20) = ``workstation’’

STRCAT(argumentlist)

Description
Returns the concatenation of all its arguments. For cell arguments, the actual
formatted contents of the cell are used, even if the cell contains a numeric value.

Parameters
argumentlist

Any combination of numbers, cells, or ranges

Example
STRCAT(``The bottom line is ‘’, B3, ``!’’) = ``The bottom line is 1!’’, where B3 = 1

STRCAT(``The sum is ‘’, SUM(I1..I5) = ``The sum is 4’’, where I1..I5 = 1, 1, -4, 0, and 6

STRCAT(``The word is ‘’, PROPER(S3)) = ``The word is Boston’’, where S3 = boston

STRING(X, N)

Description
Returns the string representing the numeric value of X, formatted to N decimal
places, where N is in the range 0 to 15. The results are rounded.

Parameters
X A numeric value

N A numeric value

Example
STRING(2, 4) = ``2.0000’’

STRING(``2’’, 4) = ``0.0000’’

STRING(SUM(A1..A3), 1) = ``1.7’’, where A1 = 0.33, A2 = 0.55, and A3 = 0.77
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STRLEN(argumentlist)

Description
Returns the total length of all the strings in its argument list. It differs from LENGTH
in that it can take multiple arguments, but more significantly, it returns the length of
the formatted contents of a cell, even if it contains a numeric argument.

Parameters
T Any combination of numbers, cells, or ranges

Example
STRLEN(``PHYSICS’’) = 7

STRLEN(B1) = 34, where B1 = ``Engineering Scientific Spreadsheet’’

STRLEN(A1) = 10, where A1 contains the value formatted as currency with two
decimal places so that it appears on screen as $1,000.00 (plus a trailing blank).

TOWORDS(N [,I])

Description
Returns the text string representing the numeric value of N. If the optional parameter
is a not passed or is zero then the value is interpreted as a number, otherwise it is
interpreted as a currency field.

Parameters
N A numeric value

I Optional parameter 0, 1, TRUE(), or FALSE()

Example
TOWORDS(123.55) = One Hundred Twenty Three Point Five Five

TOWORDS(123.55,1) = One Hundred Twenty Three Dollars and Fifty Five Cents

TOWORDS(9) = Nine

Function List

Page 6-206 Adagio Financial Reporter



TRIM(S)

Description
Returns the string formed by removing leading, trailing and consecutive embedded
spaces from string S.

Parameters
S A string value

Example
TRIM(`` Alpha Beta Gamma ‘’) = ``Alpha Beta Gamma’’

TRIM(R5) = ``There’s no place like home.’’, where R5 = ``There’s no place like
home.’’

UPPER(S)

Description
Returns the string S converted to uppercase characters.

Parameters
S A string value

Example
UPPER(``New York’’) = ``NEW YORK’’

UPPER(H7) = ``POPULAR VOTE’’, where H7 = ``popular vote’’

VALUE(S)

Description
Returns the numeric value represented by string S, or 0 if S does not represent a
number.

Parameters
S A string value
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Example
VALUE(``324.399’’) = 324.399

VALUE(G10) = 1.7, where G10 = ``1.7’’

VALUE(M8) = 0, where M8 = ``cosine’’

Financial Functions

ACCRINT(I, Ft, S, R, P, F [, B])

Description
This function returns the accrued interest for a security that pays periodic interest.
Accrued interest is the amount the buyer must compensate the seller for the portion
of the next coupon interest payment the seller has earned but will not receive from
the issuer.

Parameters
I The issue date.

Ft The first interest date.

S The settlement date.

R The annual coupon rate.

P The par value of the security.

F The number of coupon payments per year (frequency).

B (Optional) The day count basis to be used:

0 or omitted 30/360
1 Actual/actual
2 Actual/360
3 Actual/365

Example
ACCRINT(A1, A2, A3, A4, A5, A6, A7) = 35.3611, where A1=02/01/93,
A2=08/01/93, A3=06/15/93, A4=0.095, A5=1000, A6=2, and A7=0
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ACCRINTM(I, S, R, P [, B])

Description
This function returns the accrued interest for a security that pays interest at maturity.

Parameters
I The issue date, a date/time value.

S The settlement date, a date/time value.

R The annual coupon rate.

P The par value of the security.

B (Optional) the day count basis to be used:

0 or omitted 30/360
1 Actual/actual
2 Actual/360
3 Actual/365

Example
ACCRINTM(C6, C7, C8.C9, C10) = 39.3442, where C6 = 02/03/92, C7 = 07/12/92, C8
= 9%, C9 = 1000 and C10 = 1

CTERM(R, FV, PV)

Description
This function calculates the number of compounding periods required for an
investment of PV to reach a value of FV at the given interest rate R. The formula is
given by:

Parameters
R Interest rate

FV Future value of the investment

PV Present value of the investment
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Example
CTERM(0.085, 1500, 1000) = 4.97 (years, if the annual interest rate is 8.5%)

CTERM(B5, D5, C5) = 11, where B5 = 10.5%, D5 = $300,000, and C5 = $100,000

CTERM(.09, 1900, 1100) = 6.3

CUMIPMT(R, N, P, S, E, T)

Description
This function returns the cumulative interest paid on a loan between S (the start) and
E (the end). Make sure you are consistent about the units used for specifying R and
N. For example, for a 4-year loan with 10% annual interest rate, use 10%/12 for R and
412 for N)

Parameters
R Rate, a numeric expression

N Number of payments, an integer 0

P Present value

S Starting period in calculation

E Ending period in calculation

T (Optional) timing of the payment:

0 payment is made at the end of the period
1 payment is made at the beginning of the period

Example
CUMIPMT(9.5%/12, 3012, 100000, 1, 12, 0) = 9499.99

CUMPRINC(R, N, P, S, E, T)

Description
This function returns the cumulative principal paid on a loan between S (the start)
and E (the end). Make sure you are consistent about the units used for specifying R
and N. (For example, for a 4-year loan with 10% annual interest rate, use 10%/12 for
R and 412 for N)
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Parameters
R Rate, a numeric expression

N Number of payments, an integer 0

P Present value

S Starting period in calculation

E Ending period in calculation

T (Optional) timing of the payment:

0 payment is made at the end of the period

1 payment is made at the beginning of the period

Example
CUMPRINC(9.5%/12, 3012, 100000, 1, 12, 0) = 4.8055

DB(C, S, L, N, M)

Description
This function returns the fixed-declining real depreciation of an asset for a specified
period.

Parameters
C Initial cost of asset

S Salvage value of asset

L Number of periods over which the asset is depreciating (life)

N Number of periods over which to calculate the depreciation

M (Optional) Number of months in the first year. Assumed to be 12 if omitted.

Example
DB(40000, 100, 6, 3, 2) = 8323.1198
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DDB(C, S, L, P)

Description
This function returns the double-declining depreciation allowance of an asset for a
specified period.

Parameters
C cost

S salvage value

L allowable life

P the period for which the double declining depreciation allowance is being
calculated

Example
DDB(200, 120, 25, 10) = 9.6

DDB(F9, F5, 10, 6) = 524.29, where F5 = $1800.00 and F9 = $8000.00

DDB(200, 220, 10, 7) = Error! (must have ``cost’’ => ``salvage’’)

EFFECT(R, P)

Description
This function returns the effective annual interest rate.

Parameters
R Nominal rate

P Number of compounding periods per year

Example
EFFECT(6.75%, 5) = 0.06935
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FV(P, R, N)

Description
This function returns the future value of an annuity. The function is given by:

Parameters
P Periodic payment

R Interest rate

N Number of periods

Example
FV(100, 0.085, 5) = 592.54

FV(G7, C2, 2) = 6240, where C2 = 8% and G7 = $3000.00

FVSCHEDULE(P, R)

Description
This function returns the future value of an initial principal after compounding by a
series of interest rates.

Parameters
P Principal, or present value

R An array of interest rates by which to compound

Example
FVSCHEDULE(100, A1..A4) = 132.4260, where A1..A4 = 7.5%, 6.6%, 8%, 7%

FVSCHEDULE(100, RATES) = 132.4260, where RATES is a named range of cell
addresses which = 7.5%, 6.6%, 8%, 7%
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IPMT(R, P, NP, PV, FV, [T])

Description
This function returns the interest payment for a specified period for a loan or
investment based on periodic, constant payments and a constant interest rate. Make
sure that the units used for R and P are consistent. For example, for a 5-year loan
with 12% annual interest, if you make payments monthly, use 12%/12 for (monthly)
R and for NP.

Parameters
R Interest rate per period

P The period for which the interest will be calculated (an integer)

NP The total number of payment periods

PV The present value of the investment

FV The future value or a cash balance you would like to attain at the end of
the last period

T (Optional) timing of the payment:

0 payment is made at the end of the period

1 payment is made at the beginning of the period

Example
IPMT(10%/12, 1, 24, 2000, 0, 0) = 16.6667

IRR(G, F)

Description
This function returns the internal rate of return on an investment given a set cash
flow contained in range F, and an initial ``guess’’ G (usually 0). F must contain at
least two cash flow values. Negative cash flows represent expenditures, and positive
cash flows represent income. Blanks and text are treated as zeroes.

Function List

Page 6-214 Adagio Financial Reporter



Parameters
G A numeric value

F cash flow, represented by a range

Example
IRR(0, L2..L6) = -0.32606171, where L2..L6 = -80, 90, 67, 72, and -90

IRR(0, I5..I9) = 1.0462142, where I5..I9 = -700, 750, 900, 600 and 850

IRR(0, -200, 100, 300) = Error! ( too many arguments to function)

MIRR(V, F, R)

Description
This function returns the Modified Internal Return Rate for a range of periodic cash
flows. Blanks and text are treated as zeroes.

Parameters
V A range of values representing periodic income (positive values) and
payments (negative values)

F Finance rate, the interest paid on the payments

R Reinvestment rate, the rate of return on the income

Example
0 A B

1 Investment -140000

2 1st year return 34000

3 2nd year return 46000

4 3rd year return 45000

5 4th year return 47000

6 5th year return 46000
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MIRR(B1..B6, 11%, 12.5%) = 0.14522

MIRR(VALUES, 11%, 12.5%) = 0.14522, where VALUES is a named range of cell
addresses

NOMINAL(R, C)

Description
This function returns the nominal annual interest rate for an effective interest rate R
and the number of compounding periods per year C.

Parameters
R Effective interest rate

C Number of compounding periods per year

Example
NOMINAL(6.9347%, 5) = 0.0675

PMT(PV, R, N)

Description
Returns the periodic payment for a loan, given present value PV and interest rate R.
The formula is given by:

Parameters
PV present value of an investment

R interest rate

N number of periods

Example
PMT(15000, C6, 4) = 4834.90, where C6 = 11%

PMT(M4, 0.07, G4) = 8058.6404, where G4 = 30 and M4 = 100000

PMT(1700, 11, 0) = Error! (number of periods must be greater than 0)
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PPMT(R, P, NP, PV, FV[, T])

Description
Returns the payment on the principal for a specific period for an investment based on
periodic, constant payments and a constant interest rate. Make sure the units used by
R and NP are consistent. For example, for a 5-year loan with 12% annual interest, if
you make payment monthly, use 12%/12 for R and 512 for NP. If you make annual
payment on the same loan, use 12% for R and 5 for NP.

Parameters
R interest rate per period

P the period for which the interest will be calculated

NP the total number of payment periods

PV present value of the investment

FV future value or a cash balance you would like to attain at the end of the
last period

T (Optional) timing of the payment:

0 payment is made at the end of the period

1 payment is made at the beginning of the period

Example
PPMT(10%/12, 1, 60, 55000, 0, 0) = 710.2541

PPMT(10%/12, 1, 60, 55000, 1000) = 723.1678
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PV(P, R, N)

Description
Returns the present value of an annuity. The function is given by:

Parameters
P periodic payment

R interest range

N number of periods

Example
PV(360, C5, 4) = 1116.88, where C5 = 11%

PV(V10, C6, 5) = 41001.97, where C6 = 7% and V10 = 10000

PV(4500, 0.05, -1) = Error! (Period must be greater than 0

RATE(FV, PV, N)

Description
Returns the interest rate required to go from present value PV to future value FV in
N compounding periods. The formula used is:

Parameters
FV future value of the investment

PV present value of the investment

N number of periods

Example
RATE(5000, 3000, 10) = .05

RATE(H8, G8, B6) = .149, where B6 = 5, G8 = $5,000.00, and H8 = $10,000.00

RATE(8700, -1000, 3) = Error! (PV and FV must have the same sign)
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SYD(C, S, L, P)

Description
Returns the ``sum-of-years-digits’’ depreciation allowance. The function is given by:

Parameters
C cost

S salvage value

L allowable life

P the period for which the depreciation allowance is being calculated

Example
SYD(5000, 1500, 15, 14) = 58.333

SYD(S10, S9, 20, 2) = 9.048, where S9 = 400 and S10 = 500

SYD(2500, 750, 0, 5) = Error! (Life must be greater than 0)

TERM(P, R, FV)

Description
Returns the number of payment periods for an investment. The function is given by:

Parameters
P amount of periodic payments

R interest rate

FV future value of the investment

Example
TERM(1050, 0.105, 300000) = 34.39

TERM(R13, S18, S19) = 16.48, where R13 = 360, S19 = 15000, and S18 = 11%

TERM(100, 0.095, -1) = Error! (PV and FV must have the same sign)
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VDB(C, S, L, S, E)

Description
Returns the depreciation of an asset between two specific periods using the
fixed-declining balance method.

Parameters
C the initial cost of the asset

S salvage value (the value at the end of the depreciation)

L life (the total number of periods over which the asset is being depreciated)

S start period (first period in the calculation)

E end period (last period in the calculation)

Example
VDB(10000, 500, 120, 2, 4) = 319.6289

XIRR(G, V, D)

Description
Returns the internal rate of return for a series of cash flows with variable intervals . V
and D must be one-dimensional ranges and have the same size.

Parameters
G A guessed value of the result

V A range containing a series of cash flows

D A range containing the dates of cash flows in V

Example
0 A B

1 02/01/91 -12000

2 05/01/91 2800
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3 10/01/91 3250

4 02/01/92 4460

5 04/01/92 5000

XIRR(0.5, B1..B5, A1..A5) = 0.3632

XNPV(R, V, D)

Description
Returns the net present value for a series of cash flows with variable intervals. V and
D must be one-dimensional ranges and have the same size.

Parameters
R Discount rate to apply to the cash flows

V A range containing a series of cash flows

D A range containing the dates of cash flows in V

Example
0 A B

1 01/10/91 -12000

2 04/01/91 3000

3 09/30/91 4150

4 01/10/92 3300

5 04/01/92 3150

XNPV(9.00%, B1..B5, A1..A5) = 705.1677

YIELD(S, M, R, PR, RD, F[, B])

Description
Returns the yield at maturity of a security that pays periodic interest. All dates must
be entered as serial date value.
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Parameters
S settlement date

M maturity date

R annual coupon rate of the security

PR the price of the security per $100 face value

RD redemption value of the security at maturity per $100 face value

F the number of coupon payments per year

B (Optional) the day count basis to be used:

0 or omitted 30/360
1 Actual/actual
2 Actual/360
3 Actual/365

Example
YIELD(DATE(91, 3, 15), DATE(98, 10, 15), 6%, 94.1854, 100, 2, 0) = 0.07

YIELDMAT(S, M, I, R, PR[, B])

Description
Returns the annual yield of a security which pays interest at maturity. All dates must
be expressed as serial date values.

Parameters
S settlement date

M maturity date

I issue date

R interest rate at date of issue

PR the price of the security per $100 face value

B (Optional) the day count basis to be used:
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0 or omitted 30/360
1 Actual/actual
2 Actual/360
3 Actual/365

Example
YIELDMAT(DATE(93, 3, 1), DATE(93, 10, 1), DATE(92, 11, 5), 6.5%, 99.875, 0) =
0.06585

Statistical Functions

AVG(argumentlist)

Description
Returns the average (arithmetic mean) of its arguments. Blank cells and strings are
ignored. The function is given by:

Parameters
argumentlist

Any combination of numbers, cells, or ranges

Example
AVG(A1, B9, J32, F16) = 21.125, where A1 = 12, B9 = 34.5, J32 = 22, F16 = 16

AVG(A1, A12..H13, 111+32) = 135.67, where we don’t really care what is in those
variables, but which shows that you can use numbers, cell ranges, and expressions all
together as arguments for AVG.

AVG(A1, A12..H13, 111+32) = 135.67, where we don’t really care what is in those
variables, but which shows that you can use Named Ranges as arguments for AVG.

COUNT(argumentlist)

Description
This function returns a count of its non-blank arguments. Cells that contain strings
are counted.
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Parameters
argumentlist

Any combination of numbers, cells, or ranges

Example
COUNT(``Tom’’, ``Bob’’, ``Sue’’, ``Mary’’, ``Zack’’, ``Ann’’) = 6

COUNT(D4..D8) = 3, where D4 is empty, D5 = 1, D6 is empty, D7 = 0, and D8 = 5

COUNT(NAMES) = 30, where cells E5..J10 are a Named Range and contain 36 cells;
therefore 6 cells are blank

FORECAST(X’, X, Y)

Description
This function returns the forecast for a value based on the relationship trends
represented in the existing data provided. The formula is given by:

Parameters
X’ Value to be forecast

X Value

Y Forecast of x value

Example
0 A B

1 10 20

2 20 40

3 30 60

4 40 80

FORECAST(50, A1..A4, B1..B4) = 100

FORECAST(60, A1..A4, B1..B4) = 120
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FORECAST(30, A1..A2, B1..B2) = Error! (X' and Y ranges must contain at least 3
values)

LARGE(R, N)

Description
This function returns the Nth largest datum in the range R.

Parameters
R Range of data

N Integer specifying Nth largest datum from R

Example
A1..A9 = 1, 4, 8, 3, 7, 12, 54, 8, 23

LARGE(A1..A9, 3) = 12

LARGE(A1..A9, 1) = 54

LARGE(A1..A9, COUNT(A1..A7)) = 4

MAX(argumentlist)

Description
This function returns the maximum of its arguments. Blank cells and cells containing
strings are not counted.

Parameters
argumentlist

Any combination or numbers, cells, or ranges

Example
MAX(4, 56, 33, 100, 0, -1) = 100

MAX(S3..S7) = -1, where S3..S7 = -1, -4, -99, -20, -1.5

MAX(A1..B2) = 93, where A1 = 0, A2 = -93, B1 = 93, and B2 = 7
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MEDIAN(argumentlist)

Description
This function returns the median (middle value) of its arguments. Blank cells and
cells containing strings are not counted.

Parameters
argumentlist

Any combination or numbers, cells or ranges

Example
MEDIAN(A1..A6) = 80.5, where A1..A6 = 65, 70, 74, 87, 88, 95

MEDIAN(2, 8, 6, 5, 9) = 6

MIN(argumentlist)

Description
This function returns the minimum of its arguments. Blank cells and cells containing
strings are not counted.

Parameters
argumentlist

Any combination or numbers, cells or ranges

Example
MIN(4, 56, 33, 100, 0, -1) = -1

MIN(S3..S7) = -99, where S3..S7 = -1, -4, -99, -20, -1.5

MIN(A1..B2) = -93, where A1 = 0, A2 = -93, B1 = 93, and B2 = 7
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MODE(argumentlist)

Description
This function returns the mode, or most frequently occurring datum, of all the
arguments. Empty cells and cells containing text are ignored.

Parameters
argumentlist

Any combination of numbers, cells, or ranges

Example
MODE(5, 4, 10, 8, 7, 5, 4, 14, 5) = 5

MODE(A1..A7) = 2.3, where A1..A7 = 2.3, 3.4, 5.0, 3.4, 3.4, 2.3, 2.3

PERCENTILE(R, N)

Description
This function returns the datum from the range R which is at the Nth percentile in R.
Only numeric data in R are considered. The result will be interpolated if N is not a
multiple of 1/(s-1), where s is the size of R.

Parameters
R A range of data

N A numeric value between 0 and 1, inclusive

Example
PERCENTILE(A1..A4, 0.65) = 2.95, where A1..A4 = 1, 2, 3, 4

PERCENTILE(B1..B6, 0.75) = 20.25, where B1..B6 = 3.8, 23, 4, 12, 67, 0.2
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PERCENTRANK(R, N)

Description
This function returns the percentile rank of the number N among the values in range
R.

Parameters
R A range of data

N A number for which the percentile rank is to be found

Example
PERCENTRANK(A1..A6, 4.5) = 0.7, where A1..A6 = 1, 2, 3, 4, 5, 6

PERCENTRANK(B1..B6, 21.35) = 0.77, where B1..B6 = 3.8, 23, 4, 12, 67, 0.2

QUARTILE(R, Q)

Description
Finds the quartile of the data provided in the range. This is equivalent to
PERCENTILE®, Q/4).

Parameters
R Range of cells

Q Quartile as follows:

0 Minimum value
1 First quartile (25th percentile)
2 Second quartile (50th percentile)
3 Third quartile (75th percentile)
4 Maximum value

Example
A1..A8 = 1, 2, 4, 7, 8, 9, 10, 12

QUARTILE(A1..A8, 2) = 7.5

QUARTILE(A1..A8, 1) = 3.5
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RANK(E, R, [O])

Description
Returns the rank of a numeric argument E in the range R based on order O. If O is
non-zero, the rank is equal to the position of the element if the list were sorted in
ascending order; but if O is zero or omitted, the rank is equal to the position of the
element if the list were sorted in descending order. Blanks and text are ignored.
Duplicate numbers will have the same rank.

Parameters
E Numeric value for which you wish to determine its rank

R Range of cells containing data to rank

O Order of rank as follows:

0 or omitted Ascending
Non-zero Descending

Example
A1..A8 = 5, 7, 5, 2, 8, 1, 9, 10

RANK(7, A1..A8) = 4

RANK(7, A1..A8, 1) = 5

SMALL(R, N)

Description
Returns the Nth smallest number in the data range. Cells containing blanks or text
are ignored.

Parameters
R range of cells containing the numerical data

N the nth position from the smallest in the range specified
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Example
A1..A9 = 1, 4, 8, 3, 7, 12, 54, 8, 23

SMALL(A1..A9, 3) = 4

SMALL(A1..A9, 1) = 1

SMALL(A1..A9, COUNT(A1..A7)) = 12

TREND(NX, KX, KY)

Description
Fits a straight line to KX (known x’s) and KY (known y’s) using least square method,
and then returns the y values along the line for NX (new x’s).

Parameters
NX range for new x values for which TREND will return corresponding y values

KX known x values

KY known y values

Example
A B C

1 8

2 9

3 10

…

10 X values Y values

11 1 242

12 2 256

13 3 263

14 4 274

Function List

Page 6-230 Adagio Financial Reporter



15 5 279

16 6 285

17 7 290

TREND(A1..A2, B11..B17, C11..C17) = 301

308.7857

316.5714

Reference Functions

CELLREF(N1, N2)

Description
This function returns a reference to the cell whose column index is N1 and whose
row index is N2. Column indices start with 0, so the column index for column A is 0,
B is 1, etc. Row indices are the same as the row number, and therefore start with 1.

CELLREF columns are zero-based. That is column A is column 0, B
is 1 etc. Rows are the same as displayed on the row header.

Parameters
N1 A numeric value

N2 A numeric value

Example
CELLREF(3, 1) = -80, where D1 = -80

CELLREF(27, 34) = 2400, where AA34 = 2400

CELLREF(4, 8) = 100.00, where E8 = 100.00
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CHOOSE(N, argumentlist)

Description
This function returns the Nth argument from the argument list, starting with an
index of 0.

Parameters
N A numeric value which should be less than or equal to the number of

items in argumentlist - 1

argumentlist

Any combination of numbers, strings, or cell addresses separated by commas.

Example
CHOOSE(2, D1, C22, F5, K1) = 54, where F5= 54

CHOOSE(1, A9, D23, G12) = ``Peaches’’, where D23 = ``Peaches’’

CHOOSE(3, ``nuts’’, ``rings’’, ``bolts’’, ``fittings’’) = ``fittings’’

COL(C)

Description
This function returns the column index of the cell referenced by C, or the leftmost
column if C is a range, or the column in which the formula appears if C is omitted.

Parameters
C A cell or range (optional)

Example
COL(A1) = 0

COL(F10..G19) = 5

COL() = 25, where COL is in cell Z20.
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COLS(R)

Description
This function returns the number of columns in the specified range.

Parameters
R A range

Example
COLS(A1..J1) = 10

HLOOKUP(X, R, N)

Description
This function returns the value of a cell found by performing a horizontal table
lookup. HLOOKUP searches the first row (known as the index row) in the range R
for the numeric or string value which ``matches’’ X, and returns the value N rows
beneath the matching cell. If X is a string value, an exact match must be found or an
error is returned.

If X is a numeric value, the index row must contain numeric values, sorted in
ascending order, and the matching column is determined by the following rules:

1. Strings and blank cells in the index row are ignored.
2. If the first value in the index row is greater than X, an error is returned.
3. Searching stops when a numeric value which is greater than or equal to X is found
in the index row. If the value found is greater than X, the preceding column is the
matching column.
4. If there are no numeric values in the index row which are greater than or equal to
X, the last column in R is considered to be the matching column.

Parameters
X A numeric or string value

R A range

N A numeric value
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Example
0 A B C D

1 Lodging Meals Airfare Entertainment

2 $85.00 $30.00 $698.00 $25.00

HLOOKUP("Meals", A1..D2, 1) = 30

HLOOKUP(" Airfare", A1..D2, 1) = Error! (HLOOKUP, lookup failed to produce a
match)

HLOOKUP("Airfare", A1..D2, 3) = Error! (HLOOKUP, row offset out of range)

MATCH(V, R[, T])

Description
This function returns the relative position of the value V in the range R, according to
the rule specified by T:
1 find largest value in R <= V
0 or omitted find first value in R = V
-1 find smallest value in R = V

V can be a string or a numeric value. If V is a string, T must be 0 or omitted. If V is a
string, it may contain the wildcard characters of asterisk (*) and question mark (?) to
represent any sequence of characters and any single character respectively.

Parameters
V Value to be matched

R Range in which to match V

T Type of match

Example
0 A B

1 Products Quantity (Boxes)

2 Apple 32

3 Orange 50
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4 Cherry 15

5 Banana 20

6 Cantaloup 10

7 Strawberry 25

MATCH(15, B1..B7) = 3

MATCH(30, B1..B7, 1) = 6

MATCH(30, B1..B7, -1) = 1

MATCH(``Orange’’, A1..A7) = 2

MATCH(``Can’’, A1..A7) = 5

QUERYSHEET(S, C [, F [, D [, Y (, U)

Description
Returns the contents of the cell reference C from the sheet S calculated for the Fiscal
Period F using Department D in Fiscal Year Y and, if Update U is non zerio, sets
sheet S to the optional parameters. If the optional parameters, fiscal period,
department and fiscal year, are not passed, then the current contents of the cell are
returned. You cannot use this function to reference a cell on the same sheet. If a
Named Range is used, the value from the top left cell in the Named Range is
returned. If .AutoUpdate does not exist in cell A2, you can use the U parameter to
pass the fiscal period, department and fiscal year information in the toolbar to the
value reported in target sheet that uses the QUERYSHEET formula.

If [ U] used, then all preceding parameters must exist.

Parameters
S Sheet name

C Cell reference or Named Range

F Optional fiscal period

D Optional Department (if used then the Fiscal Period must also be used)
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Y Optional fiscal Year (if used then the Fiscal Period and Department must also be
used; values are 0 for current year in fiscal dropdown, 1 for the next year in the
dropdown, 2 for the third year in the dropdown, etc.)

U Optional Update (if 1 or non-zerio, causes destination sheet, i.e. the sheet
containing the QUERYSHEET formula) to be set to the fiscal period, department and
year parameters that were passed into it) NOTE: AutoUpdate must not exist in A2
if you want to use the U parameter to pass the optional values.

Example
Use Recalculate (F9) to refresh the active sheet or Recalculate All
(Ctrl/F9) to refresh all sheets in the workbook.

Sheet 2 Cell A10 contains 99

If a cell in Sheet 1 has =QuerySheet(“Sheet 2”,”A10”) then 99 will be returned.

Sheet 2 Cell A10 has =ADGET(“GLDATA.Bal” ,1000) = 345.67

If a cell in Sheet 1 has =QuerySheet(“Sheet 2”,”A10”, ) then the numeric value 345.67
will be returned.

If a cell in Sheet 1 has =QuerySheet(“Sheet 2”,”A10”,3,”100” ) then Sheet 2 will be
recalculated for Fiscal Period 3, Department 100 and the resulting value will be
returned.

If a cell in Sheet 1 has =QuerySheet(“Sheet 2”,”A10”,3,”100”,1 ) then Sheet 2 will be
recalculated for Fiscal Period 3, Department 100 and the 2nd fiscal year in the
dropdown, and the resulting value will be returned. i.e. The cell value is returned
calculated as of the optional parameters; the sheet itself remains unchanged.

If a cell in Sheet 1 has =QuerySheet(“Sheet 2”,”A10”,3,”100”,1,1) then Sheet 2 will be
recalculated for Fiscal Period 3, Department 100 and the 2nd fiscal year in the
dropdown, and the resulting value will be returned. If Sheet 2 did not have
.AutoUpdate in A2, then it will be set to the optional parameters passed. i.e. The
sheet is recalculated based on .AutoUpdate or the optional parameters.

RANGEREF(N1, N2, N3, N4)

Description
Returns a reference to the range described by corner coordinates N1, N2, N3, and N4.
Row index must be relative to 1; column index must be relative to 0.
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Parameters
1 the upper left column index of the range

2 the upper left row index of the range

3 the lower right column index of the range

4 the lower right row index of the range

Example
SUM(RANGEREF(0, 1, 0, 2)) is equivalent to SUM(A1..A2)

AVG(RANGEREF(1, 1, 25, 10)) is equivalent to AVG(B1..Z10)

ROW(C)

Description
Returns the row index of the cell referenced by C, or the top row if C is a range. If C
is omitted, the index of the current row will be returned.

Parameters
C A cell or range (optional)

Example
ROW(G42) = 42

ROW(T10..V25) = 10

ROW() = 3, where ROW is in cell B3.

ROWS(R)

Description
Returns the number of rows in the specified range.
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Parameters
R A range

Example
ROWS(C4..C13) = 10

VLOOKUP(X, R, N)

Description
Searches the first column (known as the index column) in range for the numeric or
string value which ``matches’’ X, and returns the value N columns to the right in the
row where the match is found. The index column is searched from top to bottom. If
the column contains numeric values, they must be in ascending order and cannot
contain an empty cell.

If X is a string value, an exact match must be found or an error is returned.

If X is a numeric value, the matching row is determined by the following rules:
1. Strings and blank cells in the index column are ignored.
2. If the first value in the index column is greater than X, an error is returned.
3. Searching stops when a numeric value which is greater than or equal to X is

found in the index column. If the value found is greater than X, the preceding
row is the matching row.

Parameters
X A numeric or string value

R A range

N A numeric value

Example
0 A B

1 Lodging $85.00

2 Meals $30.00

3 Airfare $698.00

4 Entertainment $25.00
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VLOOKUP(``Meals’’, A1..B4, 1) = 30

VLOOKUP(``Airfar’’, A1..B4, 1)) = Error! (lookup failed to produce a match)

VLOOKUP(``Airfare’’, A1..B4, 2)) = Error! (column out of range)

Logical Functions

AND(argumentlist)

Description
This function returns 1 if all arguments are 1; 0 if any argument is 0; otherwise -1
(unknown).

Parameters
argumentlist

Any combination of numbers, cells, or ranges

Example
A1=1, B1=1, C1=0, D1=0, E1=1 and A2=24

AND(A1, B1) = 1

AND(A1..E1) = 0

AND(A1..A2) = -1

FALSE( )

Description
This function returns 0.

Example
FALSE( ) = 0

IF(B17 == 0, TRUE( ), FALSE( )) = 1, where B17 is not equal to 0
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IF(X, T, F)

Description
This function returns the value of T if X evaluates to non-zero, or F if X evaluates to
zero. This function is included only for compatibility with other spreadsheets.

Parameters
X A numeric value

T A value

F A value

Example
IF(A1, 7, 9) = 7, where A1 = 1

IF(B17==0, 0, ``non-zero’’) = ``non-zero’’, where B17 = 1

NAND(argumentlist)

Description
This function returns 0 if all arguments are 1; 1 if any argument is 0; otherwise -1
(unknown).

Parameters
argumentlist

Any combination or numbers, cell, or ranges

Example
A1 = 1, B1 = 1, C1 = 0, D1 = 0, E1 = 1 and A2 = 24

NAND(A1, B1) = 0

NAND(A1..E1) = 1

NAND(A1..A2) = -1
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NOR(argumentlist)

Description
This function returns 0 if any argument is 1; 1 if all arguments are 0; otherwise -1
(unknown).

Parameters
argumentlist

Any combination of numbers, cells, or ranges

Example
A1 = 1, B1 = 1, C1 = 0, D1 = 0, E1 = 1 and A2 = 24

NOR(C1, D1) = 1

NOR(A1..E1) = 0

NOR(A2..A2) = -1

NOT(X)

Description
This function returns 1 if X=0; 0 if X=1; otherwise -1 (unknown).

Parameters
X A numeric value

Example
A1 = 1, B1 = 1, C1 = 0, D1 = 0, E1 = 1 and A2 = 24

NOT(A1) = 0

NOT(A2) = -1

NOT(C1) = 1
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OR(argumentlist)

Description
This function returns 1 if any argument is 1; 0 if all arguments are 0; otherwise -1
(unknown).

Parameters
argumentlist

Any combination of numbers, cells or ranges

Example
A1 = 1, B1 = 1, C1 = 0, D1 = 0, E1 = 1 and A2 = 24

OR(C1, D1) = 0

OR(A1..E1) = 1

OR(A2..A2) = -1

TRUE( )

Description
Returns the value 1.

Example
TRUE( ) = 1

IF(B17 == 0, TRUE( ), FALSE( )) = 1, where B17 is 0

XOR(argumentlist)

Description
Returns -1 if any argument is not 0 or 1; otherwise 1 if the total number of arguments
with the value 1 is odd; 0 if the total number of arguments with the value 1 is even.
Text and blank cells are ignored.
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Parameters
argumentlist

Any combination of numbers, cells, or ranges

Example
A1 = 1, B1 = 1, C1 = 0, D1 = 0, E1 = 1 and A2 = 24

XOR(A1, B1) = 0

XOR(A1..E1) = 1

XOR(A1..E2) = -1

Information Functions

ISERROR(X)

Description
This function returns 1 if X ``contains’’ an error, otherwise it returns 0. X ``contains’’
an error if it would generate an error outside of the ISERROR function, which means
that the expression itself may generate an error, or it may reference a cell which has
generated an error.

Parameters
X An expression

Example
ISERROR(1) = 0

ISERROR(3/0) = 1

ISERROR(ISERROR(3/0)) = 0

ISERROR(C1) = 0, where C1 = PI
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ISEXPANDED(S)

Description
Returns a 0 if the specification is Collapsed (false) or a 1 if it is Expanded (true). Or,
include the function as part of an IF formula to have it return a different string
depending on whether the result is true or not.

Use this function to confirm whether or not the specification sheet you are viewing or
printing is in its Expanded or Collapsed format. Generally, Expanded statements
will show more account-department detail than a Collapsed statement does. You
should always edit your specifications when they are in Collapsed mode.

Parameters
S A string indicating the sheet in the specification being checked

Example
ISEXPANDED("BalanceSheet")

IF(ISEXPANDED("3 year P&&L comparison"),"Expanded","Collapsed")

ISNUMBER(X)

Description
This function returns 1 if X is a numeric value, otherwise 0. Blank cells are considered
numeric.

Parameters
X A numeric value

Example
ISNUMBER(C10) = 0, where C10 = ``Total’’

ISNUMBER(D10) = 1, where D10 = $1000.00

ISNUMBER(A1) = 1, where A1 is blank
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ISSTRING(X)

Description
This function returns 1 if X is a string value, otherwise 0. Blank cells are considered
numeric.

Parameters
X A numeric value

Example
ISSTRING(C10) = 1, where C10 = ``Total’’

ISSTRING(D10) = 0, where D10 = $1000.00

ISSTRING(A1)= 0, where A1 is blank

N(R)

Description
This function returns the numeric value of the upper left cell in the range R, or zero if
the cell is blank or contains a label. This function is included only for compatibility
with older spreadsheets.

Parameters
R A range

Example
A1..B3 =

0 A B

1 1 ``electrons’’

2 2 ``protons’’

3 3 ``neutrons’’
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N(A1..B3) = 1

N(B1..B3) = 0

N(A1..Z25) = $1,000,000.00, where A1 = $1,000,000.00

S(R)

Description
Returns the string value of the top left cell in range R, or a null string (" ") if the cell is
blank or contains a numeric value.

Parameters
R A range

Example
A1..B3 =

0 A B

1 1 electrons

2 2 protons

3 3 neutrons

S(A1..B3) = " "

S(B1..B3) = ``electrons’’

S(A1..Z25) = " ", where A2 = $1,000,000.00

USERINITIAL()

Description
This function returns the initials of the user who last Recalculated (F9) this
worksheet.
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USERNAME()

Description
This function returns the name of the user who last Recalculated (F9) this worksheet.

Database Functions

TSV(Range)

Description
Accepts a range and produces tab delimited output. Each column will be separated
with a \t (tab) and each row with a \n (new line) character.

Parameters
Range

Any range in the grid

Example
0 A B

1 1 2

2 3 4

TSV(A1..B2) will return “1\t\2\n3\t\4\n”
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Formula Summary

Formula Description

Adagio Database =Formulas
ACCOUNTGROUP(string1[,string2

[,...string]])
ACCOUNTGROUPDEPT(string1

[,string2[,...string]])

These functions return the range of accounts specified
in the range located by matching the heading entries.
They take a sequence of text strings as arguments and
return the account range from the Account Group tree
that matches the text arguments.

ACCOUNTGROUPDEPT() returns the range of
accounts with the departmental place holder (`).

ACCOUNTGROUP() just returns the account range.

ADAVERAGE(“gldata.bal”,"range
expression")

Returns the total of field in the records in record range,
in the database indicated by link.

ADCREDIT(“gldata.SYMBOL”,"range
expression")

Totals the values in field with record range, if field
contains numbers

ADCRONLY(“gldata.SYMBOL”,"range
expression")

Similar to the =ADCREDIT but returns on the sum of
the credit amounts in the range.

ADDRESS1( ) Company address from global file

ADDRESS2( ) Company address from global file

ADDRESS3( ) Company address from global file

ADDRESS4( ) Company address from global file

ADDEBIT(“gldata.SYMBOL”,"range
expression")

Totals the values in field within record range, if field
contains numbers.

ADDRONLY(“gldata.SYMBOL”,"range
expression")

Similar to the =ADDEBIT but returns on the sum of the
debit amounts in the range.

ADGET(“gldata.SYMBOL”,"range
expression")

Returns the contents of field in the records in record
range, in the database indicated by link.

ADGETF(“gldata.SYMBOL”,"range
expression")

For dates and strings, returns the first value located in
a range of accounts.

ADMAX(“gldata.SYMBOL”,"range
expression")

Returns the largest value of field in record range.
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Formula Description
ADMIN(“gldata.SYMBOL”,"range
expression")

Returns the smallest value of field in record range.

ADSELECT(“range expression",
”criteria”)

When used in a .Range row, builds a record range that
can be referenced from other cells.

CONAME( ) Company name from global file.

CURRENTFISCALYEAR() Returns the fiscal year code for the 'current' fiscal year
(eg. 2013-)

DEPARTMENT(n) where n = 0 for code,
1 for description

Department from global file.

FAX( ) Company fax number from the company profile.

FPERIOD( ) Returns the current fiscal period

FPRIOR(n) -26 +26 n= 0 is the current
fiscal period code

Returns a code for the fiscal period

FYEAR() Returns the fiscal year based on the year displayed in
the dropdown.

GLAMT({Acct Data Token}, {Account
Range})

Retrieves GL amounts for the data field and account
range you choose. For ColSpec reports only.

GLCREDIT({Acct Data Token}, {Account
Range})

Retrieves GL amounts for the data field and account
range you choose, returning absolute value of total if it
is a credit amount, or 0 if it is a debit amount. For
ColSpec reports only.

GLCRONLY({Acct Data Token},
{Account Range})

Retrieves GL credit amounts for the data field and
account range you choose. For ColSpec reports only.

GLDEBIT({Acct Data Token}, {Account
Range})

Retrieves GL amounts for the data field and account
range you choose, returning absolute value of total if it
is a debit amount, or 0 if it is a debit amount. For
ColSpec reports only.

GLDESC (“Default Text”, {Indent}) Inserts a default description of the account range that
appears in column B. For ColSpec reports only.

GLDRONLY({Acct Data Token},
{Account Range})

Retrieves GL debit amounts for the data field and
account range you choose. For ColSpec reports only.
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Formula Description
GLFPE ({Acct Data Token}) Inserts the fiscal period ending date that corresponds

to the data field specified in the .ColSpec row above.
For ColSpec reports only.

GLFPS ({Acct Data Token}) Inserts the fiscal period starting date that corresponds
to the data field specified in the .ColSpec row above.
For ColSpec reports only.

GLSTR({Acct Data Token},{Account
Range})

Use this function to retrieve GL optional fields for the
data field and account range you choose.

GLTITLE() Use this function to retrieve GL titles as defined in the
cell referenced (eg. in .ColSpec row).

GLUPDATE({Acct Data Token},{Account
Range}, X)

Use this function to write new budget and/or forecast
values in Adagio Ledger for the 'current' fiscal year.

NOTE: If Next Year is open, the 'current' fiscal year is the
Next Year.

NOTE: GLUPDATE is always enabled and for all years in
FX9.0A.

NEXTCREATED() Returns 1=True or 0=False depending whether the
Next Fiscal Year has been created or not.

NEXTFISCALYEAR() Returns the fiscal year code for the 'next' fiscal year
(eg. 2014-), assuming this fiscal calendar has been
created.

PHONE( ) Company phone number from the company profile.

POSTCODE( ) Company postal code from the company profile.

PRIORFISCALYEAR() Returns the fiscal year code for the 'prior' fiscal year
(eg. 2012-)

QLFUNC Generates rows of information based on a specified
record range. Used in import only.

RERR Sums the rounding errors in field within record range, if
field contains numbers. Used in import only.

RNGMERGE Creates a list of all possible combinations of accounts
and departments, where the accounts and departments
are stored in separate cells.
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Formula Description
ZIP( ) Company zip code from the company profile.

Date/Time Formulas
DATE(Y, M, D) This function returns the date value corresponding to

year Y+1900, month M, and date D. Y must be in the
range 0 to 199 (representing 1900-2099).

DATESTRING() This function formats dates in your financial
statements according to your needs.

DATEVALUE(S) This function returns the corresponding date value for
a given string S

DAY(DT) This function returns the day of the month component
of the date/time value DT.

DAYS360(S, E) This function returns the number of days between two
dates, based on a 30/360 Day Count Basis
(30-day-per-month, 360-day year.)

EDATE(S, M) This function returns a date/time value representing
the date M months after S if M is positive, and M
months previous to S if M is negative. The date
returned will be on the same day of the month as S.

EOMONTH(S, M) A date/time value representing the date M months
after S, if M is positive, and M months before S, if M is
negative. The date returned will be on the last day of
the month.

HOUR(DT) This function returns the hours (0 - 23, where 0
represents midnight) component of the date/time
value DT.

MINUTE(DT) This function returns the minutes (0 to 60) component
of the date/time value DT.

MONTH(DT) This function returns the months component of the
date/time value DT.

NETWORKDAYS(S, E, H) This function returns the number of whole working
days, beginning with S and ending with E, excluding
days in H and weekends.
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Formula Description
NOW( ) This function returns the date and, depending how it

is used, time value corresponding to the current
system date and time.

SECOND(DT) Returns the seconds (0 to 59) component of date/time
value DT.

TIME(H, M, S) Returns the time value represented as a fraction of a
day, starting at midnight.

TIMEVALUE(S) Returns the corresponding time value for a given
string value S.

TODAY( ) Returns the date value corresponding to the current
system date.

WEEKDAY(D) Returns an integer representing the day of the week on
which the day D falls. 1 is Sunday, 7 is Saturday.

WORKDAY(S, D[, H]) Returns the serial day value that is D working days
after day S (if D is positive) or D working days before
day S (if D is negative), excluding weekends and all
holidays specified as dates in range H.

YEAR(DT) Returns the years component of the date/time value
DT, where 1900 = 0.

YEARFRAC(S, E[, B]) Returns the year fraction representing the number of
whole days between S (start date) and E (end date).
This function is useful in calculating the percent of
benefit or obligation to assign a specific period.

Mathematical Formulas
ABS(X) This function returns the absolute (positive) value of X.

CEIL(X) This function returns the smallest integer that is
greater than or equal to X.

FLOOR(X) This function returns the largest integer less than or
equal to X.

FRAC(X) This function returns the fractional portion of X.

INT(X) This function returns the integer portion of X.
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Formula Description
MOD(X, Y) This function returns the remainder of X/Y with the

same sign as X.

MODULUS(X, Y) This function returns the modulus of X/Y.

PI( ) This function returns the value of the mathematical
symbol PI.

PRODUCT(argumentlist) Multiplies all the numeric elements of the argument
list together, ignoring empty and non-numeric values,
and returns the product.

ROUND(X, N) Returns X rounded to the number of decimal places
specified by N (when N is positive); it returns X
rounded to a whole number when N is negative.

SQRT(X) Returns the positive square root of X.

SUM(argumentlist) Returns the sum of its arguments. Blank cells and cells
containing strings are not counted.

VSUM(argumentlist) Returns the ``visual sum’’ of its arguments. This
function differs from SUM in that it uses the precision
and rounding of the actual formatted values appearing
in the cells instead of the internal double-precision
value of the cell.

Text Formulas
CHAR(N) This function returns the character represented by the

ASCII code N.

CLEAN(S) This function returns the string formed by removing
all non-printing characters from the string S.

CODE(S) This function returns the ASCII code for the first
character in string S.

CONCATENATE(argumentlist) Returns the concatenation of all its arguments. For cell
arguments, the actual formatted contents of the cell are
used, even if the cell contains a numeric value. This is
the same as STRCAT(argumentlist)

EXACT(S1, S2) This function returns 1 if string S1 exactly matches
string S2; returns 0 otherwise.
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Formula Description
FIND(S1, S2, N) This function returns the index of the first occurrence

of string S1 in string S2, starting the search at position
N in string S2. Note that the string index always starts
with 1.

LEFT(S, N) This function returns the string composed of the
leftmost characters of string S.

LENGTH(S) This function returns the number of characters in
string S.

LOWER(S) This function returns the alphabetic string S converted
to lower-case characters.

MID(S, N1, N2) This function returns the string of length N2 that starts
at position N1 in string S.

PROPER(S) Returns the string S with the first letter of each word
capitalized.

REGEX(S1, S2) Returns True (1) if the string S2 matches the pattern
specified by the regular expression in string S1, and
False (0) otherwise.

REPEAT(S, N) Returns the string S repeated N times.

REPLACE(S1, N1, N2, S2) Returns the string formed by replacing the N2
characters starting at position N1 in string S1 with
string S2.

RIGHT(S, N) Returns the string composed of the rightmost N
characters of S. If N is greater than or equal to the
length of S, then the entire string S is returned.

STRCAT(argumentlist) Returns the concatenation of all its arguments. For cell
arguments, the actual formatted contents of the cell are
used, even if the cell contains a numeric value.

STRING(X, N) Returns the string representing the numeric value of X,
formatted to N decimal places, where N is in the range
0 to 15. The results are rounded.

STRLEN(argumentlist) Returns the total length of all the strings in its
argument list.
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Formula Description
TOWORDS(S(N [,I]) Returns the text string representing the numeric value

of N. If the optional parameter is a not passed or is
zero then the value is interpreted as a number,
otherwise it is interpreted as a currency field.

TRIM(S) Returns the string formed by removing leading,
trailing and consecutive embedded spaces from string
S.

UPPER(S) Returns the string S converted to uppercase characters.

VALUE(S) Returns the numeric value represented by string S, or 0
if S does not represent A number.

Financial Formulas
ACCRINT(I, Ft, S, R, P, F [, B]) This function returns the accrued interest for a security

that pays periodic interest.

ACCRINTM(I, S, R, P [, B]) This function returns the accrued interest for a security
that pays interest at maturity.

CTERM(R, FV, PV) This function calculates the number of compounding
periods required for an investment of PV to reach a
value of FV at the given interest rate R. The formula is
given by:

CUMIPMT(R, N, P, S, E, T) This function returns the cumulative interest paid
between S (the start) and E (the end) on a loan.

CUMPRINC(R, N, P, S, E, T) This function returns the cumulative principal paid
between S (the start) and E (the end) on a loan.

DB(C, S, L, N, M) This function returns the fixed-declining real
depreciation of an asset for a specified period.

DDB(C, S, L, P) This function returns the double-declining
depreciation allowance given cost C, salvage value S,
allowable life L, and N number of depreciation
periods.

EFFECT(R, P) This function returns the effective annual interest rate.
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Formula Description
FV(P, R, N) This function returns the future value of an annuity

given periodic payment P, interest rate R, and N
number of periods. The function is given by:

FVSCHEDULE(P, R) This function returns the future value of an initial
principal after compounding by a series of interest
rates.

IPMT®, P, NP, PV, FV, [T]) This function returns the interest payment for a
specified period for an loan or investment based on
periodic, constant payments and a constant interest
rate

IRR(G, F) This function returns the internal rate of return on an
investment given a set cash flows contained in range F,
and an initial ``guess’’ G (usually 0).

MIRR(V, F, R) This function returns the Modified Internal Return
Rate for a range of periodic cash flows.

NOMINAL(R, C) This function returns the nominal annual interest rate
for an effective interest rate R and the number of
compounding periods per year C.

PMT(PV, R, N) Returns the periodic payment for a loan, given present
value PV and interest rate R.

PPMT(R, P, NP, PV, FV[, T]) Returns the payment on the principal for a specific
period for an investment based on periodic, constant
payments and a constant interest rate.

PV(P, R, N) Returns the present value of an annuity given periodic
payment P, interest rate R and N number of periods.
The function is given by:

RATE(FV, PV, N) Returns the interest rate required to go from present
value PV to future value FV in N compounding
periods.

SLN(C,S,L) Returns the straight-line depreciation allowance given
cost C, salvage value S, and allowable life L.

SYD(C, S, L, P) Returns the ``sum-of-years-digits’’ depreciation
allowance given cost C, salvage value S, allowable life
L, and depreciation period P

Formula Summary

Page 6-256 Adagio Financial Reporter



Formula Description
TERM(P, R, FV) Returns the number of payment periods for an

investment given the periodic payment P, the interest
rate R and future value FV.

VDB(C, S, L, S, E) Returns the depreciation of an asset between two
specific period using the fixed-declining balance
method.

XIRR(G, V, D) Returns the internal rate of return for a series of cash
flows (V) with variable intervals (D). V and D must be
one-dimensional ranges and have the same size.

XNPV(R, V, D) Returns the net present value for a series of cash flows
(V) with variable intervals (D). V and D must be
one-dimensional ranges and have the same size.

YIELD(S, M, R, PR, RD, F[, B]) Returns the yield at maturity of a security that pays
periodic interest. All dates must be entered as serial
date value.

YIELDMAT(S, M, I, R, PR[, B]) Returns the annual yield of a security which pays
interest at maturity.

Statistical Formulas
AVG(argumentlist) Returns the average (arithmetic mean) of its

arguments. Blank cells and strings are ignored.

COUNT(argumentlist) This function returns a count of its non-blank
arguments. Cells that contain strings are counted.

FORECAST(X’, X, Y) This function returns Y’, the predicted value for y for
X’, given original x and y values X and Y.

INIT(X1, X2) This function returns its first argument on the first
recalculation pass and its second argument on all
subsequent recalculation passes when Objective Grid
is performing iterative recalculations.

LARGE(R, N) This function returns the Nth largest datum in the
range R.

MAX(argumentlist) This function returns the maximum of its arguments.
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Formula Description
MEDIAN(argumentlist) This function returns the median (middle value) of its

arguments.

MIN(argumentlist) This function returns the minimum of its arguments.

MODE(argumentlist) This function returns the mode, or most frequently
occurring datum, of all the arguments.

PERCENTILE(R, N) This function returns the datum from the range R
which is at the Nth percentile in R. Only numeric data
in R are considered. The result will be interpolated if N
is not a multiple of 1/(s-1), where s is the size of R.

PERCENTRANK(R, N) This function returns the percentile rank of the number
N among the values in range R.

QUARTILE(R, Q) Finds the quartile Q of the data in range R. This is
equivalent to PERCENTILE®, Q/4).

RANK(E, R, [O]) Returns the rank of a numeric argument E in the range
R based on order O.

SMALL(R, N) Returns the Nth smallest number in range R. Cells
containing blanks or text are ignored.

TREND(NX, KX, KY) Fits a straight line to KX (known x’s) and KY (known
y’s) using least square method, and then returns the y
values along the line for NX (new x’s).

Reference Formulas
CELLREF(N1, N2) This function returns a reference to the cell whose

column index is N1 and whose row index is N2.

NOTE: CELLREF columns are zero-based. That is
column A is column 0, B is 1 etc. Rows are the same as
displayed on the row header.

CHOOSE(N, argumentlist) This function returns the Nth argument from the
argument list, starting with an index of 0.

COL(C) This function returns the column index of the cell
referenced by C, or the left-most column if C is a
range, or the column in which the formula appears if C
is omitted.
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Formula Description
COLS(R) This function returns the number of columns in the

specified range.

HLOOKUP(X, R, N) This function returns the value of a cell found by
performing a horizontal table lookup.

MATCH(V, R[, T]) This function returns the relative position of the value
V in the range R

QUERYSHEET(S, C [,F , [D [,Y [, U]) Returns the contents of the cell reference C from the
sheet S calculated for the Fiscal Period F using
Department D in Fiscal Year Y. If the optional
parameters, fiscal period, department and fiscal year,
are not passed then the current contents of the cell are
returned. You cannot use this function to reference a
cell on the same sheet. If a Named Range is used then
the value from the top left cell in the Named Range is
returned. If AutoUpdate does not exist in cell A2, you
can use the U parameter to pass the fiscal period,
department and fiscal year information in the toolbar
to the value reported in destination sheet that uses the
QUERYSHEET formula.

RANGEREF(N1, N2, N3, N4) Returns a reference to the range described by corner
coordinates N1, N2, N3, and N4. Row index must be
relative to 1; column index must be relative to 0.

ROW(C) Returns the row index of the cell referenced by C, or
the top row if C is a range. If C is omitted, the index of
the current row will be returned.

ROWS(R) Returns the number of rows in the specified range.

VLOOKUP(X, R, N) Searches the first column (known as the index column)
in range R for the numeric or string value which
``matches’’ X,

Logical Formulas
AND(argumentlist) This function returns 1 if all arguments are 1; 0 if any

argument is 0; otherwise -1 (unknown).

FALSE( ) This function returns 0.

IF(X, T, F) This function returns the value of T if X evaluates to
non-zero, or F if X evaluates to zero.

Formula Summary
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Formula Description
NAND(argumentlist) This function returns 0 if all arguments are 1; 1 if any

argument is 0; otherwise -1 (unknown).

NOR(argumentlist) This function returns 0 if any argument is 1; 1 if all
arguments are 0; otherwise -1 (unknown).

NOT(X) This function returns 1 if X=0; 0 if X=1; otherwise -1
(unknown).

OR(argumentlist) This function returns 1 if any argument is 1; 0 if all
arguments are 0; otherwise -1 (unknown).

TRUE( ) This function returns 1.

XOR(argumentlist) Returns -1 if any argument is not 0 or 1;

Information Formulas
ISERROR(X) This function returns 1 if X ``contains’’ an error

ISEXPANDED(S) Returns a 0 if sheet 'S' is Collapsed and a 1 if it is
Expanded.

ISNUMBER(X) This function returns 1 if X is a numeric value,
otherwise 0. Blank cells are considered numeric.

ISSTRING(X) This function returns 1 if X is a string value, otherwise
0. Blank cells are considered numeric.

N(R) This function returns the numeric value of the upper
left cell in the range R, or zero if the cell is blank or
contains a label.

S(R) Returns the string value of the top left cell in range R,
or a null string (``’’) if the cell is blank or contains a
numeric value.

USERINITIAL() Returns the initials of the user who last refreshed this
worksheet.

USERNAME() Returns the name of the user who last refreshed this
worksheet.

Database Formulas
TSV(Range) Accepts a range and produces tab delimited output



Chapter 7
Tutorial

The lessons in this tutorial provide you with the basic skills needed to use Adagio
Financial Reporter. You will learn how to create reports, use formulas, format cells,
print and save your reports.

You will need to open the Sample Data in Adagio Ledger or Adagio FX to follow this
tutorial.

Lesson 1: Getting Started

Opening sample data in Adagio

Starting Financial Reporter

Lesson 2: Creating Reports

Using account groups

Adding account groups to your report

Adding a title and the date

Printing and saving reports
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Lesson 1

Opening the Sample Data Set
Financial Reporter runs directly from within Adagio Ledger or Adagio FX. Run
Adagio Ledger or Adagio FX from the icon in the Windows start menu or on the
desktop. The Open Adagio Data dialog automatically appears. Here you can enter
your user ID, password, date, and select a dataset (Adagio Ledger file), to work with.

The default user ID is “sys” and the default password is “sys.” If these do not work,
ask your system administrator if a different user ID and password are required.

For this tutorial, you will use a sample data set that is included with Adagio.

Adagio Ledger users: Select the file “glglob.sam” located in the directory
“\Softrak\alwin\samdata”.

Adagio FX users: Select the file “afglob.sam” located in the directory
“\Softrak\afwin\samdata”.

Starting Financial Reporter
Financial Reporter has two modes. If you only want to load and print financial
reports, select Reports | Print Financial Reports from Adagio FX or Adagio Ledger’s
menu bar. If you want to create or edit reports, select Maintenance | Maintain
Financial Reports or click on the Financial button in the toolbar.

As you are about to create a new report, select Maintain Financial Reports from the
Maintenance menu now.

Lesson 1
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Lesson 2

Creating Reports
Financial Reporter works in a similar way to many popular spreadsheet programs. If
you have experience using any of these programs, you’ll find it easy to use Financial
Reporter and this tutorial will help you get started. If you do not have experience
with spreadsheet software, this lesson will give you some of the basic skills that you
will need.

Using Account Groups

To open the Account Groups window, select View | Account Groups.

The Account Groups window appears in the left part of your screen. This window
has an expanding tree list of Account Groups. Each Account Group is linked to data
from the Adagio sample data set.

To collapse or expand items in this tree list, click on the “-” signs and “+” signs.

To create a report, all you have to do is select the information you want from the
Account Groups window, then drag and drop it into a completely blank
spreadsheet.

Lesson 2
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Adding Account Groups to Your Report
The report you are about to create will be a Balance Sheet, including assets and
liabilities data for two periods, and a balance. Notice that there is already an Account
Group labeled “Balance Sheet.” This account group contains all the departments that
will be included in the balance sheet, divided into two sections: Assets and
Liabilities.

1) Right-click on Assets in your Account Groups window. This context menu gives
you the option to include or exclude a total line for each account you drag into
the spreadsheet. For this report, we want to include a total line, so make sure
that Include Total Line is selected.

2) Do the same for Liabilities in your Account Groups window.

3) To add the data to your spreadsheet, Select Balance Sheet in the Account
Groups window and drag it into the spreadsheet, dropping it in cell A3.

4) The Select Fields window opens. This allows you to select what data from the
accounts (Account Data) you want to display in the spreadsheet

For this report, make sure that Description is selected. And also select End Bal.
Prior Period, and End Bal 2 Periods Ago. Click OK.

Lesson 2
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5) The Layout window appears so that you can change the order of the columns.

Lesson 2
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For this report, leave the columns in the order they are and click OK. The
Balance Sheet data for the last two periods is entered into the spreadsheet, with
balances for each period calculated at the bottom.

Adding a Title
Before you print the report, you should add a title and date so that you will know
when the report was printed. For this report, we will add the Company Name as the
title at the top of the report, and we will add a “current date” field.

1) Select the cell A1. This is where we will put the Company Name. You could
either type the company name in, or you could have the Financial Reporter do it
for you, using the Company Profile Data from Adagio Ledger or Adagio FX.

To have the Financial Reporter do it for you, right-click the cell A1, and select
Insert Formula | Company Information | Company Name from the pop-up
menu.

Lesson 2
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2) The company name from the sample data will be inserted into the cell. You will
notice that the row is not tall enough to fit the text. To fix this, select the row by
clicking once on the row button, which is just to the left, labeled “1.”

3) From the Format menu, select Rows | Auto-Fit. This will automatically resize
the row height to fit the text.

Adding the Date
You can add a “current date” formula to the report so that each time the report is
opened, this cell will always display the current date.

1) Select the cell C1.

2) Right-click the cell and select Insert Formula | Current Date. The current date
will be entered in the cell.

Because this is a formula that you entered in the cell, if you save this report, each
time you open it this cell will display the current date.

Lesson 2
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3) Your spreadsheet should now look like the following image:

Printing and Saving Reports
You can now print and save your report. To print your report, select File | Print
from the menu bar or click the Print button on the toolbar. Select the printer you
want to use, then click OK.

To save your report, select File | Save from the menu bar or click the Save button on
the toolbar. Give the report a file name, then click Save.

You have now finished the tutorial. There are many more features in Financial
Reporter which you will want to explore. But having completed this tutorial, you are
now prepared to do some of the most common tasks with Financial Reporter.

Lesson 2
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